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Copyright and Trademark Notice
Copyright © 1999 by CTC Parker Automation. All rights reserved. No part of this pub
tion may be reproduced, transmitted, transcribed, stored in a retrieval system, in any
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While every precaution has been taken in the preparation of this manual, CTC Parker
mation and the author assume no responsibility for errors or omissions. Neither is an
liability assumed for damages resulting from the use of the information contained he
All product and company names are trademarks of their respective companies and lic

Product Warranty Information
CTC Parker Automation provides top quality products through rigid testing and the hig
quality control standards. However, should a problem occur with your hardware or wit
software protection key, CTC’s standard product warranty covers these items for 15
months from the date of shipment from CTC. Exceptions appear below:

• PowerStation backlight bulbs have a 90-day warranty. 

• Third-party products, such as bus cards, carry the manufacturer’s specified 
warranty.

• For all displays, image retention (burn-in) is not covered by warranty.

• Software revisions that occur within 60 days after purchase are available und
warranty upon request. Please review the MachineShop License Agreement
additional software warranty information.

Should you have any questions about your application or need technical assistance,
call CTC’s Product Technical Support department at 513-248-1714, 8:00am to 5:00p
EST. You may call this same number after hours for emergency assistance. See Customer 
Support Services on page 7 of this manual for more information about CTC’s support p
ucts and services.
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C h a p t e r  1

Manual Overview and 
Support  Services

Welcome to Interact. Interact is a family of modular software 

products that can be easily combined and configured to meet a 

full-range of display-based, operator interface applications.
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Using This
Manual

This manual is designed to help you get up and running with 
Interact. It describes Interact concepts and includes example a
cations detailing the features of most Interact modules.You sho
read and understand the concepts presented in this manual pr
operating Interact.

You should read this manual from beginning to end. Pay particu
attention to the concepts presented in Chapters 4 through 13.
These chapters provide example applications so you can gain
practical experience working with each Interact module.

After you read this manual you should reference the Windows
online help files for any module you have a question on. Use t
manual for reference on overall Interact concepts.

This manual is divided into the following chapters:

Chapter 1 - Manual Overview and Support Services: Presents 
an overview of the documentation that is provided with Interac
This chapter also provides an overview of the support service
provided by CTC.

Chapter 2 - Introducing Interact:  Presents an overview of 
Interact and describes the individual components of the softwa
Describes the minimum hardware and software requirements 
needed to run the Interact software.

Chapter 3 - Using Interact: Presents a quick way to get started
using Interact and how to run Interact from a network server. I
also covers using serial drivers with Interact.

Chapter 4 through Chapter 13 - Application Manager plus all 
Interact modules: A chapter is devoted to the Application 
Manager and each Interact module. These chapters provide a
overview of the module, important concepts you should know, a
steps through an example application designed specifically to
demonstrate the module’s main features.

Chapter 14 - Interact Networking Concepts: This chapter 
describes networking Interact applications. Network topics 
include sharing data between Interact workstations, logging to 
running Interact from a central location, and many other netwo
related topics.
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MachineShop
Documentation

The MachineShop package includes all of the documentation 
need to install, configure, and run MachineShop. In addition, t
package includes all the necessary information to develop Inte
applications and MachineLogic projects. Extensive online help
exists for MachineShop, Interact, and MachineLogic as well. 
Please review the following list to verify that you have received 
necessary documentation.

Print Documentation MachineShop is shipped with the following print documentatio

License Agreement - The License Agreement explains the term
of the MachineShop component and serves as a certificate of
authenticity. This document also lists the product warranty info
mation provided by CTC. Make sure you read and understand
information in this agreement before you install and operate 
MachineShop. 

Customer Support Information - The Customer Support docu-
ment describes how to contact CTC with your comments, que
tions, and concerns regarding the MachineShop product.

What’s New in MachineShop - The What’s New in Machine-
Shop document describes what is new in MachineShop, Inter
and MachineLogic.

MachineShop Installation Booklet - The MachineShop Installa-
tion Booklet provides step-by-step instructions on how to insta
and configure all the necessary components of MachineShop. 
includes Interact and MachineLogic.

MachineShop Getting Started Guide - The MachineShop 
Getting Started Guide is designed to help you get up and runn
with MachineShop. This guide also provides instructions on ho
to download Interact and MachineLogic projects from a PC to
PowerStation or non-CTC workstation.

Interact Getting Started Guide - The Interact Getting Started 
Guide is designed to help you get up and running with Interac
Refer to the Using This Manual section on page 2 for a description
of this manual.

MachineLogic Getting Started Guide - The MachineLogic 
Getting Started Guide is designed to help you get up and runn
with MachineLogic. This manual describes the user interface a
provides instructions on how to create and online monitor 
MachineLogic projects.
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Electronic
Documentation

In addition to the MachineShop print documentation, the 
following electronic documentation is available:

MachineLogic Tutorial - The MachineLogic Tutorial provides 
step-by-step instructions for using the MachineLogic Tutorial 
Template to create, download, and run a MachineLogic projec
The tutorial is a Portable Document Format (PDF) document a
is accessible from the MachineShop program group.

MachineLogic Reference - The MachineLogic Reference is a 
comprehensive guide to using MachineLogic. This guide provid
detailed instructions on how to create, edit, and compile Mach
Logic projects. It also describes some IEC basics. This manua
a Portable Document Format (PDF) document and is accessib
from the MachineShop program group.

MachineLogic Runtime Reference - The MachineLogic 
Runtime Reference provides information on the MachineLogic
Runtime kernel. It contains basic concepts and system specific
the MachineLogic Runtime to help you structure your Machine
Logic project. This manual is a Portable Document Format (PD
document and is accessible from the MachineShop program 
group.

Online Help Files - Extensive online help is accessible from 
MachineShop, Interact, and MachineLogic Development. The
online help contains detailed information on the products and 
describes how to perform all product operations. To access th
online help available for a specific part of the program, press 
F1 key on your keyboard.

I/O Driver Online Help - The I/O Driver online help is accessible
from the MachineShop Toolbar and the MachineShop program
group. The online help provides a technical overview of the I/O
driver and contains detailed instructions on how to configure t
I/O driver for MachineLogic.

Interact Tutorial  - The Interact Tutorial is an online help file tha
is designed to be run on the Interact development system. Th
help file includes step-by-step instructions for creating examp
applications using the Panel Toolkit Module (PTM), the Graphi
Monitoring Module (GMM), and the Alarm Management Modul
(AMM), which will help you become familiar with Interact. The
Interact Tutorial is accessible from the MachineShop program
group.
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Related
Documentation

In addition to the documentation that is included in the Machin
Shop package, you should become familiar with the following 
documentation:

I/O Interface Card Documentation - This documentation is 
supplied by the manufacturer of your I/O interface card. Pleas
read this documentation in its entirety prior to downloading or 
running a MachineLogic project.

PowerStation User Guide - If you are running Interact on a CTC
PowerStation, you should have received this manual. This man
explains how to configure, install, and operate the PowerStati
Please familiarize yourself with this manual prior to operating t
unit.

PowerStation CPU Manual - If you are running Interact on a 
CTC PowerStation, you should have received this manual. Th
manual is provided by the manufacturer of the CPU board fou
in your PowerStation. Please familiarize yourself with this manu
prior to operating the unit.

Workstation User Guide - If you are running Interact on a non-
CTC workstation, you should have received user documentati
for the unit. Please familiarize yourself with this manual(s) prio
to operating the unit.

MachineShop Shell Runtime User Guide - This manual 
provides instructions on how to use the MachineShop Shell to
monitor and configure a PowerStation or non-CTC workstation
communicating with a development system running Machine-
Shop. This includes creating and restoring backups and prepa
the workstation for transfers. Please read this manual prior to 
downloading an Interact application from the MachineShop 
toolbar.

Windows Documentation - This manual assumes you have a 
thorough knowledge of the Windows operating system when 
working with Interact. If this is not the case, then refer to the do
mentation shipped with your operating system for details on 
Windows.
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Documentation
Standards

As you read this manual, you will notice that the following doc
mentation standards have been followed.

1. Important terms are shown in bold.

2. Text to be entered from the keyboard is shown in Courier  
font.

3. Buttons, menu titles, and keyboard keys are shown in Initi
Caps.

4. Indented paragraphs denote one of the following:

• Note - Describes alternative approaches or issues you
should be aware of while using a particular function.

• Important  - Contains information that needs particular
attention while reading the text. Follow this information
to save development time and/or minimize problems.

• Warning  - Contains information on safety issues. Follow
this information to prevent equipment damage or perso
injury.

ISO Symbols This symbol is the International Standards Organization (ISO)
symbol for Caution (ISO 3864 No. B.3.1). This symbol denote
information that could affect operation of the PowerStation if n
properly followed.

This symbol is the ISO symbol for Caution - risk of electrical 
shock (ISO 3864 No B.3.6). This symbol denotes information th
could cause personal injury from electrical shock or damage t
equipment if not properly followed.
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Customer
Support

Services

CTC welcomes your thoughts and suggestions on our produc
and services. You can contact CTC by telephone, email, or fa
You can also visit CTC on the World Wide Web to learn the late
about CTC hardware, software, and customer support service

• Telephone: 513-831-2340

• Fax: 513-831-5042

• E-mail: sale@ctcusa.com or @ctcusa.com

• World Wide Web: http://www.ctcusa.com

CTC recognizes that every customer and every application ha
different support needs, so CTC offers a variety of support 
services designed to meet those needs. CTC offers three type
customer support services: Product Technical Support, Techn
Support Products, and the Product Support Program.

Product Technical
Support

The Product Technical Support department welcomes any ques-
tion that might arise as you develop or run your applications. W
offer complimentary support for any customer, whether you are
end user, original equipment manufacturer (OEM), system int
grator, or distributor.

If you have a question about MachineShop, Interact, or Interact
sure to complete the following steps before contacting the Prod
Technical Support department:

1. Check the Readme files installed with the software. These
files provide general information about the release.

2. Consult the appropriate documentation and other printed 
materials included with MachineShop, Interact, and Machin
Logic.

3. Check the online help. MachineShop, Interact, and Machi
Logic each have extensive online help facilities that cover 
aspects of the product.

If you cannot find a solution, contact the Product Technical 
Support department for help. Support lines are open during nor
business hours, Monday through Friday, 8:00am to 5:00pm E
You may call this same number after hours for emergency ass
tance.
Interact Getting Started Guide 7
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Technical Support
Products

Our Technical Support Products department provides service
two areas: training and consulting. CTC offers training on all o
products either at CTC in our state-of-the-art training center o
your site. You can learn how to write custom interfaces, devel
specialized applications, and implement your complete, opera
interface application. You can contact the Training Coordinator
phone at 1-800-233-3329 or by email at training@ctcusa.com

CTC offers consulting services through our Professional 
Consulting Services (PCS) group. Our PCS group can build y
application from the ground up by writing custom, communica
tions drivers or designing special modules to perform function
unique to your application. Our team of specialists is flexible, 
they can create a project development schedule that meets yo
needs. You can contact the PCS Coordinator by phone at 1-8
233-3329 or by email at pcs@ctcusa.com.

Product Support
Program

The Product Support Program (PSP) is designed to keep you
to-date with the current version of Interact software. The PSP
consists of a renewable, one-year membership that provides y
with free upgrades, utilities, automatic notification of software 
updates, and other valuable tools for Interact. Single-user, site,
corporate licenses are available. The PSP is an easy, cost-effe
way to automatically receive the most recent Interact software 
the associated utilities. You can contact the PSP Coordinator 
phone at 1-800-233-3329 or by email at psp@ctcusa.com.

Chapter
Summary

This chapter has provided a general overview of the documen
tion that is provided with Interact as well as the supporting doc
mentation that you may find useful as you develop Interact 
projects. This chapter has also provided an overview of CTC’s
support products and services.

In the next chapter you will learn about the Interact user interfa
as well as the system requirements for running Interact.
8 Interact Getting Started Guide



C h a p t e r  2

Introducing Interact

Interact provides you with a reliable and efficient method of 

controlling your machines. It is part of the MachineShop develop-

ment environment, which also includes MachineLogic. Informa-

tion on MachineShop and MachineLogic is provided in the 

Getting Started Guides for each application. This chapter provides 

an introduction to Interact and its components.

Interact is a modular software family that can give you all the 

functionality you need, from control panel replacement to histor-

ical trending and networking. Interact makes it easy to develop, 

maintain, and run your own applications. Pre-configured tools and 

screens as well as comprehensive online help files make it easy to 

develop the perfect application for your system.

Please review this manual and all other documentation included 

with Interact before configuring an application.
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Interact Basics Welcome to Interact. Interact is a family of modular software 
products that can be easily combined and configured to meet 
full-range of display-based operator interface applications. 
Interact software can be used in systems such as:

• Machine Control Stations with display-based panel replac
ment, graphics, and alarming, which are alternatives to tra
tional hardwired control panels

• Operator Interface Workstations with recipe management,
historical trending, and data logging in conjunction with 
panel replacement functions

• SCADA or Supervisory Control Workstations with compre-
hensive reporting, networking, and the ability to send facto
floor information to other computing environments like MIS

Operating
Environments

Interact has two distinct operating environments: developmen
and runtime. The development environment is a 32-bit applicat
designed to run under Windows 95, Windows 98, or Windows
NT, while the runtime environment runs under MS-DOS®. Th
means you can take advantage of both the ease-of-use of the
Windows graphical user interface in the development environ-
ment and the high-speed efficiency, reliability, and cost-effecti
ness of the DOS runtime environment. The DOS runtime 
environment allows Interact to run on any IBM-compatible PC
including CTC’s family of PowerStation workstations.

Development
Environment

The development environment allows you to create your opera
interface application. It provides an integrated development en
ronment for creating control panel screens and configuring 
module and driver settings. Development modules and drivers
supplied as Windows Dynamic Link Libraries (DLLs) which yo
install using the Interact Setup program according to your appl
tion’s needs.

Each module and driver requires specific configuration for the
user application. For example, graphics must be drawn and al
text must be entered and tied to an I/O trigger point. Whether y
are drawing a push button or identifying which I/O point to be 
logged, all configuration information about the application is 
performed in the development environment.
10 Interact Getting Started Guide
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Runtime Environment The runtime environment simply uses the screens and informa
that were created in the development environment and comm
cates with the control equipment to monitor and turn I/O points
and off. The modules perform their specific tasks according to
how they were configured in the development environment. F
example, while Interact is running, the user could acknowledge
alarm, and a date and time stamp could be assigned and logg
these functions were configured in the development environm

The runtime environment runs under MS-DOS. The runtime 
versions of the Application Manager, modules, and driver 
programs allow you to acquire data from controllers and view 
module and driver screens. During runtime, Interact runs in 
protected mode and uses extended memory, eliminating the l
tations of DOS real mode.

Important The runtime environment is designed to run exclusively
under MS-DOS. To test the functionality of your applica
tion, you can select the Run Interact command from the
Run menu on the Application Manager menu bar, but fo
better performance and improved reliability, you should
exit Windows entirely whenever you run an application i
an actual production environment.

The runtime environment consists of two modes of operation: 
Program Mode and Run Mode. Programmable controllers typ
cally provide a program mode for entering and editing ladder lo
rungs and a run mode for executing these rungs. Similarly, 
Interact’s Program Mode allows you to change driver configur
tion, Interact Settings, and Application Settings without having
return to the development environment. Run Mode lets you vi
operating module screens using data collected by the drivers.
Interact Getting Started Guide 11
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Development
System

Requirements

The development system is the computer you plan to use to cr
and manage your Interact applications. This computer will not
used to run the applications that you create. Instead, you will 
this computer to manage your applications to and from a Pow
Station that will be used to run your applications. The PowerS
tion is referred to as the runtime system throughout this manual.

The Interact development environment is a 32-bit Windows ap
cation designed to run in Windows 95, Windows 98, or Window
NT. To achieve acceptable performance, your hardware platfo
should meet the minimum  requirements below.

Hardware
Requirements

Your development system must meet or exceed the following 
system requirements in order for Interact to perform as intend

• Processor: Pentium 133MHz

• Memory: 24MB RAM (Windows 95/98 systems)

• Memory: 32MB RAM (Windows NT systems)

• Fixed Storage: 50MB of free hard disk space

• Removable Storage: CD-ROM drive

• Input Devices: keyboard and Microsoft compatible mouse

• Video: 800 x 600 resolution, 256 colors

• 10MB Ethernet network interface card or serial port

Software
Requirements

Your Interact development PC requires the following software
order to develop Interact applications:

• Operating System: Windows 95 4.00.950B (OSR2), 
Windows 98 or Windows NT 4.0 SP3

Note DCOM 95 must be installed if using Windows 95/98. A 
self-extracting executable install is provided on the 
MachineLogic install disk in the DCOM 95 directory.

• Interact: Version 5 or later

Note Interact Version 6.0 is required if you are using Interact 
with MachineLogic.
12 Interact Getting Started Guide
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Installing the
Software

Refer to the MachineShop Installation Booklet for step-by-step 
instructions on how to install and setup the Interact software 
components.

Important In order to run Interact in the development environment
the Windows development option on your security key 
must be enabled. Refer to the MachineShop Getting Started
Guide for details on the security key.

Runtime System
Requirements

The runtime system is the PowerStation you plan to use to run
your Interact applications. This computer will only be used to r
the applications you create. You will develop your applications 
a development system and download them to this computer.

The Interact runtime environment runs under MS-DOS. The 
Interact runtime environment runs in protected mode and use
extended memory, eliminating the limitations of DOS real mod
To achieve acceptable performance, your hardware platform 
should meet the minimum  requirements below.

Hardware
Requirements

Your runtime system must meet or exceed the following Intera
system requirements in order for Interact applications to perfo
as intended:

• Processor: 80386-SX 25MHz or higher

• Memory: 4MB

• Fixed Storage: 8MB

• Video: 320 x 240 or 640 x 480 resolution, 16 colors

• Input Device: Microsoft compatible mouse (or equivalent)

• Third Party I/O Card

• 10MB Ethernet network interface card or serial port

Software
Requirements

Your runtime PC requires the following Interact software in ord
to run Interact applications:

• Operating Systems: MS-DOS 6.22 or later 

• Interact Runtime: Version 5 or later

Note Interact Version 6 is required if you are using Interact wi
MachineLogic.
Interact Getting Started Guide 13
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Installing the
Software

Refer to the MachineShop Installation Booklet for step-by-step 
instructions on how to install and setup the Interact software 
components.

Getting Help Help is available if you have any questions about the features
Interact or need additional information. For print documentatio
read the Getting Started Guide and look in the table of content
index. For online documentation, select Help from the Interact
toolbar and view the help contents or perform an index search

Before consulting a CTC support representative, we suggest y
look for help in this Getting Started Guide or search the online
help. If you are unable to find the information you need, call 
Customer Support for assistance. For more information about
available support services or how to contact CTC Customer 
Support, see Chapter 1.

Basic Interact
Components

There are three basic components to the Interact software: th
Application Manager, modules, and device drivers.The Interac
architecture is illustrated below:
14 Interact Getting Started Guide
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• The Application Manager represents the core of the Interac
software. In the development environment, it provides a 
framework to manage the various aspects of the applicatio
such as the modules and device drivers. In the runtime en
ronment, the Application Manager is a real-time, multitask
ing kernel that controls the flow of data from the modules 
the drivers. Its multitasking capability, which is required fo
high-performance operator interfaces, allows data to be pr
cessed simultaneously from various modules and device d
ers. It represents the heart of Interact that keeps the data 
flowing freely.

• The Application Modules, also referred to as modules, are
optional components. Modules provide specific operator 
interface functionality, such as graphics, alarming, recipe 
management, etc. Knowing that requirements vary from 
application to application, Interact’s modular architecture 
allows you to purchase the products that support all the fu
tionality needed for various applications. The user can als
choose just the functions or modules needed for each spe
application. Also, with this modular architecture, modules 
can be easily added in the future if the application require-
ments change.

• The Device Drivers are the communication components of
the software. They handle the reading and writing of data 
and from Interact and control devices, such as PLCs, drive
and motion controllers. Interact currently supports over 45
different device drivers, which include all of the major PLC
brands.

In addition, Interact supports customer-developed, device
drivers with the Software Development Kit (SDK). This kit 
allows the user to develop interfaces so Interact can comm
nicate to devices which are not supported by the standard
product. Interfaces for bar code readers, vision systems a
pagers have all been developed using the SDK.
Interact Getting Started Guide 15
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Module
Descriptions

Panel Toolkit Module
(PTM)

Use PTM to construct a screen-based equivalent of traditiona
operator control panels. A library of over 30 panel tools model
after standard hardwired devices is available. Various tools ar
listed below.

Graphics Monitoring
Module (GMM)

Use GMM to add free-form, animated graphics to PTM panels
using CAD-like, graphic tools. Animation actions can be based
either discrete or analog values and include changes in size, c
location, orientation, and visibility. The ability to import the mos
common graphic formats is also supported by GMM. These 
formats include BMP, JPG, TIF, AutoCAD DXF, WMF, and 
PCX.

Alarm Management
Module (AMM)

Use AMM to define alarm conditions and specify correspondin
reporting, logging, and corrective actions. Alarms can be group
for enhanced, alarm control and prioritized using five, color-
coded, priority levels.

Recipe Module (RCM) Use RCM to download, upload, edit, and store recipes online.
log of recipe alternatives is automatically stored.

Machine
Configuration Module

(MCM)

Use MCM to download, upload, edit, and store groups and lis
online. These groups and lists run your processes, providing t
settings and functions to produce your product. This module a
keeps an automatic log of all changes in lists and groups and 
activity.

Data Transfer Module
(DTM)

Use DTM to exchange data at high speed between different 
control equipment by passing information among multiple, 
Interact device drivers.

• Lighted Push Button • Multi-state Indicator

• Numeric Display • Slide Potentiometer

• Panel Meter • XY Plot

• Real-time Line Trend • PID Faceplate

• Bar Graph • ASCII Message Entry
16 Interact Getting Started Guide
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Historical Trending
Module (HTM)

Use HTM to view logged data online in tabular or line trend 
format. You can also view data off-line via popular computer 
packages.

Report Module (RPM) Use RPM to create free-form reports that can be reviewed onl
printed, and downloaded to a network or disk. Report function
include value minimum/maximum tracking, event counting and
timing, and row/column sum and average.

User Program Module
(UPM)

Use UPM to easily add your own features to an Interact applic
tion with a user-written, terminate-and-stay-resident (TSR) 
program that shares data with Interact.

Networking Interact provides a NetBIOS, high-speed LAN that allows real
time data to be shared among multiple, Interact stations. The 
NetBIOS interface is implemented using the NetBIOS driver. Th
driver works with all major networking topologies and provides
remote monitoring and control functions, the ability to share lo
files, and a connection between distant remote stations via 
modem.

DDE Server Use the DDE Server to connect Interact applications directly t
Windows applications via a NetBIOS-compatible LAN. The DD
Server is used with Interact’s NetBIOS, network driver and allo
any DDE-enabled, Windows application to exchange data with
any Interact workstation.

Chapter
Summary

In this chapter you have learned about the hardware and softw
components for Interact Development and Runtime.

In the next chapter, you will learn how to start Interact develop
ment and runtime. 
Interact Getting Started Guide 17
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C h a p t e r  3

Using Interact

Before you begin creating and building Interact applications, you 

need to understand how to get up and running with Interact.

This chapter provides information on starting the Interact Devel-

opment and Runtime components. It also describes how to run 

Interact from a network server. In addition, this chapter covers 

using serial drivers with Interact.

Chapter Contents
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Running Interact from a Network Server 22

Using Serial Drivers with Interact 23

Chapter Summary 24
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Starting Interact This section descibes how to start Interact development and 
Interact runtime. 

Starting Interact
Development from

MachineShop

Interact must be started from MachineShop. MachineShop is 
foundation of your Interact software and is used to create, man
and transfer your projects to and from your runtime system. O
a project is created and opened in MachineShop, you can the
launch Interact from the MachineShop toolbar. The toolbar ope
Interact with the proper application ready for development. 

See the MachineShop Getting Started Guide for a complete 
discussion on how to use MachineShop. 

To open Interact development, follow these steps:

1. Start MachineShop and open your project.

Use the MachineShop online help for assistance.

2. Click the Interact button on the MachineShop Toolbar or 
select Interact  from the Tools menu.

The Application Manager window appears with the proper
application ready for development..
20 Interact Getting Started Guide
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Starting Interact
Runtime

You may start the Interact Runtime from Interact development
from MS-DOS. 

Start Interact Runtime for Interact Development

To start Interact runtime from Interact development, follow 
these steps:

1. Start MachineShop and open your project.

2. Click the Interact button on the MachineShop Toolbar or 
select Interact  from the Tools menu.

The Application Manager window appears with the proper
application ready for development.

Note  If you need to open another application, select the Open 
Application  command from the File menu. The Open 
Application dialog box appears. Select the name of the 
application you want to open and click OK .

3. Select the Run Interact command from the Run menu.

Interact opens an MS-DOS window and begins running th
MS-DOS version of Application Manager. The screen that
appears in the window depends on the options you select f
the Startup Mode group on the General page of the Applic
tion Settings property sheet.

Start Interact Runtime from MS-DOS

To start Interact runtime from MS-DOS, follow these steps:

Important Before starting Interact on a Windows NT system, you 
must have MS-DOS or Windows 95 installed with dual-
boot capability, and you must reboot into MS-DOS mod
prior to completing the steps below.

1. From the MS-DOS prompt, type c: (if necessary, substitute 
your drive letter for c:).

2. Press Enter.

3. Type cd\Interact\am (if necessary, substitute your path for 
\Interact).

4. Press Enter.
Interact Getting Started Guide 21
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5. Type am.

6. Press Enter.

The Application Manager runtime display appears or the 
application chosen as the Startup Application is displayed
The Application Manager runtime display is shown below.

Running Interact
from a Network

Server

Interact software is network aware, meaning you can run it fro
any logical drive. This allows you to store Interact files and the
Interact applications you create on one centralized server for b
development and runtime. This may be done using the Interac
runtime environment variables: Interact  and Interact_files. 
These settings control the location of the Interact program file
(Interact) and the application files (Interact_files).

Important Before you can run Interact from a logical drive, you mu
have MS-DOS client software installed and configured 
with the proper drive mapping using the environment va
ables listed above. This requires an in-depth knowledge
networking and access to proprietary files that CTC is 
unable to provide. Consult your network supervisor or a
experienced network technician for more information 
about configuring your local area network.
22 Interact Getting Started Guide
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Centralizing of program and application software makes file 
management and software upgrades fast and simple because
Interact program and application files used throughout the faci
are located in the same place. The picture below illustrates tw
Interact stations running off the same network server.

Node_A and Node_B might have environment variables as: 

set interact=f:\interact

set interact_files=f:\interact\appfiles

These environment settings may be set to any logical path and 
be stored in the workstation’s autoexec.bat file or in a batch fi
entered at startup.

Using Serial
Drivers with

Interact

This section provides special information on Interact serial 
drivers.

Two factors affect how quickly Interact serial drivers can respo
to interrupts from the communication channels in Run Mode.

• While running Interact, the processor is continually changi
between real mode and protected mode. The mode switch
may take a relatively long time, during which interrupts from
the serial ports cannot be serviced.

• Mouse interrupts can also prevent the communication cha
nels from being serviced in a timely manner. This is espe-
cially true when the mouse is run in relative mode.

Note Interact spends much less time servicing a mouse set fo
absolute mode. This option is found on the General page
the Interact Settings property sheet.
Interact Getting Started Guide 23
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To overcome these problems, Interact provides support for th
16550AF UART. This device provides a 16-byte FIFO (First-In
First-Out) buffer for the communication channels.

Important We strongly recommend the use of a 16550AF (or equi
lent) UART if you are running Interact. The UART buffers
incoming characters until the processor can read them,
virtually eliminating overrun errors.

At startup, Interact looks for a 16550AF UART. If it is detected
all Interact serial drivers automatically support FIFO operation
With no 16550AF UART installed, it may not be possible to ru
more than one Interact serial driver at a time using baud rates
greater than 4800 baud, depending on the processor clock sp

If you experience communication problems when using Intera
we suggest you do one of the following:

• install a 16550 UART (the recommended solution)

• run at a slower baud rate

Chapter
Summary

In this chapter you have learned how to start Interact and how
use serial drivers with Interact.

In the next chapter, you will learn about the Interact Applicatio
Manager (AM).
24 Interact Getting Started Guide
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Appl icat ion Manager

The Application Manager (AM) is essentially the framework of 

Interact that holds together the modular components of the 

product. All Interact applications, whether in the development 

environment or the runtime environment, require AM. This 

chapter discusses AM and includes an example of how to create 

and configure an application.

Chapter Contents

Overview of AM 26

Important Concepts 27

Overview of the Example Application 34

Creating a Project 34

Application Manager Interface 36

Adding a Module 40

Adding a Driver 41

Configuring Interact Settings 42

Configuring Application Settings 47

Experiment! 49



Overview of AM Chapter 4: Application Manager

n-
re 

li-
s 

and 
 run 

h 

m 

M.

s 
ent. 
ta 
e 

ost 

he 
lso 
ud 

er 
he 
Overview of AM AM consists of two programs, one for the development enviro
ment and one for the runtime environment. These programs a
described in the sections that follow.

AM for the
Development
Environment

AM for the development environment is a 32-bit, Windows app
cation designed to run in Windows 95, Windows 98, or Window
NT. This program allows the user to create applications, select 
configure modules and device drivers, set system settings, and
utilities.

In the development environment, AM works in conjunction wit
the modules and device drivers to create runtime files to be 
executed in the runtime environment. AM also supports syste
functions and utilities. For example, utilities such as the Tag 
Editor and the Cross Reference Utility are available through A

AM for the Runtime
Environment

AM for the runtime environment is an MS-DOS program that i
used to execute the files created in the development environm
It is a real-time, multitasking kernel that manages the flow of da
within Interact. This multitasking capability allows the data to b
processed by the multiple modules simultaneously, which is 
essential for Interact to provide the performance required for m
operator interface applications.

In the runtime environment, all data flows through AM. The 
device drivers communicate to the control equipment; AM 
receives the data from the device drivers; then, AM transfers t
data to the modules that require specific I/O addresses. AM a
allows certain device driver options to be changed, such as ba
rate, but I/O configuration can only be set in the development 
environment.

In summary, AM manages all aspects of the application wheth
in the development environment or the runtime environment. T
figure below illustrates the relationship between the modules, 
26 Interact Getting Started Guide
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drivers, and AM.

Important
Concepts

The Application Manager (AM) is the foundation of Interact; 
therefore, you must understand the following concepts before
using Interact for the first time.

Application A group of Interact module programs and driver programs that y
configure to perform a specific workstation task.

Application Manager The foundation of the Interact product. Application Manager 
provides the link between Interact modules and drivers and allo
you to perform several basic functions:

• Specify the application name

• Select which modules and drivers to use for your applicati

• Switch between the development environment and the run
ime environment for designing and operating your worksta
tion
Interact Getting Started Guide 27
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Password Settings Interact provides a method of runtime security in the form of us
levels. The level of security depends on who is currently operat
the system. Each operator is assigned a user name, a unique
word, and a user level.

The user name is a name referencing the operator and can be
printable ASCII string up to 12 characters long. The password 
unique set of characters associated with the user name that en
the user access to the system. The password can contain up 
alphanumeric characters.

User levels are active in the runtime environment only. They 
control the operator's access to certain functions. For example,
may exclude the operator from viewing specific PTM panels 
depending on the user level. Interact supports six user levels 
numbered from 0 to 5. User level 0 is the highest user level, 
offering the most privileges; user level 5 is the lowest user lev
offering the least privileges.

Restrictions on AM runtime functions are as follows:

• User level 0 - The operator has access to all application, m
ule, and driver functions.

• User level 1 - The operator is restricted to Run Mode func
tions. The operator may not access Program Mode functio
or exit from Interact.

• User level 2, 3, and 4 - In addition to level 1 restrictions, th
operator may not select an application.

• User level 5 - In addition to the restrictions for levels 1 
through 4, the operator may not view driver screens.

Address References The module screens you design for your Interact workstation m
contain input and output tools. The operator monitors data fro
the controller with output tools and uses input tools to modify da
in the controller. When you configure a tool, you identify the da
that the tool will monitor or change. Output references identify t
data to monitor. Input references identify the data to change.

Interact expects all address references to start with the name o
device driver that is attached to the controller containing the re
enced item. Device driver names can have up to six characters
most driver names are four or five characters long.
28 Interact Getting Started Guide



Chapter 4: Application Manager Important Concepts

e 
 the 
ss 

ds 
what 
lp 
n 

 of 

river 
Throughout this manual, the generic name DVR is used as th
device driver name. The device driver name is separated from
rest of the reference by the backslash (\) character (dvr\addre
string).

Controllers of varying models and vendors have different metho
of addressing. The address string format you use depends on 
is expected by the named device driver. Refer to the online he
file of the device driver you are using for specific information o
the device driver name and address string format.

Throughout this manual, we have adopted a standard method
showing address references, as listed below:

DVR\DN:WORD.BIT

DVR = device driver name

\ = device number delimiter

DN= device number

:= word delimiter

WORD = word address

. = bit delimiter

BIT  = bit within word (0 - 15 decimal)

Below is a list of address examples:

dvr\1:200 = driver “dvr” / device #1 / word 200

dvr\2:400.5 = driver “dvr” / device #2 / word 400 / bit 5

dvr\12:59.15 = driver “dvr” / device #12 / word 59 / bit 15

This format is used for illustrative purposes only. The actual 
address reference format you will use depends on the device d
and is described in the device driver online help file.
Interact Getting Started Guide 29
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Link Variables The Interact link driver enables data to be transferred between
Interact modules without storing the data in the controller. This
done using link variables (data stored in Interact’s Link Variab
Memory) made available to all Interact modules.

To define a link variable, you assign a special address referen
Address references for link variables are similar except for the
following:

• The driver name is always “LINK.”

• There is no device number.

• The link variable is always a whole word or a discrete 
value—there is no bit reference.

A typical reference for a link variable looks like this:

LINK\BATTERY_LOW

Decoding Address References

When the Application Manager decodes an address reference
first looks for the device name, which is everything before the
backslash (\).

LINK\BATTERY_LOW

If the device name represents a controller, the data will be writ
to (input) or read from (output) a specific location in the controll
memory. If the device name represents a link variable, the da
will be stored to or retrieved from a specific location in Interact
Link Variable Memory.
30 Interact Getting Started Guide
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Reserved Link Variables

The Application Manager and some Interact modules have lin
variable names reserved. The link variables reserved for each
module are described in the help file for that module and are 
summarized in the Link Variable List located in the Application
Manager help file. For example, the Application Manager reser
the following link variables:

• LINK\RELAY is a variable used with Interact running on a 
PowerStation. It is used to actuate an external relay con-
nected to the PowerStation (a discrete input).

• LINK\BATTERY_LOW is a variable used with Interact run-
ning on a PowerStation. It is used as an indication to the u
that the PowerStation’s internal battery is low and needs to
replaced (a discrete output).

• LINK\USER_LEVEL is a variable used to change the user
level in Run Mode. A supervisor can use an analog input to
to change the user level without entering a password.

• LINK\SCREEN_SAVER is a variable that allows you to 
monitor the status of a PowerStation’s screen saver.

Link Variable Example

Assume that you want to generate an alarm when the Applica
Manager detects a low battery condition. This is done as follo

1. The Application Manager detects the low battery condition

2. The link driver sets link variable LINK\BATTERY_LOW 
true (i.e., writes a 1 to this memory location).

3. The Alarm Management Module is configured to monitor th
variable address. When it detects a 1 at location 
LINK\BATTERY_LOW, it generates the configured alarm 
response.
Interact Getting Started Guide 31
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Tag Editor The Interact Tag Editor is a program that enables you to creat
list of tag names and their associated address references. A t
name can then be entered instead of an address reference st
when you are prompted for an address during module configu
tion.

Note Although the use of tags simplifies the configuration 
process, it can affect Run Mode performance. Starting R
Mode and switching between panels takes more time sin
Interact must search the Tag List for the address refere
that corresponds to each tag. If you have sufficient syst
memory, you can set the Tag Storage in Run Mode para
eter in the Tag Editor Settings dialog box to Load All int
Memory to improve performance.

Tag Names

A tag name is a name used in place of a controller-specific add
reference string. You can also combine tag names with contro
specific references. Tag names make your application more fl
ible and usable in other control systems. Tag names may be u
30 characters long (this does not include the @ character).

Note Every tag name must begin with the @ character. Tag 
Editor automatically inserts the @ for you if you check th
Include @ in Selection check box in the Tag Editor Settin
dialog box.

An example of a tag name is as follows: @BUTTON. This tag
name could be used to reference the address DVR\1:1. Any to
assigned the @BUTTON reference would refer to address 
DVR\1:1 in your controller.

The Tag Editor saves tag names in the INTERACT.TAG file th
resides in your application’s subdirectory. There can only be o
tag file per application. Interact searches for the tag file each ti
it enters Run Mode. If a tag file exists and the Use Tags in Ru
Mode check box is checked in the Tag Editor Settings dialog b
the Tag Editor replaces all module item address references th
have been assigned a tag name with the associated tag name
tag file does not exist, Interact assumes normal address refere
have been used.
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Cross Reference
Utility

The Interact Address Cross Reference Utility (CRU) enables y
to generate a Cross Reference Report of address references 
specific application.

Using the Cross Reference Utility

To run the CRU, follow these steps:

1. Select the Cross Reference command from the Tools menu.

The Cross Reference dialog box appears.

2. Enter an address reference or tag name followed by a file s
ification.

The CRU determines what drivers are being used in it and wh
their names are. Application Manager (AM) scans the pertinen
files within the application and performs a search for all addre
references, tags, and link variables. AM then includes these re
ences in a report that lists the references alphabetically and by
type.

Viewing the Cross Reference Report

You can view the report in one of two formats: by file or by 
module. Viewing by file will list the address references, matchi
your search criteria, on a file-by-file basis. Viewing by module
will list the address references, matching your search criteria, o
module-by-module basis.

Contents of a CRU Report

The CRU report consists of the following information.

1. The report header that contains the following information:

• The date and time the report was generated

• A legend listing the names of the drivers contained in t
application files

• The total number of files and references

2. A list of references arranged alphabetically with the file or
files the references are found in, along with the number of
times they appear in the file

3. A list of files arranged by module, each listing the referenc
it contains
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Additional References That May Appear in a Report

In addition to the information listed above, the CRU report
may also include the following references:

• All addresses assigned to tools, whether they are visib
on the screen or not. For example, if a bar graph has f
address references assigned for the different bars and
tool is resized on the screen to only show two bars, the
CRU will still report all four addresses, even though on
two appear on the screen.

• The Data Transfer Module (DTM) enables you to assig
a starting address for a block of addresses. The CRU 
ity will only report the starting address for a block.

Overview of the
Example

Application

The following sections provide hands-on experience with creat
and configuring a project and application using MachineShop.
AM has no pre-existing application that is shipped with Interac
You must create the project and application yourself. In this 
example you will learn to do the following:

• Create a project and application using MachineShop

• Observe the menu bar and toolbar

• Navigate Interact

• Add Modules and Drivers

• Select an existing application

• Configure Interact settings

• Configure application settings

Creating a
Project

MachineShop provides a New Project Wizard to guide you 
through the process of creating a project. 

To create a project and application using MachineShop, 
follow these steps:

1. Start MachineShop if it has not been started already. The 
MachineShop toolbar appears at the top of your desktop.

2. On the File menu, click New Project, or click the New 
Project button on the toolbar. 

The New Project dialog box appears.
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3. Type a project name, a project description, and click the 
Interact  box.

4. Click OK to accept the changes and begin the New Projec
Wizard.

5. Follow the instructions provided by the New Project Wizar
to finish creating the project.

The New Project Wizard will ask you to enter an applicatio
name and to select the modules and the driver(s) that will 
used in the application. Enter or select the following option

• application name = amexamp

• Module = Panel Toolkit Module (PTM)

• Driver = Demo Driver (DVR)

You can add additional Modules and drivers from Interact.
Instructions to add Modules and drivers is discussed later
this chapter. 

6. When the New Project Wizard is finished, click the Interact  
button on the MachineShop Toolbar to start Interact.

The Application Browser appears, with the application name y
entered appearing in the Application Browser title bar. 

The Application Manager window is shown below.
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Application
Manager
Interface

This section describes the Application Menu Bar and Toolbar 
well introduces you to the major components of the AM develo
ment environment. 

Using the Menu Bar
and Toolbar

The Application Manager Menu Bar and Toolbar are shown 
below. Each selection is described in the following paragraphs

File Menu

The File menu is the main menu in AM. It includes the comman
for managing applications. You can create new applications, o
and save existing applications, and set application properties.

View Menu

The View menu includes the commands for customizing the 
program window. Each command acts as a toggle switch: wh
the command is active, a check mark appears next to the comm
name.

Settings Menu

The Settings menu includes the commands for configuring an
customizing the application.

Go To Menu

The Go To menu allows you to switch to any other module or 
driver you have included in the current application. When you 
open the Go To menu, a list of the available modules and driv
appears.

Tools Menu

The Tools menu allows you to access the Cross Reference ut
and the Tag Editor utility.
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Run Menu

The Run menu allows you to enter the Interact runtime enviro
ment.

Window Menu

The Window menu includes the commands for controlling 
windows and icons that appear in the program window. If you a
familiar with Windows applications, many or all the commands
will be familiar to you.

Help Menu

The Help menu includes the commands for finding help on AM
The Contents command opens the AM help window. From he
you can browse for the desired information. The How to Use H
command provides general information for using and navigatin
Windows online help.

You can also view the Interact Help Contents by selecting the
Introduction command or the Interact Tutorial by selecting the
Tutorial command. 

Toolbar

The Toolbar provides quick access to the commands you use m
often in the Application Manager (AM). The default position fo
the Toolbar is along the top of the AM program window, but yo
can drag the Toolbar to another location. Each of the tools in 
Toolbar also appears on one of the eight AM menus.

Navigating Interact The Interact Application Manager, the modules, and the drive
are Windows-compatible applications. This means that they 
adhere to the standards set by Microsoft for Windows applica
tions. The following paragraphs introduce you to the main com
nents of the AM development environment. If you are already
familiar with Windows applications, much of this information 
may be familiar to you.
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Application Browser

The Application Browser is a window that displays Interact app
cations and their components hierarchically. Icons appear at e
level of the tree, and dashed lines further define the hierarchy. 
Application Browser is designed to provide you a graphical wa
to manipulate Interact applications, but there are also menu 
commands available that you can use to accomplish the same
tasks. An example of the Application Browser appears below.

You can navigate the Application Browser with the mouse or 
keyboard. If you are using the mouse, select the desired level
expand or collapse the tree. If you are using the keyboard, use
Up and Down arrow keys to move to the desired level of the tr
and press the Right and Left arrow keys to expand or collapse
level. Levels that can be expanded have a plus (+) to their left
those that can be collapsed have a minus (-) to their left, and th
with no levels have no sign at all.

Workspace

The workspace is the area just below the menu bar and Toolb
This is the main working area of the application. The Applicatio
Browser is located here as well as any open windows. You ca
move and resize the Application Browser and the windows to 
occupy some or all the workspace. However, you must stay wit
the boundaries of the workspace. You do not actually enter an
modify parameters in the workspace itself but in windows locat
in the workspace.
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Windows

Windows appear throughout each of the Interact modules. 
Windows allow you to view and edit information as well as vie
the content and properties of objects. Windows also display 
palettes of controls, parameters to complete commands, or 
messages to inform you about the status of the program. Two ty
of windows generally appear in most Windows-compatible ap
cations: primary windows and secondary windows.

When in Windows-compatible applications, you do most of yo
viewing and editing in primary windows. The Interact Applicatio
Manager window is an example of a primary window.

You specify parameters or options in secondary windows. The
can also contain specific details about the objects or actions in
primary window. The Interact Application Browser is an examp
of a secondary window.

Dialog Boxes and Property Sheets

Dialog boxes and property sheets appear throughout each of 
Interact modules. These objects are similar in that they both 
provide an exchange of information between you and the app
tion. Dialog boxes and property sheets generally appear after 
choose a particular menu command or command button. Men
commands or command buttons that have dialog boxes or prop
sheets associated with them are followed by an ellipsis (...).

Dialog boxes and property sheets differ from one another in th
way they present controls and information. Dialog boxes pres
all of the controls and information in one place and are intende
obtain additional information from you that is needed to comple
a particular task.

Property sheets display the properties of an object that are ac
sible to you. They condense what may be found in several dia
boxes into a series of tabbed pages that contain controls and i
mation.
Interact Getting Started Guide 39



Adding a Module Chapter 4: Application Manager

ules 

s to 

ou 
, it 
Adding a
Module

When you need to add a module to an application, use the Mod
Used icon on the Application Browser or the Modules Used 
command on the Settings menu. You can add as many module
your application as system memory allows.

To add a module to an application, follow these steps:

1. Double-click the Modules Used icon in the Application 
Browser.

The Modules Used dialog box appears as shown below. If y
selected the PTM module when you created the application
should be listed in the Modules Used By list.

2. Add RPM to this application:

a. Click Report (RPM) in the Modules Available list.
b. Click Add. RPM is now listed in the Modules Used By 

list.

3. Click OK .

RPM appears in the Application Browser Window.
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Adding a Driver When you need to add additional drivers to an application, use
Drivers Used icon on the Application Browser or the Drivers Us
command on the Settings menu. You can add as many driver
your application as system memory allows.

To add a driver to an application, follow these steps:

1. Double-click the Drivers Used icon in the Application 
Browser.

The Drivers Used dialog box appears as shown below:

2. Drivers are added to applications the same way as Modul
Add the 

a. Click the appropriate from the Drivers Used list. 
b. Click Add. The driver is now listed in the Drivers Used

By list.

3. Click OK .

The driver will appear in the Application Browser window.

Closing an Interact
Application

This portion of the example is complete. Yo do not need to sa
this example. In the next section, you will be running the PTM
example application and making changes to it.

To close an Interact Application, follow these steps:

1. Open the File menu from the menu bar.

2. Click on Close Application.

This will close the Application Browser for your current app
cation. 
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Configuring
Interact Settings

In this section you will make changes to the Interact Settings p
erty sheet. Changes made to the Interact Settings property sh
affect all Interact applications. For detailed information on eac
parameter see the Application Manager help file.

You will select the PTM example application shipped with the 
PTM module, change several Interact settings, and observe th
changes in Run Mode. If you do not have PTM, just read throu
the steps below.

Important You must remember to change the Interact settings back
their previous state or when you run the PTM example i
the next chapter it will not work properly.

To change Interact Settings, follow these steps:

1. On the File menu, click Open Application.

A list of available projects appears.

2. Double-click the APPFILES folder.

The APPFILES folder opens.

3. Click Example and then click OK .

The Application Browser appears with the Example applic
tion loaded.

4. On the Run menu, click Run Interact.

5. Click on Yes in the Save dialog box.
42 Interact Getting Started Guide



Chapter 4: Application Manager Configuring Interact Settings

 as 

u 
li-
ot 
on-

t.
You enter the Interact Run Mode. The PTM panel appears
shown below:

6. Press the F10 function key.

The Application Manager Run Mode menu is displayed. Yo
will change this so that function key F9 will display the App
cation Manager Run Mode display. The Screen Saver is n
yet activated. Now return to the Interact development envir
ment.

7. Click Exit Interact ; then, click Accept.

You are returned to the Interact development environmen

8. On the File menu, click Interact Settings.
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The Interact Settings property sheet appears as shown belo

The General page is displayed once the Interact Settings p
erty sheet appears.

9. Select the Run Mode Display page of the Interact Settings 
property sheet.

Use this page to configure the Run Mode display type, AM
menu color, and the blinking colors.

10. Click the Display Type box, and select Plasma for the display 
type.

The display type you select allows you to select colors that 
appropriate for the target platform. The Interact color sche
changes the next time you enter Run Mode.

11. Select the Keys page of the Interact  Settings property sheet.

Use this page to assign the default Selection Key and keys
special functions such as Go to AM, next and previous 
module, print screen, and abort print.
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You may assign any key on the keyboard except the arrow
keys, but do not terminate your entry by pressing the Ente
key. Ctrl, Alt, and Shift key combinations are also valid, bu
the Shift key is ignored when you press it in conjunction wi
the A through Z keys.

If you want a key to be undefined, press the Delete key at 
prompt. The setting will be shown as None. When you hav
selected the setting you wish to change, simply press the 
or key combination you want to use. For example, Ctrl+F5
will be shown as c-F5 (0/98).

12. Click Go To AM and press function key F9.

13. Select the Screen Saver page of the Interact Settings prop-
erty sheet.

Use this page to configure the screen saver. When the scr
saver is enabled, AM either clears the screen or scrolls tex
the display if it detects no mouse or keyboard activity for a
specified number of minutes. The screen saver works only
during Run Mode and helps prevent phosphor “burn” when
graphic is displayed for a long time.

AM continues to update graphics in the background while t
screen saver is active. To deactivate the screen saver and
display the screen, move the mouse, press a mouse butto
press a keyboard key.

14. Enable the screen saver by selecting the Enabled box.

15. Click the Timeout Interval , and enter 1 minute.

16. Click the Scrolling Text button.

17. Click Text, and enter your name or any other text string yo
wish to use.

18. Click OK .

The Interact Settings property sheet closes, saving all you
changes. Now you will enter Run Mode and observe your 
changes. In this example, do not activate the PTM tools. Y
will investigate all the features of the PTM example in the ne
chapter.

19. On the Run menu, click Run Interact.
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20. Click on Yes in the Save dialog box.

You enter the Interact Run Mode, and the PTM panel appe
The panel is displayed in colors that would be appropriate 
a Plasma display. Changing the Display Type parameter fr
Color to Plasma caused this effect.

21. Press the F9 function key.

The Application Manager Run Mode menu is displayed. D
not use the keyboard or move the mouse for one minute.

The Screen Saver activates and scrolls the text you entere
across the display. Now you will return to the Interact deve
opment environment.

22. Move the mouse.

The Application Manager Main Menu displays.

23. Click Exit Interact ; then, click Accept.

You are returned to the Interact development environmen

24. On the File menu, click Interact Settings.

25. Select the Run Mode Display page of the Interact Settings 
property sheet.

26. Click the Display Type box, and select Color for the display 
type.

This returns the display back to Color the next time you en
Run Mode.

27. Select the Keys page of the Interact Settings property sheet.

28. Click Go To AM and press function key F10.

This returns the Go To AM selection key back to F10.

29. Select the Screen Saver page of the Interact Settings prop-
erty sheet.

30. Disable the screen saver by clearing the Enabled box.

31. Click OK .

All parameters are back to their original states.
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Configuring
Application

Settings

In this section you will make changes to the Application Settin
property sheet. Changes made to the Application Settings prop
sheet only affect the currently loaded application. For detailed
information on each parameter, see the Application Manager h
file.

You will select the PTM example application shipped with the 
PTM module, change several application settings, and observe
changes in Run Mode. If you do not have PTM, just read throu
the steps below.

Important You must remember to change the application settings 
back to their previous state; otherwise, when you run th
PTM example in the next chapter, it will not work properl

To change Application Settings, follow these steps:

1. On the File menu, click Open Application.

A list of available projects appears.

2. Double-click the APPFILES folder.

The APPFILES folder opens.

3. Click Example.

4. Click OK .

The Application Browser appears with Example applicatio
loaded.

5. On the Run menu, click Run Interact.

6. Click Yes to the Save dialog box.

You enter the Interact Run Mode. The PTM panel appears
shown in the previous section on Configuring Interact 
Settings.

Notice that when Interact started in the runtime environme
Run Mode was the startup mode, and the PTM module was
startup module. Now you will make Program Mode the start
mode.

7. Click the Go To AM button on the PTM panel.

The Application Manager Run Mode menu appears.

8. Click Exit Interact ; then click Accept.
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You are returned to the Interact development environmen

9. Double-click on the Application Manager icon in the Appli-
cation Browser.

The Application Browser expands.

10. Double-click on the Application Settings icon in the Appli-
cation Browser.

The Application Settings property sheet appears as shown
below:

The General page is displayed once the Application Settin
property sheet appears. Use this page to configure Startu
Write Value, Startup Mode, and module input and output 
references. You can also enable CTS checking and the dis
of data errors.

11. Click Program for the Startup Mode. 

This enables the application to startup in the Program Mod
Selecting this radio button disables the other parameters in
group.

12. Click OK .

The Application Settings property sheet closes, saving all 
your changes. Now you will enter Run Mode and observe yo
changes. In this example, do not activate the PTM tools. Y
will investigate all the features of the PTM example in the ne
chapter.
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13. On the Run menu, click Run Interact.

14. Click on Yes in the Save dialog box.

You enter the Interact Run Mode. The Application Manage
Main Menu appears.

Notice Interact is set to the Program Mode. The applicatio
did not enter Run Mode immediately. Changing the Startu
Mode parameter from Run to Program caused this effect.

15. Click Exit Interact ; then click Accept.

You are returned to the Interact development environmen

16. Double-click on Application Settings in the Application 
Browser.

17. Click on the Run button on the General page.

This returns the Startup Mode back to Run Mode.

18. Click OK .

All parameters are back to their original states.

Experiment! This chapter provided only a brief introduction to the features 
AM. The best way to learn is to experiment.

• Read and work through the other examples provided in th
manual.

• Create a new application with only the PTM module and th
Demo driver.

• Build a simple tool and change various Interact and applic
tion settings, and see the effect on application operation.
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Panel Toolk i t  Module

The Panel Toolkit Module (PTM) is an Interact software 

module that runs under the control of the Application Manager 

(AM). PTM includes over 30 pre-configured panel tools, 

which replace traditional hardware, creating a more direct and 

powerful link between operator and machine. This chapter 

provides an overview of PTM and includes an example that 

shows you how to build panels of tools.
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Overview of
PTM

PTM allows you to quickly and easily construct an operator int
face panel consisting of input tools and output tools. These to
are graphical objects modeled after real input/output devices s
as push buttons, meters, numeric displays, bar graphs, etc. Y
can place the tools on the panel and attach them to discrete o
analog variables in your controller.

For increased capability, PTM is designed to work hand-in-ha
with the Graphics Monitoring Module (GMM). GMM is another
Interact software module that runs under control of the Applica
tion Manager and always accompanies PTM. GMM allows you
create graphic objects using simple graphic units such as line
boxes, circles, polygons, arcs, and text. You can connect thes
objects to variables in your controller, allowing you to create 
panels that contain animated processes or machine diagrams a
with PTM tools.

The term “panel” is used to describe a single screen containing
assortment of graphical objects, representing input and outpu
devices called “tools.” Typically, an operator uses several, if n
many, panels to monitor and control a machine or process.

In the development environment, you can design and configur
your panels. In the runtime environment, panels are viewed by
operator, and the tools on them are connected to the discrete
analog variables in the controller. The operator may select wh
panels to view.
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Overview of the
Example

Application

This section provides hands-on experience using the Panel To
Module (PTM). The example application, Example, consists o
pre-configured panel. The following features are demonstrated
the example application:

• Running the Application Manager and loading the applica-
tion

• Using the pre-configured PTM tools in Run Mode

• Adding PTM tools in the development environment

• Testing the modified example

Using the Demo
Device Driver

The demo device driver is provided for you to use with the 
example application. The example application does not requir
you to interface with a controller. However, you can assign 
addresses to tools using the demo device driver, just like you 
would when using a standard device driver. Input data is passe
the output address by the demo driver as shown below:

In the figure above the input and output address are the same; i
data appears at the output address. Therefore, the driver loops
input data.
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The demo driver address format is shown below:

The address format is defined as follows:

• Device driver name: DVR

• Device number: 1-4

• Word address: 0 - 65535

• Bit within word: 0 - 15 (optional)

For example, you could enter DVR\1:3. The address format fo
this example appears below:

• Device driver name: DVR

• Device number: 1

• Word address: 3

Or you could enter DVR\3:234.7. The address format for this 
example appears below:

• Device driver name: DVR

• Device number: 3

• Word address: 234

• Bit within word: 7
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Running the
Example

Application

To access the example application you must first run the Appl
tion Manager.

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, click Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Example; then click OK .

The Application Browser appears with the Example applic
tion loaded.

5. On the Run menu, click Run Interact.

6. Click Yes when you are asked to save changes.

You enter the Interact Run Mode. The first PTM panel, title
“Tools,” appears as shown below:
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PTM provides you with a wide variety of tools for use in your 
application. The example application uses two panels with sam
input and output tools to demonstrate how these tools work. Pa
#2 is titled “Trend.” The panel designer assigns panel names w
he creates his application.

To view Panel #2, click the aqua “Trend Scn” button. When yo
want to toggle back to the first panel, click the gray “Go to 
Previous Panel.” 

Using PTM
Tools

This section groups the tools on each panel for descriptive 
purposes. Each of the following sections provides a general to
description and an explanation on how each tool is used in thi
example during Run Mode. You should read each tool group’s
description prior to manipulating the device. For details on too
configuration parameters, refer to the Panel Toolkit Module onl
help file.

Time and Date Tools The Time Display and Date Display tools allow you to display t
current time and date on any panel. These tools are shown be
as they appear on Panel #1:

Push Button Tools Push Button tools work much the same as ordinary lighted pu
buttons. You can use them to control a discrete input bit whene
they are pressed and released. You can also use them to refle
status of a discrete output bit by changing their text and/or col
according to the output bit state.

You must assign a discrete input address to a Push Button. Th
the bit which will be controlled by the button. An optional outpu
address may be used to allow the button to monitor the status
bit (i.e. change the color and/or text of the button when the bit g
high). The following is a list of the three types of Push Buttons

• Momentary Push Buttons

• Maintained Push Button

• Latched Push Buttons 
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These tools are shown below as they appear on Panel #1:

Momentary Push Button

A Momentary Push Button sets a discrete input bit in your 
controller with the press of a button. You may also assign a 
discrete output bit to control the appearance of the tool lens.

A Momentary Push Button retains its state only while the butto
is being pressed. This means the discrete input bit changes s
when it is pressed and returns to its previous state when the u
releases the button.

To use the Momentary Push Button, complete this step:

• Click the Momentary Push Button.

Notice that the button lens color and text change. This is beca
the output bit address is the same as the input bit address. The
Button lens reflects the output bit state.

Maintained Push Button

A Maintained Push Button sets a discrete input bit in your 
controller with the press of a button. A Maintained Push Butto
retains its state when it is pressed and released. This allows t
Maintained Push Button to act as toggle switch because relea
the button does not affect the input bit.

To use the Maintained Push Button, follow these steps:

1. Click the Maintained Push Button.

Notice that the button remains On once you release it.

2. Click the Maintained Push Button again, and notice that the
button returns to the Off state.

We assigned the function key F2 to this Push Button.
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3. Press F2 to move the cursor over the Maintained Push 
Button and actuate the device.

4. Press F2 again to release the Maintained Push Button.

Latched Push Button

You control the state of a Latched Push Button with the state of
unlatch output bit as well as the input bit. Once you press the 
Latched Push Button, the controller’s logic program monitors t
unlatch output bit. When the output bit is triggered, Interact kno
to reset the input bit. This pushes the Latched Push Button ba
out.

This type of button is useful if your controller has an unusually
long scan time that may cause it to miss button presses. An a
tional use for this Push Button would be to synchronize button
presses with events in the controller’s logic program.

For the purposes of this example, the Momentary Push Button
input address is assigned as the unlatch output bit address. T
pressing the Momentary Push Button releases the Latched Pu
Button from its On state.

To use the Latched Push Button, follow these steps:

1. Click the Latched Push Button.

2. Click the Momentary Push Button.

Observe the results on the Latched Push Button.

Analog Input and
Output Tools

An analog tool is used to monitor or control an analog value in 
controller. You must enter an address reference to the desired
value (word or register) in the controller.

The Input address reference assigns the address of the analo
value to be controlled by the tool. The Analog Output address
reference assigns the address of the analog value to be monit
and displayed by the tool. This area of the display is compose
both analog input and analog output tools.
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These tools are shown below as they appear on Panel #1:

In this group of tools, the three input tools are configured to 
control the data at the same address, and the three output too
configured to monitor the same data values. Thus, output tool
update to display the data entered in the input tools.

To use the Analog Input and Output Tools, follow these steps:

1. Click on the Slide tool control (gray tab).

2. Drag the Slide tool control, and observe the output tools.

3. Click on the Increment and Decrement Buttons, and 
observe the output tools.

Input Tools

Analog Input tools allow you to control data at an analog input
address. The above portion of the example panel includes the
following analog input tools:

• Slide

• Increment Button

• Decrement Button

Slide

Slide tools allow you to enter data values to be written to a
analog address. Moving the Slide control enters data from 
tool’s selected range into the input address. This range is u
defined.
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In this example the Slide tool ranges from 0 to 1000. The d
from this tool is used to control the data displayed on the 
Numeric Display tool and the Bar Graph. Also, the messag
displayed on the Range Indicator is dependent upon the S
tool data.

To use the Slide tool, complete this step:

• Click the Slide tool control (gray tab), drag it, and observe 
the data on the Numeric Display and the Bar Graph . The 
Range Display message also changes based on the nume
setting.

Notice that if you use the Increment or Decrement Buttons
change the data value, clicking on the Slide tool also adju
the Slide to the new value. In this application, the Slide too
acts as the coarse adjustment, while the Increment and De
ment Buttons act as the fine adjustment.

Increment Button

Increment Buttons increase a data value located at an ana
input address. Pressing the button increases the data valu
the analog input address by an amount configured by the 
designer for that tool. 

In this application, the Increment Button controls the value
displayed on the Numeric Display and the Bar Graph tools
The data value is set to increment by 1 each time the butto
pressed, and the maximum value is set to 1000. You cann
exceed this value.

The font selected for both the pressed and released lens s
is the symbols1 font. With the symbols1 font, you may assi
graphical icons to the lens. Refer to the Application Manag
online help for all font tables.

To use the Increment Button, complete this step:

• Click on the Increment Button, and observe the Numeric 
Display and Bar Graph  tools.
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Decrement Button

Decrement Buttons decrease a data value located at the to
input address. Pressing the button decreases the data valu
the amount configured for the tool.

In this application, the Decrement Button controls the valu
displayed on the Numeric Display and the Bar Graph tools
The data value is set to decrement by 1 each time the too
pressed, and the minimum value is set to 0. You cannot g
below this value.

The font selected for both the pressed and released lens s
is the symbols1 font. With the symbols1 font, you may assi
graphical icons to the lens. Refer to the Application Manag
online help for the symbols1 font table.

To use the Decrement Button, complete this step:

• Click on the Decrement Button, and observe the Numeric 
Display and Bar Graph  tools.

Output Tools

Analog Output tools allow you to monitor data at an analog outp
address. The example panel includes the following analog out
tools:

• Bar Graph

• Numeric Display

• Range Indicator

Bar Graph

A Bar Graph monitors and displays data from an analog 
output address. The Bar Graph tool is designed to display
analog values, but discrete values can also be displayed.

The minimum and maximum values assigned to the Bar Gra
is 0 to 100, while the values assigned to the Slide tool are 0
1000. The address assignment for the Bar Graph has bee
configured to scale the data it receives from the output addr
by dividing it by 10. Thus, the value controlled by the Slide
tool is divided by a factor of 10 prior to display by the Bar 
Graph.
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Notice the small triangular markers on the Bar Graph. The
markers indicate where limits are assigned. (The limits are
and 75 which represent an input data value of 500 and 75
prior to scaling). As the Bar Graph moves through the limi
the bar color changes.

Numeric Display

Numeric Displays monitor and display data from output 
addresses. You can assign minimum and maximum value
this tool that define the low and high range of that particula
tool.

This tool reads the data value controlled by the Slide or Inc
ment and Decrement tools. Any change in these tools appe
on the display.

In this example, the field size has been set to 4 with no deci
places. The minimum value is set to 0, and the maximum 
value is 1000. Limits are set to 500 and 750.

Range Indicator

The Range Indicator displays message text based on data
monitored from an analog output address. This tool can be
used to display cautions and warnings to the user indicatin
when a condition requires attention.

In this example, as the Slide or Increment/Decrement Butto
are actuated, the Range Indicator changes the displayed 
message. The limits where the message and lens change a
500 to 750.

To observe the bar graph, numeric display, and range indi-
cator, follow these steps:

1. Click the Slide tool control (gray tab), drag it, and observe th
Bar Graph.

The bar color changes when the slider moves past 500 an
changes again when the slider moves past 750.

2. Click the Increment and Decrement tools, and observe the 
Range Indicator.
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The Range Indicator changes the message and color whe
either the Slide tool or the Increment and Decrement butto
move the value past 500 and 750.

Meter and Message
Display Tools

This area of the display is composed of both input and output 
tools. These tools are shown below as they appear on Panel #

In this group of tools, the data controlled by the Slide tool is mo
tored by the output tools. Hold down on the gray slide tab, and
move it, while observing the effect on the output tools.

Input Tools

Analog Input tools allow you to control data at an analog input
address. The example panel includes the following analog inp
tool.

Slide

Slide tools allow you to enter data values into an analog in
address. This tool is similar to the Slide tool described earli
Moving the slide enters data within the tool’s range into th
input address.

In this example, the Slide tool ranges from 0 to 10. Both th
Meter and Bar Graphs scale this data prior to displaying it
The Local Message Display tool displays messages based
the data value read from the Slide tool.

To use the Slide tool, complete this step:

• Click the Slide tool control (gray tab), drag it, and observe 
the output tools.
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Output Tools

Analog Output tools allow you to monitor data at an analog outp
address. The example panel includes the following analog out
tools:

• Bar Graph

• Meter

• Local Message Display

Bar Graph

This Bar Graph is similar to the Bar Graph previously 
described. A Bar Graph monitors and displays data from a
analog output address. The Bar Graph is designed to disp
analog values, but discrete values can also be displayed.

As you move the Slide tool control, the Bar Graph monitor
the data value. In this example the bars complement each o
so that when one bar is at the minimum value, the other is
the maximum value.

In this example, the Bar Graph ranges from 0 to 100. Since
range of data from the Slide tool is 0 to 10, scaling is 
performed on the data value read from the Slide tool. For 
bar on the left, the data value is multiplied by 10 prior to 
display. For the bar on the right, the data value is multiplie
by 10 and subtracted from 100 prior to display.

Notice the markers on the Bar Graph. These markers indic
where each limit is assigned. There are limits assigned to e
bar so that when a limit is passed, the bar color changes. 
the left bar, the limits are 50 and 80. For the right bar, the 
limits are 50 and 20.

Meter

A Meter monitors and displays data from an analog addre
The position of the meter’s needle reflects the data read fr
the output address.
64 Interact Getting Started Guide



Chapter 5: Panel Toolkit Module Using PTM Tools

e 
its 
ool 

you 

e 
ated 
er 
s this 
se, 

bine 
ssage 
hes 

 

olor. 
olor.

 and 

rent 

et 
hese 
As you move the Slide tool control, notice that the Meter 
needle moves to reflect the monitored data value. When th
needle passes its limits the needle changes color. The lim
are currently set to 60 and 80. Data controlled by the Slide t
is multiplied by 10 before it is displayed on the Meter.

Local Messa ge Display

The Local Message Display displays local messages that 
create and store in PTM. The controller’s logic program 
controls which message is displayed by placing a messag
number in a register. Each message has a number associ
with it. The Local Message Display tool monitors this regist
and determines if a message has been created that matche
register value. If a message exists, it is displayed; otherwi
no message is displayed.

In this example there are 10 separate messages which com
to form a single sentence. Each message is assigned a me
number. When the data value read from the Slide tool matc
a message number, that particular message is displayed.

To observe the Bar Graph, Meter, and Local Message Display
tools, follow these steps:

• Click the Slide tool control (gray tab), drag it up and down.

As the Slider passes 50 and 80, the left Bar Graph changes c
As the Slider passes 20 and 50, the right Bar Graph changes c

The Meter needle changes colors as the Slider moves past 60
80.

As the Slide tool passes a whole number (1, 2, 3, etc.), a diffe
message is displayed.

Numeric Entry and
Set Button Tools

This area of the display is composed of input tools. With this s
of tools, we assigned both tools to the same analog address. T
tools appear on Panel #1 as shown below:
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Numeric Entry

The Numeric Entry tool allows you to enter data through a keyp
device into an analog address. The keypad device is either an
internal keypad (appears on your computer screen) or an exte
keypad (the numeric keypad on your computer’s keyboard). 
Access the keypad device by clicking on the Numeric Entry to

To use the internal keypad, click on the screen’s keys for each
number. Use the enter key to enter a data value into the analo
input address. Click on the Cancel key to return to the display 
abort any data entry.

To use the external keypad, enter your data value using the k
on your keypad. Press Enter to enter data, and press the Esc k
abort the data entry. 

An internal keypad appears below:
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To use the Numeric Entry tool, follow these steps:

1. Click the Numeric Entry  tool.

2. When the keypad pops up, enter data by clicking the nume
keys.

3. When you finish entering data, click the Enter key of the 
keypad to close the internal keypad and display the data on
Numeric Entry tool.

The keypad has two arrow keys that allow you to move the
keypad from one side of the display to the other. You can 
assign the default position for a keypad when you configur
the tool. Function key F4 is assigned to the Numeric Entry
tool, so pressing F4 pops up the keypad and allows data e

Set Button

The Set Button tool writes a predefined value to the assigned 
analog input address each time you press the button. You can
assign this predefined value when configuring the tool.

To use the Set Button, complete this step:

• Press the Set Button.

When you press the Set Button, a value of 500 is sent to t
Numeric Entry tool. The address where the value is written
the same address monitored by the Numeric Entry tool.

Function key F5 is assigned to the Set Button tool. Press F
move the cursor to the tool and actuate the tool.

Increment Buttons
and Indicator

This area of the display is composed of both input and output 
tools. These tools appear on Panel #1:
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Input Tools

Analog Input tools allow you to control data at an analog input
address. The above portion of the example panel includes the
following analog input tools:

• Increment Button

• Decrement Button

Increment Button

Increment Buttons increase a data value located at an ana
input address. Pressing the button increases the data valu
the amount configured for the tool.

In this application, the Increment Button controls the value
displayed on the Numeric Display and the Indicator tools. T
data value is set to increment by 1, and the maximum valu
set to 100. You cannot exceed this value.

The font selected for both the pressed and released lens s
is the system2 font. Refer to the Application Manager onlin
help for all font tables.

To use the Increment Button, complete this step:

• Click the Increment Button, and observe the Numeric Dis-
play and Indicator tools.

Notice the Numeric Display counts from 0 to 7, depending 
the current state. Also, the Indicator message and backgro
color change to reflect the current state.

Decrement Button

Decrement Buttons decrease a data value located at an an
input address. Pressing the button decreases the data valu
the amount configured for the tool.

In this application, the Decrement Button controls the valu
displayed on the Numeric Display and the Indicator tools. T
data value is set to decrement by 1, and the minimum valu
0. You cannot go below this value.

The font selected for both the pressed and released lens s
is the system2 font. Refer to the Application Manager onlin
help for all font tables.
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To use the Decrement Button, complete this step:

• Click the Decrement Button, and observe the Numeric Dis-
play and Indicator  tools.

Notice the Numeric Display counts from 0 to 7, depending 
the current state. Also, the Indicator message and backgro
color change to reflect the current state.

Output tools

Analog Output tools allow you to monitor data at an analog outp
address. The above portion of the example panel includes the
following analog output tools:

• Numeric Display

• Indicator

Numeric Display

Numeric Displays monitor and display data from an analog
address in the controller. You can assign minimum and 
maximum values to this tool that define the low and high 
range of the tool. These values are also used during tool li
assignments.

This tool reads the data value controlled by the Increment a
Decrement Buttons. Any change in these tools appears on
display. In this example, the field size has been set to 1 w
no decimal places. The minimum value is set to 0, while th
maximum value is set to 100.

Indicator

The Indicator monitors up to three discrete outputs. These 
control up to a maximum of eight states (lens colors and te
messages) on the Indicator. As the outputs change, the In
cator also changes state.
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The table below lists each discrete output combination and
corresponding Indicator state.

To observe the Numeric Display and Indicator tools, follow 
these steps:

1. Click on the Count Up or Count Down Increment and 
Decrement buttons located below the Indicator .

Notice that each time you press one of these buttons, a 
different state is displayed by the Indicator. Once you reac
the maximum (7), the Increment button cannot increase th
Indicator state. Likewise, once you reach the minimum sta
(0), the Decrement button cannot decrease the Indicator s

2. Now observe the Numeric Display as you click the Incre-
ment and Decrement buttons.

Action Tools This area of the display is composed of the following tools. The
tools are shown below as they appear on Panel #1:

Action Tools allow access to functions local to the Interact sof
ware. When you press an Action Tool, a specific function is 
performed. Panel #1 includes the following Action Tools:

Discrete
Output 0

Discrete
Output 1

Discrete
Output 2

Indicator State 
Displayed

0 0 0 State 0

1 0 0 State 1

0 1 0 State 2

1 1 0 State 3

0 0 1 State 4

1 0 1 State 5

0 1 1 State 6

1 1 1 State 7
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• Next Panel (Trend Scn)

• Go to AM

Next Panel and Go to AM

The Next Panel tool loads the next panel in the PTM Runtime
Panel List. The Runtime Panel List is a list of panels to be use
during Run Mode. This list is considered to be a continuous lo
This means if the last panel in the list is currently loaded, press
the Next Panel button loads the first panel in the list.

The Go to AM button brings the Application Manager screen in
the foreground.

In this example we have created two separate PTM panels. P
#1 of this example is called the Tools panel (the current panel
loaded in this example). Panel #2 is called the Line Trend pan
We are using a Next Panel Action Tool to access the Line Tre
panel.

You can use another Action Tool, Go to AM, to return to the 
Application Manager Main Menu.

To use an Action Tool, complete this step:

• Click on the Trend Screen Action button.

The Line Trend panel, Panel #2, appears as shown below
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Now practice with the remaining tools used by this examp

Line Trend

This area of the display is composed of both input and output 
tools. In this set of tools the analog input addresses assigned t
Slide tools are monitored by the Line Trend. These tools are 
shown below:

Input Tool

Analog Input tools allow you to control data at an analog input
address. The example panel includes four analog input slide to

Slide

There are four data values monitored by the Line Trend. Ea
Slide controls a separate line. Notice that each Slide tool h
different minimum and maximum values assigned. The Lin
Trend has a minimum and maximum range of 0 to 100 
assigned.

Data for each of the four trends are derived from four separ
address assignments:

• Line trend 1 (green) monitors the data from the upper l
Slide tool (green) and multiplies the data by a factor of 
prior to display.
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• Line trend 2 (cyan) monitors the data from the upper rig
Slide tool (cyan) and displays the data directly.

• Line trend 3 (red) monitors the data value from the low
left Slide tool (red) and divides the data by a factor of 1
prior to display.

• Line trend 4 (magenta) monitors the data value from th
lower right Slide tool (magenta) and divides the data by
factor of 100 prior to display.

To use the Slide tool, complete this step:

• Click the Slide tool control (gray tab), drag it, and observe 
the Line Trend  display.

Output Tool

Analog Output tools allow you to monitor data at an analog outp
address. The example panel includes the analog output Line T
tool.

Line Trend

A Line Trend tool provides trend analysis by representing d
values as lines on a graph. Data from four separate analo
output addresses may be graphed.

There are two selection keys on the bottom of the Line Tre
tool. These keys are expand level keys which control the 
expansion level of the line trend. In other words, they zoom
and out on the line trend tool so you can either see more de
or get a broad picture of total activity. Expanding the line 
trend allows you to view the graphed data in greater detai
The left key increases the expansion level, while the right k
decreases the expansion level.

As the expansion level changes, the number inside the ex
sion window also changes. There are a maximum of five 
levels available with level five representing the highest 
possible expansion of the line trend. Level one represents
normal viewing. The size of the tool determines how many
expansion levels there are for the particular tool. The large
the tool, the more expansion levels are available.
Interact Getting Started Guide 73



Using PTM Tools Chapter 5: Panel Toolkit Module

 

 is 

phs 

t 
 is 

. 

el 
his 
ng 
t.
To observe the Line Trend, complete this step:

1. Click each of the Slide tool controls (gray tab) on this panel,
and observe the Line Trend.

Notice that by assigning different colors to the Line Trend it
easier to spot a change in a particular data value. In this 
example, there are a maximum of 68 events that can be 
graphed.

2. Click the expand level keys, and observe the results.

As you increase or decrease the expand level, the line gra
expand or contract according to the level you select.

Action Tools

Action Tools allow you to access functions local to the Interac
software. When you press an Action Tool, the specific function
performed. The example panel (Trend Panel) includes the 
following Action Tools:

• Load Panel

• Previous Panel

These tools are shown below as they appear on Panel #2:

Load Panel and Previous Panel

The Load Panel tool displays the PTM Runtime Panel List
You must select a panel to load from the Panel List. The 
Previous Panel tool loads the previous panel from the Pan
List. The Panel List is considered to be a continuous loop. T
means if the first panel in the list is currently loaded, pressi
the Previous Panel button will load the last panel in the lis
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To use the Action Tools, follow these steps:

1. Click Go To Previous Panel to clear Panel #2 and load Pane
#1 on the display. 

2. Click the Trend Screen Action Tool on Panel #1 to return to
Panel #2. 

3. Click Select Panel from List to pop up the Panel List.

The Panel List allows you to select a panel that you want t
load. An example of the Panel List appears below:

4. Click on the desired panel; then, click Accept.

The current panel will clear from the display, and the selec
panel will load, if the panel you select is not currently loade

The Panel List has arrow keys along the right side that you 
use to scroll through panel names. The solid arrow keys sc
the Panel List one page at a time, while the thin arrow key
scroll the Panel List one line at a time.

The arrow keys above the Accept button allow you to shift t
box from side to side on the panel. You select the default p
tion of the box when you configure the panel.
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All example application tools have now been described. Return
Panel #1 of the example application by clicking on Go to 
Previous Panel button of Panel #2.

Understanding
User Levels

User Levels allow you to control access to your panels. With t
capability you can do the following:

• prevent individuals from accessing certain panels

• lock out access to the input tools on your panels

Each user is assigned a specific user level during configuratio
That user can only access features that are assigned their lev
lower.

There are six user levels available for security protection. You c
assign each panel a number from 0 to 5 indicating its user lev
The panel levels are defined in PTM under Settings, Panel Lis
(Panel Level and Input Level). Level 0 provides the strictest 
control possible, while level 5 allows unrestricted access to al
panel functions and features. The example application has the
following user levels assigned to each panel:

Thus, anyone assigned user level 5 or lower can view Panel #1
only individuals with user level 3 or lower can actually input dat
Individuals with user level 5 will not be able to view Panel #2 
since the panel is assigned user level 4. In this application you
must return to the AM Main Menu to change the current user le

To change user levels, follow these steps:

1. Ensure Panel #1 is displayed on the screen.

2. Click on Go To AM Action Tool.

User Level to View
the Panel

User Level to Input
on the Panel

Panel #1 5 3

Panel #2 4 3
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The Application Manager Run Mode screen is displayed a
shown below:

3. Click on Change User.

This allow you to change the existing user. The cursor mov
to the Password prompt. Each user name has a password
assigned that must be entered prior to accessing the desir
panel. Passwords may be up to fifteen characters (alphan
meric) in length.

In this example, the passwords were chosen to match the 
level for clarity only. In an actual application you probably 
would want to assign a password that is not so obvious.

4. Type 5555; then press Enter.

You are now at user level 5. Notice that the Application 
Manager Main Menu has fewer selection keys available. T
higher the user level, the fewer available functions there a
Now return to PTM with this new user level.

5. Click on Go To Module.

Notice that security protection symbols are placed over the
tools that you can not access. With this user level you can 
access any input tools. You are only able to view the pane
Remember this is the highest restricted level. 
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The password restricted panel is shown below:

6. Press function key F10 to return to the Application Manager
Run Mode screen.

7. Click on Change User.

8. Type 0; then, press Enter.

You are now at user level zero again.

9. Click on Go To Module.

Now you have unrestricted access to all tools on the pane

10. Press function key F10 to return to the Application Manager
Run Mode screen.

11. Click Exit Interact ; then, click Accept. 

 You are returned to the Interact development environmen
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Adding a Panel
to the Example

Application

In this part of the example, you will enter the development env
ronment and add tools to a panel. These tools are configured 
you can understand how a panel is created.

Creating a New Panel To create a new panel, follow these steps:

1. Double-click on the Panel Toolkit Module (PTM) icon in the 
Application Browser window.

2. Double-click on the Panels icon.

3. Double-click on the New icon.

A blank PTM panel appears.

4. Click on the Maximize button to maximize your viewing 
window.

5. On the Edit  menu, click Background; then, click Color/
Pattern.

The Background Pattern Selection dialog box appears as 
shown below:

This allows you to assign foreground and background colo
to your panel. You are doing this as the first step in creatin
new panel; however, the background may be changed at 
time during development.
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Each panel has a background on which the tools are place
The pattern and color of the background can be changed 
through the Background Pattern Selection dialog box. 

6. Experiment with selecting various display patterns and ba
ground and foreground colors by clicking on boxes within th
Background Pattern Selection dialog box.

7. Once you decide on a pattern and color for the backgroun
click OK .

Using the PTM
Toolbar

When you wish to add tools to your panel, you must find the to
on the Toolbox found on the right side of the PTM window. Belo
we have identified for you each tool available on the Toolbox.

 Push Button  Increment/Decrement Button

 Set Button  Action Button

 Numeric Entry  Selection Entry

 Slide  Input List

 Input Area  Indicator

 Range Indicator  Numeric Display

 Meter  Counter

 Bar Graph  Line Trend

 XY Plot  PID Faceplate

 Local Message Display  Remote Message Display

 Message Entry Display  Remote List Display
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Adding Tools to the
Panel

In this example, you will make the following three tools:

• Slide

• Bar Graph

• Action Tool (Previous Panel)

You will configure the Slide tool to write data to an analog inpu
address that will be monitored by the Bar Graph tool. Thus, th
Bar Graph will update when the gray control tab on the Slide i
moved.

The Previous Panel Action Tool will be configured to return yo
to the Line Trend panel of the example application.

Select tools by clicking on the appropriate tool icon in the Toolb
on the right side of the screen, or click New, then Tool, from th
Object Menu. Then drag within your panel to create the tool. 

Note When you place the cursor over different tool icons on th
Toolbox, notice that the tool name appears over each ic

To add the Slide tool, follow these steps:

1. Click on the Slide icon in the Toolbox.

2. Position the cursor on the screen where you want the tool
appear.

3. Hold down the left mouse button, and drag the mouse unti
outline of a Slide tool appears.

Note The Slide tool can only be configured for two sizes.

4. Release the mouse button, and the Slide tool appears.

5. Double-click on the Slide tool to configure it. 

Time Display  Date Display

 Panel Label
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The Slide property sheet appears as shown below:

6. Leave the Minimum Value  parameter assigned a value of 0. 
In the Maximum Value box, enter a value of 1000.

7. Click in the Slide Input box to display the Address Referenc
dialog box.

The Address Reference dialog box appears as shown bel

8. Enter the address reference string by typing DVR\ 1:1.

9. Click OK  to accept the address and return to the Settings p

10. Click the Appearance page of the Slide property sheet.
82 Interact Getting Started Guide



Chapter 5: Panel Toolkit Module Adding a Panel to the Example Application

 to 

l an 

o 
11. Select a color by clicking the Tool Color box.

Choose a color from the color well.

12. Click off the property sheet to close it. 

The Slide tool is now configured.

To add the Bar Graph tool, follow these steps:

1. Click on the Bar Graph icon in the Toolbox. 

2. Position the cursor on the screen where you want the tool
appear. 

3. Hold down the left mouse button, and drag the mouse unti
outline of a Bar Graph appears. 

4. Release the mouse button, and the Bar Graph tool appears.

5. Double-click on the Bar Graph tool to configure it. 

The Bar Graph property sheet appears as shown below:

6. Leave the Minimum Value  parameter assigned a value of 0. 
In the Maximum Value box, enter a value of 1000.

7. Click in the Bar 1 Output box to display the Address Refer-
ence dialog box.

8. Enter the address reference string by typing DVR\ 1:1.

Note You can also press the Up arrow key on the keyboard t
automatically enter the last-entered address reference.
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9. Click OK  to accept the address and return to the Settings p

10. Click the Appearance page of the Bar Graph property shee

11. Select a color by clicking the Tool Color box.

Choose a color from the color well.

12. Click off the property sheet to close it. 

The Bar Graph tool is now configured.

To add the Previous Panel Action Tool, follow these steps:

1. Click on the Action Button icon in the Toolbox.

2. Position the cursor on the screen where you want the tool
appear. 

3. Hold the left mouse button, and drag the mouse until an 
outline of a button appears. 

4. Release the mouse button, and the Action Tool appears.

5. Double-click on the Action Button  tool to configure it.

The Action Button property sheet appears as shown below

6. Click Previous Panel in the Action Type box.

7. Click the Appearance page of the Action Button property 
sheet.

8. Select a color by clicking the Tool Color box.

Choose a color from the color well.
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9. Click off the property sheet to close it.

The Action Tool is now configured.

Saving the Panel and
Adding it to the Panel

List

To save your panel, follow these steps:

1. On the File menu, click Save Panel.

The Save As dialog box appears. Notice the Add to Runtim
Panel List box is selected.

2. Click Save.

3. Close the panel.

Testing the
Example

Application

Once you have saved the panel and added it to the Panel List,
are ready to test the modified example application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, click Run Interact.

3. Click Yes when you are asked to save changes.

To view the panel changes in Run Mode, follow these steps:

1. Click on the Trend Screen Action Tool.

The Line Trend panel (Panel #2) appears.

2. Click on the Select Panel From List Action Tool.

The Panel List selection box pops up on the right of the 
display. Your newly created panel will be displayed in this
list. 

3. Click on Panel 1 (the panel you created); then, click Accept.

The Line Trend panel clears, and your panel loads into 
memory.

4. Experiment with moving the Slide tool control while 
observing the Bar Graph .
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5. Click on the Previous Panel Action Tool to clear your panel 
and load the Line Trend panel.

This occurs because the Line Trend panel is listed as the 
number two panel on the Runtime Panel List.

6. Click on Go to Previous Panel.

7. Click on Go to AM.

The Application Manager Main Menu appears.

8. Click on Exit Interact ; then, click Accept.

You are returned to the Interact development environmen

Experiment! This chapter provided only a brief introduction to the features 
PTM. The best way to learn is to experiment.

• Go to the development environment, and load one of the 
example PTM panels. Look at each tool’s configuration pro
erty sheet and how each parameter was assigned. Compa
this to the performance you observed in Run Mode.

• Create a panel, and place a PID tool on the panel. Practic
configuring the PID tool and observing its characteristics.

• Use the Action List to assign function keys to various action
The keys assigned on this list take precedence over funct
keys assigned to tools.
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Graphics Moni tor ing 
Module

The Graphics Monitoring Module (GMM) is used to produce free-

form graphics and animation using a CAD-like, object-oriented 

graphics (OOG) development environment. You can create 

animated picture representations of your process or machine based 

on discrete or analog values. Objects change size, color, location, 

orientation, and visibility with respect to their real counterparts.

This chapter provides an overview of GMM. An example is 

provided that shows you how to create graphic objects and imple-

ment animation in your application.
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Overview of
GMM

GMM is an Interact software module that runs under control of t
Application Manager (AM). GMM allows you to create graphic
objects using simple graphic units such as lines, boxes, circle
polygons, arcs, and text. You can connect these objects to va
ables in your controller, allowing you to create panels that cont
animated processes or machine diagrams along with panel to

For increased capability, GMM is designed to be used with the
Panel Toolkit Module (PTM). See Chapter 5 for more informatio
about PTM.

GMM objects can be dynamically linked to the current applicati
and receive real-time data outputs from a device such as a 
programmable logic controller.

Data can be analog or discrete in nature:

• Analog values range continuously between a minimum an
maximum value (for example between 0 and 100).

• Discrete values are binary in nature. They can have only o
of two possible values (for example 0 or 1).

You can configure the objects to change appearance, size, or 
tion when the value of the controller output data changes.

The graphic objects you draw are combined on panels. Each p
is a single screen which contains an assortment of objects rep
senting controller output devices. PTM tools may exist on the 
same panel as GMM objects.
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Example Display The figures below represent a GMM panel having two tanks 
linked to output addresses in a controller. The height of the m
rial in the tanks is represented by the patterned areas.

This figure shows the objects when the analog value in the firs
output address is 80, and the value in the second address is 2

As the controller values change, the heights of the patterned a
change accordingly. When the values reach 40 and 90, the pa
appears as shown below:
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Overview of the
Example

Application

The following sections provide hands-on experience using the
GMM. This example consists of a panel containing an injectio
molding machine drawn and animated with GMM objects. PTM
tools are used to control the animation. As you explore the 
example application, you will learn to do the following:

• Run the example to see how GMM objects are drawn and
animated

• Investigate the GMM panel to learn how animation is creat
by forming animation connections such as Motion, Positio
and Appearance

• Create your own GMM objects

• Run this new panel in Run Mode

Note This example assumes you have the Panel Toolkit Mod
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Running the
Example

Application

In this exercise, you will load a panel consisting of GMM objec
and PTM tools. In the Run Mode, you will see how PTM tools c
be used to animate GMM objects. In an actual application, the
animated GMM objects would be controlled by outputs from th
control device.

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, click Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Gmmexamp; then, click OK .

The Application Browser appears with the Gmmexamp 
loaded.

5. On the Run menu, click Run Interact.

6. Click Yes when you are asked to save changes.
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You enter the Interact Run Mode. The PTM Tools Panel 
appears.

7. Click the Trend Scn button in the upper left of the panel.

The Line Trend panel is displayed.

8. Click the Select Panel From List button. 

The Panel List, which lists all available panels, is displaye

9. Click GMM EXAMPL .

This panel uses GMM graphics.

10. Click Accept to load the GMM example panel.
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Viewing the
GMM Animation

The example panel consists of an injection molding machine 
drawn with GMM objects. The bottom half of the panel has a 
number of PTM tools which animate the machine and perform
other PTM operations. The injection molding machine has fou
animated parts:

• Platen and clamp cylinder

• Platen position indicator

• Hopper and screw assembly

• Hopper feed conveyor

To view the GMM animation, follow these steps:

1. Click the left Slide tool under Profile Settings up and down.
As you do, observe the following GMM animation:

• The platen and clamp cylinder move in and out (right a
left). This illustrates the Motion animation connection.

• The platen position (in inches) displays above the plate
This illustrates Text animation.

2. Locate the group of four Cycle Control Push Buttons:

• Of the four cycle control buttons, click the lower right 
button. This toggles the hopper and screw assembly in
and out (left and right), illustrating the Position animatio
connection.

• Of the four cycle control buttons, click the lower left but-
ton. This toggles the color and pattern of the hopper fe
conveyor, illustrating the Appearance animation conne
tion.

The other PTM tools demonstrate PTM functions not linked
GMM.

Note In an actual application, the animated GMM objects cou
be controlled by outputs from the controller.
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Investigating the
GMM Panel

In this part of the exercise, you open the GMM module and se
how the animation commands are used to animate GMM obje

To go to the development environment, follow these steps:

1. Click on the right arrow  Push Button under the High Limit 
Numeric Entry tool.

The screen returns to the first screen of the application, th
Tools PTM panel.

2. Click Go To AM to return to the Application Manager Main
Menu.

Note You can also get to the Application Manager Main Menu
by pressing F10.

3. Click Exit Interact ; then, click Accept.

You will return to the Interact development environment.

4. Double-click on the Panel Toolkit/Graphics Module (PTM/
GMM)  icon.

5. Double-click on the Panels icon.

6. Double-click on the GMM EXAMPL  icon.

The GMM Example panel appears.

7. Click on the Maximize button to enlarge your viewing area.

Viewing the Clamp
Cylinder

Configuration

To examine the clamp cylinder configuration, follow these 
steps:

1. Click on the clamp cylinder (the gray shaft with red end) to 
select it.

2. Double-click on the gray shaft of the clamp cylinder.

The Group property sheet appears as shown below.

gray 
shaft

red
end
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3. Click the Connections page; then, click the Motion  page.

4. Click on Edit/View Motion .

The Edit/View Motion dialog box appears as shown below

5. Click back and forth on the Object at Minimum  and Object 
at Maximum buttons.

Notice the changes in position of the clamp cylinder. This 
the position of the clamp cylinder at its minimum and 
maximum positions.

6. Click Cancel.

The Group property sheet appears.
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Motion connections allow an object to change size and/or 
move as the data from the address reference varies betwe
minimum and maximum values. The settings are listed bel

• Connection Output: dvr\3:1. The controller address to 
which the object is connected. On the PTM panel, the l
Slide control is an input to this same address. Therefo
when you move the Slide, the clamp cylinder changes
size.

• Minimum Value:  0.000. The minimum value read from
the Connection Output address to be used for animatio

• Maximum Value: 100.000. The maximum value read 
from the Connection Output address to be used for ani
tion.

• Apply Connection: Always. To use all the values from 
the controller for animation, not just the values that are
range.

If you select Always, a value greater than the Maximum driv
the object to the maximum position. Also, a value less tha
Minimum drives the object to the minimum position.

If you select In Range, Interact ignores values less than th
Minimum or greater than the Maximum. The connection 
output only affects the object when the data value is within 
range specified by the Minimum and Maximum parameter

• Size Control: X. The input changes the size of the objec
in the X direction. When an object is resized, the uppe
left hand corner remains fixed. The object increases in
size down, and to the right. Since X is selected, the obj
size can change only to the right.

• Location Control: None. Controls the movement of an 
object. The point of location for an object is the upper le
corner of the object.

Note With this connection, as the input changes, the size 
changes, but the location does not. When an object is 
resized, the upper left-hand corner remains fixed. The 
object grows right and/or down.

7. Click off the Group property sheet to close the property she
and return to the GMM/PTM panel.
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Viewing the Platen
Configuration

To examine the platen configuration, follow these steps:

1. Click on the clamp cylinder (the gray shaft with red end) to 
select it.

2. Double-click on the red end of the clamp cylinder.

3. Click the Connections page; then, click the Motion  page.

Notice the Connection Output is dvr\3:1. This is the same 
address reference as the clamp cylinder, and both objects
animated by this output. The settings are listed below:

• Connection Output: dvr\3:1. The controller address to 
which the object is connected. On the PTM panel, the 
Slide control is an input to this same address. Therefo
when you move the Slide, the platen as well as the cla
cylinder changes size.

• Minimum Value:  0.000.

• Maximum Value:  100.000.

• Apply Connection: Always.

• Size Control: None. The object does not change size.

• Location Control:  X. The output changes the location o
the platen along the X-axis (left to right).

Note The platen moves as the size of the clamp cylinder chang
Thus, the platen appears to be attached to the end of th
clamp cylinder.

4. Click on Edit/View Motion .

The Edit/View Motion dialog box appears.

5. Click back and forth between the Object At Minimum  and 
Object At Maximum  buttons.

gray 
shaft

red
end
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Notice the changes in the position of the platen. This is the
position of the platen at its minimum and maximum position

6. Click Cancel.

The Group property sheet displays.

7. Click off the property sheet to return to the GMM/PTM Pan

Viewing the Platen
Position Indicator

Configuration

To examine the Platen Position Indicator, follow these steps:

1. Double-click on the Platen Position Indicator (the # signs).

The Text property sheet appears.

2. Click the Connections page.

The Appearance page is already in view. This will be an 
Appearance connection.

Notice dvr\3:1 /1.98 in the list. This connection is controlle
by the PTM Slide tool configured with the same address.

Advanced Information

This motion (location) connection was originally configured i
two steps:

1. With Object At Minimum  selected in the Edit/View 
Motion  dialog box, the object was placed in the desired 
location at the “minimum” input value.

2. With Object At Maximum  selected in the Edit/View 
Motion  dialog box, the object was placed in the desired 
location at the “maximum” input value.

Now, when you click on Object at Minimum  or Object At 
Maximum , GMM moves the object according to these origin
specifications.
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The expression “/1.98” is a scaling factor applied to the 0-1
input from the slide. The “/” indicates division. Thus the valu
being read from address DVR\3:1 will be divided by 1.98 a
the results will be displayed on the screen. This converts i
0-50.51 inches for the display.

With the Text Value box selected, this indicates a text valu
connection in which the pound characters (#) define a varia
field. During operation, the actual input value, scaled by /1.9
displays here.

3. Click off the Text property sheet to close it and return to th
GMM/PTM Panel.

Viewing the Hopper/
Screw Assembly

Configuration

To examine the Hopper and Screw Assembly, follow these 
steps:

1. Click the Hopper And Screw Assembly.

The entire assembly is enclosed in an invisible box, indicat
it is a group object. A single animation connection is applie
to this group of objects.

2. Double-click on the entire assembly to display the Group 
property sheet.

3. Click the Connections page; then, click the Position page.

Notice dvr\4:1.4 in the list. This connection is controlled by
the PTM Push Button configured with the same address. P
tion was chosen rather than motion because the object ha
only two positions, in and out, with no animation in betwee
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During operation, the address reference is evaluated as “tr
or “false” based upon the status of bit 4 as follows:

• If bit 4 = 0, the address reference evaluates “false.” Th
connection is not applied, and the object remains in the
Original Position location.

• If bit 4 = 1, the address reference evaluates “true.” The
connection is applied, and the object moves to the Con-
nection Position location.

The settings are:

• Size Control: None

• Degrees of Rotation: Zero

• Location Control:  X

• Mirror Object:  No

4. Click on Edit/View Position.

The Edit/View Position dialog box appears as shown belo

5. Click back and forth between the Original Position and 
Connection Position buttons.
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Notice the position of the object with and without the conne
tion applied. The object moves to the left at Connection Po
tion. The connection settings are applied to the object whe
the reference data evaluates as “true.”

6. Choose Cancel.

The Selected GMM Objects property sheet displays.

7. Click off the property sheet to return to the GMM/PTM Pan

Viewing the Hopper
Feed Conveyor

Configuration

To examine the Hopper Feed Conveyor, follow these steps:

1. Double-click on the Hopper Feed Conveyor.

The Polygon property sheet appears.

2. Click the Connections page.

The Appearance page is already in view. This is a discrete
connection controlled by a PTM Push Button configured wi
the same address reference.

Advanced Information

This position connection was originally configured in two step

1. With Original Position selected in the Edit/View Position 
dialog box, the object was placed in the desired position 
the “0” or false output value.

2. With Connection Position selected in the Edit/View Posi-
tion dialog box, the object was placed in the desired posit
for the “not 0” or true output value.

Now, when you click on Original Position or Connection 
Position, GMM moves the object according to these original 
specifications.
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The Appearance page has commands for setting various 
attributes of the object. The Foreground Color, Backgroun
Color, and Pattern options are selected indicating the con
tion controls are selected for these parameters.

3. Click on View Appearance.

The View Appearance dialog box appears as shown below

4. Click back and forth between the Original Appearance and 
Connection Appearance buttons.

Notice the color and platen change on the hopper feed 
conveyor. During operation, Interact evaluates the addres
reference as true or false based upon the status of bit 3 as
follows:

• If bit 3 = 0, the address reference reads “false.” Interac
does not apply the connection, and the object maintains
Original Appearance.
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• If bit 3 = 1, the address reference reads “true.” Interact 
plies the connection, and the object assumes the Conn
tion Appearance state.

5. Choose OK .

The Polygon property sheet displays.

6. Click off the property sheet to return to the PTM/GMM Pan

You are finished examining the existing GMM panel.

Adding a Panel
to the Example

Application

In this part of the example, you will enter the development env
ronment and add tools to a panel. These tools are configured 
you can understand how a panel is created. This example assu
you know how to configure PTM tools. If this is not the case, 
review the PTM example in Chapter 5.

In this exercise, you will learn to do the following:

• Create new PTM tools

• Create new GMM objects

• Link the two panels in the PTM Panel List

• Animate the panel in the Run Mode

Advanced Information

This appearance connection was originally configured in two
steps:

1. With Original  selected in the View Appearance dialog 
box, the object was originally drawn and given a Fore-
ground Color, Background Color, and Pattern for the “0” 
or false output value.

2. With Connection Appearance selected in the View 
Appearance dialog box, the object was defined at the “no
0” or true output value.

Now, when you click on Original  or Connection Appearance, 
GMM changes the object appearance according to these orig
specifications.
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Creating a New Panel To create a new panel, follow these steps:

1. Double-click on the Panel Toolkit/Graphics Module (PTM/
GMM)  icon in the Application Browser window.

2. Double-click on the Panels icon.

3. Double-click on the New icon.

A blank PTM panel appears.

4. Click on the Maximize button to maximize your viewing 
window.

Creating PTM Tools Place the following PTM tools along the bottom of the panel y
just created:

1. A Load Panel Action Button.

2. A Maintained Push Button. Use dvr\4:300.1 as the Switch 
Input  address, and enter OFF as the Lens Label.

3. A Slide tool. Use dvr\3:300 for the Slide Input address, and 
use a Minimum Value  of 0 and Maximum Value of 100.

Creating GMM
Objects

To add graphics to your PTM Panel, follow these steps:

1. Draw a rounded rectangle above the PTM tools. Do this b
clicking on the Round Rectangle icon in the GMM Graphics 
Box located at the bottom of the screen. Draw the rectangle
the size shown below.

2. Double-click on the Rounded Rectangle object just created.

The Rounded Rectangle property sheet appears.

3. Click on black in the Foreground Color box.

4. Click on Wire Frame in the Pattern box.

1 2 3
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The Rounded Rectangle object changes from a solid figure
an outline.

5. Click on one of the larger sized lines in the Line Width  box.

6. Click off the property sheet to close it and return to your pan

7. Click on the Ellipse icon in the GMM Graphics Box.

8. Draw a circle on the left side of the rectangle as shown bel

Note If you push the Ctrl key while drawing the ellipse, you wil
draw a perfect circle.

9. After drawing the ball, if you must resize or move it, click o
the Selection Mode button (selector arrow) on the Toolbar. 
Click on the ball you drew to bring up the selection tabs to
either resize or move the ball.

10. Double-click on the ball you just created.

The Ellipse property sheet appears.

11. Click on a pattern with diagonal lines in the Pattern box.

12. Click on a light green color for the ball in the Background 
Color box.
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13. Click off the property sheet to close it.

Note You cannot place a PTM tool over a GMM object. Intera
places all PTM tools on a layer behind the GMM layer, s
you cannot change the order by simply bringing a PTM to
forward. 

The only way to achieve the same effect is to draw all yo
GMM objects first. Make sure you have them exactly th
way you want them. Then save the screen as a backgro
(Edit, Background, Save Image). Open a new panel, an
select the background you just saved (Edit, Background
Select Image). You can now place your PTM tools over t
GMM image.

Applying Animation
Connections to the

Ball

The ball will have two different animation connections:

• Motion

• Appearance

Applyin g a Motion Connection

To apply motion connections, follow these steps:

1. Double-click on the ball.
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The Ellipse property sheet appears. When completely con
ured, the Selected GMM Objects property sheet appears a
shown below:

2. Click the Connections page; then, click the Motion  tab.

3. Click the Add Connection button.

4. Click the Connection Output box.

The Address Reference dialog box appears.

5. Type dvr\3:300 in the Address Reference dialog box.

6. Click OK .

Notice that the address reference you just entered now app
next to No. 1 in the list on the left side of the Motion page.

7. Enter 100 in the Maximum Value box.

8. Click the X option in the Location Control box.

 This will allow the ball to move only along the X-axis.

9. Click on the Edit/View Motion  button.

10. Click Object at Maximum.

11. Drag the ball to the other end of the rectangle.
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This sets the position for the object when the output is at i
maximum value (100).

12. Click on Object at Minimum .

The ball returns to its original position. In Run Mode, Intera
will animate the ball at all locations in-between.

13. Click OK .

Applyin g an Appearance Connection

To apply appearance connections, follow these steps:

1. From the Connections page, click the Appearance page.

2. Click on the Add Connection button.

3. Click the Connection Output box.

The Address Reference dialog box appears.

4. Type dvr\4:300.1 in the Address Reference dialog box.

5. Click OK .

6. Click the Background Color box and choose red.

7. Click the Pattern box, and choose a different pattern from th
original.

8. Click on the View Appearance button.

The View Appearance dialog box appears.

9. Click back an forth between the Original Appearance and 
Connection Appearance buttons.

Notice how the appearance of the ball changes. The Conn
tion Appearance shows how the ball will appear when the 
300.1 is evaluated as “true.”

10. Click OK .
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11. Click off the property sheet to close it.

Saving the GMM
Objects

To save the GMM Objects, follow these steps:

1. On the File menu, click Save Panel As.

The Save As dialog box appears.

2. Enter PTM and GMM File names as shown above. 

Notice the Panel Name is PANEL 1.

3. Make sure the Add to Runtime Panel List option is selected.

4. Click Save.
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Testing the
Example

Application

Once you have saved the GMM objects, you are ready to test
modified example application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. On the Window menu, click Application Browser: 
gmmexamp.

The Application Browser window becomes active.

2. From the Application Browser, click the Application 
Manager icon.

3. On the Run menu, click Run Interact.

4. Click Yes when you are asked to save changes.

5. Go to the Trend Screen by clicking on the Trend Scn button 
in the upper left of the panel.

6. Click on Select Panel From List .

7. Load the panel “Panel 1” by highlighting it and then clicking 
Accept.

Panel 1 is a combination of the PTM and GMM objects yo
created, as shown on page 108.

8. Click on the Push Button.

Since this is a Maintained Push Button, it remains On. Not
how the appearance of the ball changes.

9. Click on the Slide tool tab, and drag the slide to 50.

Note how the ball moves along the rectangular conveyor.

10. Continue moving the slide to 100.

11. Click on the Load Panel button, and choose Tools to exit this 
panel.

12. Click on Go To AM to return to the Application Manager.

13. Click Exit Interact ; then, click Accept.

The Application Manager window appears.
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Experiment! This chapter provides only a brief introduction to the features 
GMM. The best way to learn is to experiment.

• Add additional connections to the panel you created in this
chapter.

• Create the panel shown below; then, animate it.

• Use the Motion connection to change the level of the liquid
the tanks.

• Use a PTM Slide tool to transfer liquid from one tank to the
other.

• Add high and low limit switches using the appearance con
nection.
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Alarm Management Module

The Alarm Management Module (AMM) allows you to define 

alarm conditions and define corresponding reporting, logging, 

and corrective action procedures. AMM has five different 

levels of alarm priority that can be programmed to require 

certain user access levels to disengage or recognize alarms.

This chapter provides an overview of AMM. An example is 

provided that shows you how to set up an alarm configuration 

and incorporate alarm functions into your application.
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Overview of
AMM

The Alarm Management Module (AMM) is an optional softwar
module that runs under the Interact Application Manager (AM
AMM is used to automatically and continuously:

• Monitor conditions within process parameters

• Present alarm information to an operator when these cond
tions are out of tolerance

Detected alarm conditions appear on an Alarm Summary Disp
An alarm is shown as a line of text which has attributes such a

• The time and date the alarm was triggered

• The time and date the alarm went inactive

• The time and date the alarm was acknowledged

• A description of the alarm condition

• The alarm priority level

• Alarm Value (the data value when the alarm was detected

• Current Value (the data value updated in real-time)

• The name of the group to which the alarm belongs

• The name of the operator who acknowledged the alarm

In the development environment, AMM enables you to configu
alarms and their corresponding parameters for unique proces
requirements by:

• Creating new alarms

• Editing existing alarms

• Deleting existing alarms

• Configuring the Alarm Displays which the operator uses d
ing Run Mode

• Configuring the alarm history file and printer settings

In Run Mode, AMM continuously monitors the designated 
process variables for out-of-tolerance (alarm) conditions. Whe
an alarm condition exists, AMM automatically:

• Alerts the operator

• Provides information on the alarm condition

• Enables the operator to acknowledge the alarm
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• Directs the operator to take corrective action

• Lets the operator comment on the conditions and the corr
tive actions taken

AMM can also do the following:

• Automatically produce printed reports and alarm logs on di
for problem investigation and record keeping

• Allow override and adjustment of alarm conditions by per-
sonnel having the correct user level

• Provide alarm information to other Interact modules such 
PTM

An optional alarm message can be attached to an alarm objec
more detailed information is needed.

In Run Mode, alarm information displays in a standard format th
shows a large number of alarm points at one time. Normally, j
the basic attributes of the alarms and real-time data values ar
displayed. The operator can “expand” individual alarm points 
view optional alarm messages if these are configured.

Important
Concepts

The following are important concepts you will need to know as
you use AMM.

Alarm Priorities All alarms must be assigned to one of five priorities numbered
through 5. Priority 1 is the lowest priority and 5 is the highest. 

Note  All alarms assume Priority 3 by default.

This priority number is used in Run Mode to selectively displa
and/or acknowledge alarms. For example, you can configure 
AMM to force an operator to acknowledge all priority 5 alarms
individually instead of all at once.

Priorities may be assigned names which provide the operator w
useful information. The priority name is optional and can be 
between 0 and 8 characters long. 
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The default names are listed below:

You can specify whether priority number will invoke the alarm
annunciation procedure, the method by which AMM notifies th
operator of an alarm. If you specify No Annunciation, the alarm
just displayed on the screen, logged, and sent to the printer (i
configured). Alarms configured for No Annunciation need not b
acknowledged.

Acknowledging
Alarms

You can acknowledge alarms one of two ways, depending on h
AMM is configured:

• All at once (within a specific alarm priority level)

• Individually

You acknowledge alarms by pressing the Acknowledge button
located on the Alarm Summary Display in Run Mode.

You might want to configure AMM to require individual acknow
edgment of critical alarms to force the operator to examine ea
alarm before acknowledging it. An example of how you might 
configure AMM is listed below:

• Priorities 1 through 4 for Acknowledge All

• Priority 5 for Acknowledge Individual

Acknowledgment
User Level

Each Priority can be assigned an Acknowledgment User Leve
This feature can be used to prevent unauthorized personnel fr
acknowledging high priority alarms.

Within Interact there are six user levels (0 through 5) with 5 
providing the least privileges and 0 the most.

Priority # Priority Name

1 Notice (Lowest)

2 Warning

3 Alert

4 Urgent

5 Critical (Highest)
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Alarm Groups All alarms must be assigned to a group. Groups allow alarms to
separated into sets which share something in common:

• All alarms on the same machine

• All alarms of a given priority

• All alarms related to the same process or function

A typical use for alarm groups is to assign the alarms from ea
machine to separate groups. In Run Mode, the operator can en
or inhibit an entire group of alarms at once. This allows you, fo
example, to inhibit the alarms from a machine when that mach
is taken off-line for maintenance.

Note Alarms not assigned to a group are automatically assign
to the default group “Global.” A group can contain alarm
of different priorities.

Sending Alarm
Information to

Another Module

AMM can send alarm information to other Interact modules. F
example, the Panel ToolKit Module (PTM) can be configured 
display alarm messages and acknowledge alarms. To enable
capability, you must configure the Remote Alarm Controls Set
property sheet. You then reference AMM’s reserved “Link Var
ables” from PTM.

Key Assignments Alarm display components (buttons, etc.) can be assigned 
keyboard keys. Pressing an assigned key (or keys) will perfor
the assigned operation. For example, pressing F1 might perfo
the same operation as clicking the Acknowledge button with th
left mouse button.

During configuration of the Alarm Summary, Alarm Control, or
Alarm History Displays, you can change the default key assig
ments to any other key on the keyboard.

The function keys F1 through F10 can be used together with t
Shift, Ctrl, and Alt keys to provide forty function key assignmen
The table below lists possible key assignments.

Pressing these keys Assigns these functions

F1 through F10 F1 through F10

Shift+ F1 through F10 F11 through F20

Ctrl+ F1 through F10 F21 through F30

Alt+ F1 through F10 F31 through F40
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Alarm Runtime
Displays

AMM includes a series of Alarm Displays that are used during
runtime to view and control alarm information. You can configu
the appearance of these screens in the development environm
using the Runtime Display command on the Settings Menu. Y
can also configure the Backup popup displays and the Print 
History popup display.

Overview of the
Example

Application

The following sections provide hands-on experience with alarm
using AMM. This example consists of an application, 
Ammexamp, which contains several alarms and a panel create
PTM. You will explore the example application in several way

• Load the example application and view the Alarm Summa
Display and the example panel

• Trigger several alarms and observe the results

• Acknowledge and clear the alarms

• Turn off audible annunciation

• Inhibit a group of alarms, trigger the alarms, and observe 
results

• Create an alarm using AMM

• Test the modified application

Note This example assumes you have the Panel Toolkit Mod
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Running the
Example

Application

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, select Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Ammexamp; then, click OK . 

The Application Browser appears with the Ammexamp app
cation loaded.
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5. On the Run menu, select Run Interact .

You enter the Interact Run Mode, and the PTM panel desig
for this example appears as shown below.

Note This application was configured to go into Run Mode whe
the Run Interact option is selected. Use the Startup Mo
parameters configured on the Application Settings prope
sheet to configure which runtime mode, module, and 
startup user will be active upon entering Run Mode. For
this application, the PTM panel designed for this examp
is the first Run Mode screen displayed.

Triggering an
Alarm

In a real application, conditions in your actual process will trigg
the alarms. However, in this example, you will manually trigge
the alarms from a PTM panel.

Now you will trigger an alarm from the example panel and the
view the result on the Alarm Summary Display. You will trigge
the alarm using the Horizontal Slide tool at the bottom of the 
screen. A value between 30 and 70 will trigger an alarm.

To trigger an alarm, follow these steps:

1. Move the slider on the Horizontal Slide tool to an approxi-
mate value of 40.
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An alarm is triggered and begins beeping an audible alert.

2. Click Acknowledge Alarms to acknowledge the currently 
selected alarm.

The beeping stops, indicating the alarm has been acknow
edged. Notice the Alarm Conditions display indicates that o
alarm condition exists. Also, a message is displayed in the
Alarm Messages window.

3. Click Go To Alarm Module.

The Alarm Summary Display appears and a row of inform
tion about the alarm is displayed. The text for this alarm is r
The up and down arrows along the right edge of the displa
are scroll buttons.

4. Click the Down Arrow  button to scroll the alarm into the 
dotted capture area at the top of the display.

A message corresponding to this particular alarm appears
the Alarm Message Window located at the upper right of t
screen.

5. Click Expand Message to increase the size of the window an
view the message in its entirety.

6. Once you have read the entire message, click Expand 
Message again to return the window to its normal size.

Turning Off Audible
Annunciation

(Optional)

Before triggering more alarms you may turn off audible alarm 
annunciation, since this is just a practice session. If you wish 
keep the audible ‘beeping’ enabled, skip to the Triggering More 
Alarms section.

To turn off audible alarm annunciation, follow these steps:

1. Click Alarm Control  located at the upper right of the scree

2. Click Audible On located at the bottom of the screen. 

The label on the button changes to Audible Off. Alarms wi
no longer beep.

3. Click Alarm Summary  located at the upper right of the 
screen. 

The Alarm Summary Display appears.
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Triggering More
Alarms

Now you will trigger several more alarms to see how AMM 
handles multiple alarms. As each alarm is activated, observe 
changes to the tools on the PTM panel.

To trigger multiple alarms, follow these steps:

1. Click the left arrow  in the lower left corner of the Alarm 
Summary Display.

The example panel appears.

2. Click the Up Arrow  button, next to the Panel Meter tool, 
until the needle points to a value of 6. 

A value greater than 4 will trigger an alarm.

3. Click the Alarm  button.

This is a Momentary Push Button which triggers an alarm 
when pressed.

4. Drag the slider on the Vertical Slide tool to a value of 6.

An input value greater than 5 will trigger an alarm. Return 
the Alarm Summary Display to see how the alarms were 
reported.

5. Click the Go To Alarm Module button.

The Alarm Summary Display appears.
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6. Click the Up Arrow  button until none of the alarms are high
lighted.

Notice that four alarm conditions are present. The Vert. Sli
and Panel Meter alarms are blinking. This indicates these
alarms have not been acknowledged. 

7. Click the Acknowledge button, which is also blinking, to 
acknowledge the alarms.

The Button Entry alarm is the only alarm which is inactive,
meaning the alarm condition no longer exists. An inactive 
alarm is indicated in two ways: the color of the row is gray
and the Alarm Value field displays “Inactive.”

The alarms are listed on the Alarm Summary Display according
the time at which they occurred. They can also be listed by prio
level, from highest to lowest priority. To do this, complete the 
following steps:

1. Click the List Priority  button located at the bottom of the 
screen.

The alarms are listed by priority with the most critical alarm
listed at the top of the display. Also, the button label chang
to List By Time.
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2. Click the List By Time button located at the bottom of the 
screen.

The alarms are rearranged according to time with the mos
recent alarms at the top of the screen. Also, the button lab
changes to List By Priority.

Clearing Alarms An alarm must be inactive before it can be cleared. Depending
the Clear Alarms button settings, the alarm may also have to 
acknowledged and viewed before it can be cleared.

To clear alarms, follow these steps:

1. Click the Clear Alarms button located at the bottom of the 
Alarm Summary Display.

Notice that the only alarm which clears is the Button Entry
alarm, because it is the only inactive alarm. Before we can
clear the other alarms, we must remove the alarm conditio

2. Click the Left Arrow  button in the lower left corner of the 
display to go to the example panel.

3. Change the values on the Meter, Horizontal Slide tool, and 
Vertical Slide tool to 0.

4. Click Go To Alarm Module button.

The Alarm Summary Display appears. All alarms are now
inactive, since the alarm conditions no longer exist.

5. Click Acknowledge.

6. Click Clear Alarms located at the bottom of the Alarm 
Summary Display.

The alarms are cleared.

Inhibiting a
Group of Alarms

When you create an alarm, you may assign it to a group. Typic
this would be a group of related alarms associated with one 
machine or process. AMM allows you to use groups in two 
powerful ways. First, you can inhibit/enable alarms by group. 
Second, if you are logging alarm activity, you can view the ala
history (logged files) by groups of alarms.
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In this example, the alarms are assigned to one of two groups
Level 1 or Level 2, and all alarms are currently enabled. You w
inhibit Level 2 alarms.

To inhibit a group of alarms, follow these steps:

1. Click the Alarm Control button located in the upper right 
corner of the Alarm Summary Display.

The Alarm Control Display appears. “Level 1” is shown und
the Control Group area in the upper left corner, and the ala
assigned to the Level 1 group are listed in the main area of
display.

2. Click the right arrow  button in the Control Group area.

Level 2 displays as the current group, and the alarms assig
to Level 2 are listed.

3. Click the Enabled button in the Control Group area to inhibi
the alarms in Level 2.

The color of the alarms change to gray, and the line to the ri
of the time display reads “Level 2 Group: Inhibited.” Now yo
will go back to the example panel, trigger some alarms, an
see what happens.

4. Click the left arrow  button located in the lower left of the 
Alarm Control Display.
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The example panel appears.

5. Move the slider to change the value on the Horizontal Slide 
tool to a value between 30 and 70.

6. Click the Up Arrow  button to change the value on the Panel 
Meter tool to a value greater than 4.

7. Click the Alarm button.

8. Move the slider to change the value on the Vertical Slide tool 
to a value greater than 5. 

9. Now you will go to the Alarm Summary Display to see how
the alarms were reported.

10. Click Go To Alarm Module.

The Alarm Summary Display appears. The Button Entry a
Vert. Slide alarms are the only alarms listed.

There are also alarm conditions for the Panel Meter and H
zontal Slide, but since they are both assigned to Level 2, wh
is inhibited, no alarms were triggered. You do not need to 
clear alarms before exiting this example.

Adding an Alarm
to the Example

Application

In this part of example, you will learn to do the following:

• Create an alarm in the development environment

• Test the alarm by triggering it from the example panel and
observing the results

Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. Click Go To AM, located at the lower right of the Alarm 
Summary Display, to return to the Application Manager Ma
Menu.

2. Click Exit Interact ; then, click Accept.

The Interact Application Manager window is displayed.
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Creating a New Alarm You will add a second alarm condition to the Vertical Slide too
Currently, an alarm is triggered at a value greater than 5. The
alarm we create will be triggered at a value greater than 8.

There are two ways to enter a new alarm: entering all new info
mation for a new alarm or copy, paste, and edit an existing ala
For this example, you will copy Alarm 2, the existing Vertical 
Slide alarm, and edit it.

To create a new alarm, follow these steps:

1. Double-click on the Alarm Management Module (AMM)  
icon in the Application Browser.

2. Double-click the Alarm Definitions icon.

The Alarm Definitions window appears. The four alarm de
nitions from the example application are listed as shown 
below:

3. Click on alarm definition number 2, the Vert. Slide alarm. Th
entire row is highlighted.

4. On the Edit  menu, select Copy, or click the Copy button on 
the Toolbar.

5. Click on End of List in the Alarm Definitions  window.

The entire row is highlighted.

6. On the Edit  menu, select Paste, or click the Paste button on 
the Toolbar.

The copied alarm now appears as alarm No. 5, which is h
lighted. You will now edit this alarm.
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7. On the Edit  menu, select Edit Alarm . The Alarm Definition  
property sheet appears.

Note An alternate means of editing an alarm is to simply doub
click on the alarm definition in the Alarm Definitions 
window.

8. Type 2 at the end of the description in the Alarm Description  
box so that the new entry reads Vert. Slide 2.

9. Click the Alarm Trigger Output  box.
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The Address Reference dialog box appears with the addre
listed in the box.

10. Change the 5 to an 8, so the entry reads: dvr\3:101>8.

Now a new alarm will be triggered when the value at locati
3:101 is greater than 8.

11. Click OK .

The Alarm Definition property sheet is displayed.

12. Select Level 2 from the Group box.
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13. Click the Message page of the Alarm Definition property 
sheet.

14. Click Edit .

The Alarm Message Window is displayed.

15. Change both 5s to 8s so the message field reads:

“The Vertical Slide will show an alarm condition when move
above 8. Keep slide switch above 8 to show an active alar
condition.”

16. Click outside the window to close the window and save 
changes.

17. Click OK .

18. Close the Alarm Definitions  window.

19. On the File menu, select Save Alarms.

20. Click Yes.
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Testing the
Example

Application

Once you have created and saved an alarm, you are ready to
the modified example application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, select Run Interact .

3. Click Yes when you are asked to save changes.

The PTM example panel appears.

4. Move the slider on the Vertical Slide tool to a value of 10. 

An alarm is triggered and begins beeping an audible alert.

5. Click the Go To Alarm Module button.

The Alarm Summary Display appears.

6. Click the Acknowledge button to acknowledge the alarm.

This will cause the alarm items to stop blinking.

7. Click on Go to AM, located at the bottom right of the screen
to return to the Application Manager Main Menu.

8. Click Exit Interact ; then click Accept to return to the devel-
opment environment.

Experiment! This chapter provides only a brief introduction to the features 
AMM. The best way to learn is to experiment.

• Practice inhibiting/enabling groups of alarms and individua
alarms.

• Create additional alarms for another tool like you did for th
Vertical Slide.

• Configure the Acknowledge button on the Alarm Summary
Display to acknowledge alarms by priority.

• Configure the Next Alarm button on the Alarm Summary 
Display to view alarms by priority.
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Data Transfer Module

The Data Transfer Module (DTM) allows you to exchange 

data between multiple device drivers. DTM provides a solu-

tion to expensive networking software and hardware with 

inexpensive software connections. There is no limit to the 

number of device drivers that can be used with DTM, and 

there is no extra hardware required.

This chapter provides an overview of DTM. You will learn to 

create an example application that shows you how to transfer 

data directly between controllers.
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Overview of
DTM

The Data Transfer Module (DTM) is a software program used
with the Interact product. It provides a method of transferring d
between device drivers used in your Interact application. This
module is typically used to pass data between different controll

DTM is provided as a module that runs under the control of th
Interact Application Manager (AM). The Data Transfer Module
Application Manager block diagram is shown below.

The following list is a summary of DTM features:

• You can configure Interact applications to transfer data 
between device drivers.

• You can assign data transfers to groups.

• You can form a group from any collection of data transfer 
items. For instance, all discrete data items can be grouped
together.

• You can control individual groups to enable or disable data
transfers.

• You can load, save, or print data transfer configurations.
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You can see a diagram of data transfers between controllers 
below. This graphic illustrates DTM taking data from controller 
(output reference) and transfers it to controller Y (input referenc

During Run Mode, DTM uses the configuration of data transfe
and group assignments to perform the transfers in the backgro
We have not associated a runtime display with DTM.

Creating an
Example

Application

The following sections provide hands-on experience with trans
ring data between fictitious controllers using the Data Transfe
Module (DTM).

DTM does not use any runtime screens. There is no example a
cation that is shipped with Interact. You must create the applic
tion yourself. In this example you will learn to do the following:

• Create an application using the Data Transfer Module 
(DTM), the Panel Toolkit Module (PTM), and two Demo 
Drivers (DVR)

• Rename each of the Demo Drivers TI (Texas Instruments)
and AB (Allen-Bradley) to allow simulation of two PLC 
drivers
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• Design a PTM panel to display the data transfers in runtim

• Configure DTM to send data from the TI driver to the AB 
driver

• Run the application and view the transfers taking place on 
PTM panel

Note This section assumes you have the Panel Toolkit Modu
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Creating an
Application

To create an application, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, click New Application.

The New Application dialog box appears.

3. Type Dtmexamp in the Application Name box.

4. Click OK .

The Application Browser appears.

Assigning the
Modules and Drivers

1. Double-click the Modules Used icon in the Application 
Browser.

The Modules Used dialog box appears.
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2. Add PTM and DTM to this application:

a. Click Panel Toolkit (PTM) in the Modules Available list.
b. Click Add. PTM is now listed in the Modules Used By 

list.
c. Click Data Transfer (DTM)  in the Modules Available 

list.
d. Click Add. DTM is now listed in the Modules Used By 

list.

3. Click OK .

4. Double-click the Drivers Used icon in the Application 
Browser.

The Drivers Used dialog box appears.

5. Drivers are added to applications the same way as Modul
Add the Demo driver to this application twice:

a. Click Demo Driver in the Drivers Available list.
b. Click Add. The driver is now listed in the Drivers Used

By list.
c. Click again on Demo Driver in the Drivers Available list.
d. Click Add. The Demo Driver is now listed twice in the 

Drivers Used By list. 

Notice that the second driver is listed as Demo Driver 
(DVR0). The names DVR and DVR0 indicate that the two 
Demo drivers are unique.
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6. Rename the drivers TI and AB:

a. Click on Demo Driver (DVR) in the Drivers Used By list.
b. Type TI  in the Driver Name text box located below the

Drivers Used list.
c. Click on Demo Driver (DVR0) in the Drivers Used By 

list.
d. Type AB in the Driver Name text box located below the

Drivers Used list.

The Drivers Used dialog box on your screen should look li
this:

7. Click OK .

The two demo drivers will appear in the Application Browse
window.

Designing a
PTM Panel

Next you will build a PTM panel. One side of the panel will 
contain tools tied to the TI driver. The other side of the panel w
be dedicated to tools tied to the AB driver. It is important to no
that both of these drivers are the Demo driver which you have
renamed TI and AB.

TI Tools To configure the TI tools, follow these steps:

1. Double-click on the Panel Toolkit Module (PTM) icon in the 
Application Browser.

2. Double-click on the Panels icon.

3. Double-click on the New icon.
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A new PTM panel window appears. When this section is 
completed the panel should resemble the one shown belo

Note The numbers labeling each tool will not appear. The 
numbers are for the purpose of this exercise only. Do NO
add these numbers. All tools are created using the PTM t
buttons located along the right edge of the PTM window
To distinguish which buttons are tied to which tools, plac
the cursor over a button and a Tool Tip will appear 
displaying the name.

4. Create tool #1. This tool is a Numeric Display. Size and pla
this tool on the screen as shown above.

5. Double-click the Numeric Display tool.

The Numeric Display property sheet appears.

6. Enter the following settings for the Numeric Display on the
Settings page:

• Field Size: 4

• Display Value Output: Ti\timer1

Note Clicking the Display Value Output box displays the 
Address Reference dialog. Type the address in the box, 
click OK.

7. Click the Appearance page.
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8. Enter the following settings for the Numeric Display on the
Appearance page:

• Tool Color:  gray

• Font: eurostyl

9. Click outside the Numeric Display property sheet to close i

10. Create tool #2. This tool is a Push Button. Size and place 
tool on the screen as shown in the figure on page 135.

11. Double-click the Push Button tool.

The Push Button property sheet appears.

12. Enter the following settings for the Push Button:

• Type: Maintained Button

• Switch Input:  Ti\1:2.1

Note Clicking the Switch Input box displays the Address Refe
ence dialog box. Type the address in the box, and click O

13. Click outside the Push Button property sheet to close it.

If you desire, you can place Panel Labels as shown in the
figure on page 135.

AB Tools To configure the AB tools, follow these steps:

1. Create tool #3. This tool is another Numeric Display. Size a
place this tool on the screen as shown in the figure on pag
135.

2. Double-click the Numeric Display tool.

The Numeric Display property sheet appears.

3. Enter the following settings for the Numeric Display on the
Settings page:

• Field Size: 4

• Display Value Output: Ab\1:1

Note Clicking the Display Value Output box displays the 
Address Reference dialog. Type the address in the box, 
click OK.
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4. Click the Appearance page.

5. Enter the following settings for the Numeric Display on the
Appearance page:

• Tool Color:  green

• Font: eurostyl

6. Click outside the Numeric Display property sheet to close i

7. Create an Indicator tool. This is tool #4. Size and place th
tool on the screen as shown in the figure on page 135.

8. Double-click the Indicator tool.

The Indicator property sheet appears.

9. Enter the following setting for the Indicator on the Settings 
page:

Lens Output 0: Ab\4:1.1

Note Clicking the Lens Output 0 box displays the Address Ref
ence dialog. Type the address in the box, and click OK.

10. Click the Appearance page.

Notice that the Lens Label State 0 page is selected.

11. Select red for the Lens color.

12. Click the Lens Label State 1 tab.

13. Select yellow for the Lens color.

14. Click outside the Indicator property sheet to close it.

If you desire, you can place Panel Labels as shown in the
figure on page 135. For an example of the Panel Label ico
see Using the PTM Toolbar on page 80.

Configuring the
Output Tool and Panel

Labels

To configure the Push Button and Panel Labels, follow these 
steps:

1. Create tool #5. This tool is a Push Button. Size and place 
tool on the screen as shown in the figure on page 135.

2. Double-click the Push Button tool.

The Push Button property sheet appears.
Interact Getting Started Guide 137



Designing a PTM Panel Chapter 8: Data Transfer Module

r-

 the 
3. Enter the following settings for the Push Button on the 
Settings page:

• Type: Maintained Button

• Switch Input:  Ti\1:3.3

Note Clicking the Switch Input box displays the Address Refe
ence dialog. Type the address in the box, and click OK.

4. Click the Appearance page:

5. Enter the following setting for the Indicator on the Appear-
ance page:

Tool Color: gray.

Notice that the Lens Label State 0 page is selected.

6. Click Edit .

The cursor appears on the lens of the tool.

7. Type the word Control .

8. Click the left mouse button to return to the property sheet.

9. Click on the Lens Label State 1 tab.

10. Click Edit .

11. Type the word Enabled.

12. Click the left mouse button to return to the property sheet.

13. Click outside the Push Button property sheet to close it.

If you desire, you can place the Panel Labels as shown in
PTM panel window on page 135.

Saving the Panel To save the panel, follow these steps:

1. On the File menu, click Save Panel.

2. In the Panel Name box, leave the name set to the default 
Panel1.

3. Make sure that Add to Runtime Panel List is selected.

4. Click Save.

5. On the File menu, click Close Module.
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The PTM panel has been configured for this example.

Configuring
DTM

Configure DTM to demonstrate the transfer of data between th
two drivers.

To configure DTM, follow these steps:

1. Double-click the Data Transfer Module (DTM) icon from 
the Application Browser.

2. Double-click the Group Setup icon.

The Group Setup dialog box appears.

3. Click Add Group .

4. Type Control in the Group Name box.

5. Click in the ‘Group Enabled’ Output  box.

The Address Reference dialog box appears.

6. Type Ti\1:3.3; then, click OK .

7. Click OK .

8. Double-click the Data Transfers icon.

9. Double-click on End Of List .
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The Data Transfer Entry dialog box appears as shown bel

10. Enter the following settings for the data transfer:

• Source Output: Ti\timer1

• Destination Input:  Ab\1:1

• Group: Control

Note Clicking the Source Output and Destination Input boxes
display the Address Reference dialog. Type the address
the box, and click OK.

11. Click OK  in the Data Transfer Entry  dialog box.

12. Double-click on End Of List .

The Data Transfer Entry dialog box appears as shown abo

13. Enter the following settings for the data transfer:

• Source Output: Ti\1:2.1

• Destination Input:  Ab\4:1.1

• Group:  Control

14. Click OK  on the Data Transfer Entry  dialog box.

15. Click the Close button.
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Testing the
Example

Application

Once you have created and configured an application using th
Data Transfer Module (DTM), you are ready to test the modifi
example application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, click Run Interact.

3. Click Yes to save the application.

The Application Manager Main Menu is displayed.

4. Click on Run/Prog Mode to enter Run mode.

5. Click Go to Module.

The PTM panel you just created is displayed.

Note DTM does not have a runtime screen. Its purpose is to p
information from one driver to another during Run Mode
DTM does this in the background. The PTM screen you
created and are viewing was made for the sole purpose
viewing the transfers. PTM is not necessary when using
DTM.

6. DTM was configured to send data from the TI driver to the A
driver. However, transfers will only occur when the ‘Contro
Output bit is ‘true.’

Notice that the timer value in the upper left of the display i
changing.

7. Click the Push Button in the lower left corner of the display

The data from these tools is not being sent to the tools tied
the AB driver at this time.

8. Now click the Control Button  in the center of the panel.

The Indicator changes from red to yellow.

The Control Button is tied to the ‘Control’ Output bit. Now th
data from the Numeric Display on the left is being transferr
to the Numeric Display on the right side of the screen.
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9. Click the Push Button in the lower left corner of the display

Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. Press F10 to return to the Application Manager.

2. Click Exit Interact ; then, click Accept.

The Interact Application Manager window is displayed.

Experiment! This chapter provides only a brief introduction to the features 
DTM. The best way to learn is to experiment.

• Configure additional PTM tools such as a Slide tool tied to
TI reference, and transfer this data to a Horizontal Bar too
tied to an AB reference.
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Histor ica l  Trending Module

The Historical Trending Module (HTM) gathers selected data 

from your process or machine control and writes the data to a 

storage device via “data logging.” This data can be used to tell 

the use and/or history of the machine or process.

This chapter provides an overview of HTM. An example is 

provided that shows you how to record and view data that is 

routed through Interact.
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Overview of
HTM

HTM is an optional software module that runs under the Intera
Application Manager (AM). HTM gathers selected data from yo
process or machine control and writes the data to a mass stor
device. This process is called “data logging.” Each data loggin
event records a snapshot of selected variables to a log file. HT
lets you view this information in several formats to obtain a hist
ical perspective of the process or machine operation.

Important
Concepts

The following are important concepts you will need to know as
you use HTM.

Log Files HTM creates log files during run time. Log files consist of recor
containing data for up to 16 variables. As HTM creates log files
assigns them sequential numbers (001, 002, etc.) up to a maxim
number (referred to as the Maximum File Number). HTM mar
each record in the log file with a record number, a time stamp, 
a date stamp. It then assigns the following values in the listed
format to each record:

Record# Timestamp Datestamp Value1 Value2 
Value3....Value16

Log files are defined by a log form. If it is necessary to track mo
than 16 variables, you can create more than one log form for 
process. HTM writes records to the log file each time a Log 
Trigger occurs. A Log Trigger specifies an event, such as a tim
interval or data change that triggers HTM to write a record into
data log file.

HTM logs data to a log file until certain criteria are met. Then,
file break occurs. At the time of the file break, the current log f
is closed and a new one is opened for continued data logging
file break can also be based on a time interval or data change

HTM lets you view the logged information in two different 
formats: a Chart Display and a Trend Display.
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Log Forms A log form is a template that controls the data logging process
Log forms determine what data variables are logged and how
log files are created and managed. The set of log files associa
with a log form is called a data log.

Log forms contain fields that define the following information:

• The location (path name) of the data log

• What variables are written to the log file

• The maximum number of log files associated with the data
log

• How and when the information is written to disk

You can create as many log forms as needed for your applica

Data Log The set of data files associated with a log form is called a data 
When creating a log form, you specify the maximum number o
log files the data log may contain. You also specify what happe
when the maximum number is reached. There are two options

• Data logging stops until the operator manually restarts it, o

• Data logging continues, with new log files overwriting the 
old. This is called “recycling” the data log.

During run time, the operator can start and stop data logging at
Logging Control Display. When logging stops, a data log is sa
to be inactive. Data can be written only to active data logs.

Log Form List HTM can manage many data forms and data logs simultaneou
During the configuration of an application, you create a Log Fo
List to specify which log forms are used and enabled during R
Mode. You must enter the log form on the Log Form List befo
an application can use it. During Run Mode, the operator can 
change the enabled/disabled status of any log form.
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Write Interval When HTM logs a data record, it temporarily stores the record
a buffer in memory. Because of the time-consuming nature of d
writes, HTM only writes the records to disk at the interval you 
specify or when the buffer is full.

File Conversion Utility HTM comes with a utility that allows you to convert log files to
ASCII format so you can use the information with other applic
tions. Select the Convert Log command from the File menu to 
this utility.

Note The File Conversion Utility is also available during Run 
Mode from the Logging Control Display.

Runtime Displays In Run Mode, the device driver and all Interact modules for th
application load and begin running. All data log features are 
active, and you can begin data logging.

HTM includes a series of displays that are used during runtime
view and control data logging. You can configure the appeara
of these screens in the development environment using the 
Runtime Display command on the Settings Menu. You can als
configure the various runtime popup displays, including the 
Backup popups and the Print History popup.

Trend Display

The Trend Display lets you load a data log and view the data 
trend graph form (like a stripchart). This is the first screen that
appears when you enter the Run Mode. Initially, the Trend Disp
is blank since no data has been loaded.

After loading a log file, up to eight variables appear. Each is rep
sented by a pen that draws a trend graph for that variable. On c
monitors, you can display each pen in a specific color.

Buttons on the Trend Display let you:

• Initiate a real-time trend update

• Scroll horizontally (in time) through the file showing the dat
and time stamps under the Trend graph’s update

• Move to three other run time displays

• Adjust the Y-axis (vertical) amplitude of the display. This 
does not affect the data, only how the data appears on the
screen.
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• Adjust the X-axis (horizontal) time span of the display. 
Again, this does not affect the data, only how the data appe
on the screen.

• Change pen assignments and select the Y-axis scale

• Print the displayed trend graphs. To print other portions of t
data log, you must first scroll to that data.

• Perform a search

• Go to next module, previous module, and return to the AM
main menu

Above the trend display is the slide cursor button that moves a
cursor right and left. Data values under the cursor appear at the
of the screen, in the same color as the pen. The date and time
stamps display under the trend data.

At the top of the screen is a message window. The first line of t
window displays status messages. If your application includes
Alarm Management Module (AMM), the second line of the 
window notifies you of alarms.

Chart Display

The Chart Display lets you load a data log and view the data i
numeric (chart) form. For each record the following informatio
appears:

• record number

• time and date

• variable values

Buttons to the right of the screen let you scroll up and down 
through the data. If the record has more than four variables, y
also can scroll right and left.

Other buttons on the Chart Display let you do the following:

• Move to three other runtime displays

• Perform a search

• Print the log

• Go to the next module, previous module, and return to the
AM main menu
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Load Data Log Display

The Load Data Log Display lets you load a data log for view in
either the Trend Display or the Chart Display. The Trend Displ
and the Chart Display are independent, and you can load diffe
data into each.

A selection box follows the cursor as you move it over the list. T
variables for the boxed data log appear below the list, and the 
line comment entered in the development environment also 
displays.

Logging Control Display

The Logging Control Display lists the data logs and lets you 
perform data log operations during run time.

A selection box follows the cursor as you move it over the list. 
highlight a data log, place it in the capture box; then, click with t
left mouse button. Now, you can do the following:

• Enable/Disable the data log

• Force a file break which overrides the configured file criter

• Back up the entire data log or a particular file within the lo

• Convert the log data to ASCII text format

• Erase the log from disk

• Create a new data disk

Additional buttons move you to the next module, previous 
module, and return to the AM main menu.

Overview of the
Example

Application

The following sections provide hands-on experience using the
HTM example application, Htmexamp. Htmexamp contains 
several existing log forms. In a real application, log forms wou
be configured to monitor addresses in your controller, but log 
forms in this example are configured to monitor addresses in 
demo driver.

You will explore the example application in several ways:

• A log form, MONITOR1, is configured to automatically 
begin logging as soon as you enter Run Mode.

• You will load and examine the data log on the Trend and 
Chart Displays.
148 Interact Getting Started Guide



Chapter 9: Historical Trending Module Running the Example Application

 

ule 
r 
 

li-
• You will edit a log form in the development environment.

• Test the modified example by generating a new data log in
Run Mode to see the effects of editing.

Note This example assumes you have the Panel Toolkit Mod
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Running the
Example

Application

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, click Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Htmexamp; then click OK . 

The Application Browser appears with the Htmexamp app
cation loaded.

5. On the Run menu, click Run Interact.

6. Click Yes when you are asked to save changes.
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You enter the Interact Run Mode. The HTM Trend Display
appears as shown below:

Note This application was configured to go into Run Mode an
display the Trend Display when the Run Interact option 
selected. Use the Startup Mode parameters configured 
the Application Settings property sheet to configure whic
mode, module, and startup user will be active upon enter
Run Mode. As soon as you enter Run Mode, the examp
will begin logging, so you may notice your hard drive’s 
indicator light blinking.

Loading a Data Log
into the Trend Display

First, we will explore the features of the Trend Display by loadin
and examining a data log. 

To load a data log, follow these steps:

1. Click Load Data Log.

The Load Data Log display appears.

2. Place the selection box over MONITOR1 , and click.

3. Click Accept.
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The data log MONITOR1 is loaded and drawn on the Tren
Display. The display will look similar to the one shown below

4. Click the Expand X-Scale button once, the second button 
from the bottom along the right edge of the screen.

The graph is redrawn to the new scale. The scale should be
to 10 sec/div.

Moving the Sliding Cursor and Turning Off Pens

Each data field is listed in the column on the left side of the scre
Notice that the value of each data field is listed. Each data fiel
plot is drawn in the same color as its text.

To move the cursor and turn off pens, follow these steps:

1. Drag the sliding cursor (the gray tab at the top of the Tren
Display) to the left or right, and notice how the values chan
as the cursor moves.

Because there are many values shown, the display is clutte
You will turn off the plot for the data field “TEMP Zone 2.”

2. Click the Pen\Scale button.
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The Pen Assignments and Y-Axis Scale menu appears as
shown below. The pens are listed and identified by the da
fields assigned to them. They are all highlighted because t
are currently turned on.

3. Click TEMP Zone2.

The highlighting disappears, which means the pen is turne
off.

4. Click Continue.

If you wanted to permanently change these settings, you co
click on Save Settings; then click on Continue. The Trend 
Display would reappear, and TEMP Zone2 would no longe
be displayed.

Adjusting Bias

There is still an overlap between the Speed and Blower data fie
so you will move the Blower plot by adjusting its bias.

To adjust the bias, follow these steps:

1. Click the Pen/Scale button.

The Pen Assignment and Y-Axis Scale menu appears.

2. Drag the pen slide selector down to point to Blower.
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To the right of the cursor is the Y-Axis Scale bias group. T
box is labeled Blower. The bias is a discrete pen’s Y-axis 
offset from zero, and the current bias is 80 percent. You w
change it to 90, and the plot will move up accordingly on th
Y-Scale.

3. Click the square button to the right of the number 80.

A Keypad appears.

4. Type 9, 0; then click Enter.

The Pen Assignments and Y-Axis Scale menu reappears w
a new value of 90 set for the blower bias.

5. Click Continue.

The Trend Display reappears. Notice that the Blower plot 
shifted up to a bias of 90. This appears close to the top of 
display.

Changing Y-Scale

The current Y-axis scale is set to percent. Change the Y-axis s
to reflect the units of the TEMP Zone1 plot.

To change the Y-Scale, follow these steps:

1. Click the Pen/Scale button. 

The Pen Assignment and Y-Axis Scale menu appears. 

2. Drag the pen slide selector up to point to TEMP Zone1.

3. Click Pen in the Y-Axis Scale group.

“TEMP Zone1” appears in the window.

4. Click Continue.

The Trend Display reappears. Notice that the Y-axis coord
nates now correspond to TEMP Zone1.
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Loading a Data Log
into the Chart Display

In this part of the example, you will explore the Chart Display b
loading and examining a data log.

To load a data log, follow these steps:

1. From the Trend Display, click the Chart Display button 
located at the top right edge of the screen (the tablet icon)

A blank Chart Display appears because of the lack of data

2. Click the Load Data Log button.

The Load Data Log Display appears.

3. Place the selection box over MONITOR1 and click.

4. Click Accept.
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The data log MONITOR1 is loaded and appears on the Ch
Display as shown below:

Examining the Data Log

The records of the data log are displayed in a tabular format. T
date and time of each record is listed on the left side of the vert
dotted line, and the data fields are listed on the right. The arrow
the far right side of the column headings indicates there are m
data fields to the right.

To examine the data log, follow these steps:

1. Click the right arrow  button, located on the right edge of th
screen, to scroll right by one data field.

Notice the data fields scroll, but the record number, date, a
time remain in place.

2. Click the left arrow  button, located on the right edge of the
screen, to scroll left by one data field.

3. Click the down arrow button, located on the right edge of th
screen, to page down through the records.
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Searching for a Data Value

A powerful feature of HTM is its ability to search a data log for
specific times or data values. In this series of steps, you will sea
for a value in the TEMP Zone2 column.

To search for a data value, follow these steps:

1. A search begins from the current position in the data log. Cl
the Beginning of Data Log button, which is the second button
from the bottom on the right edge of the display.

You move back to the very beginning of the data log. Notic
the top record is record number 1. The search will start wit
the top record (record number 1) and end when a match is
found or the end of the data log is reached.

2. Click the S button located on the right edge of the display. 

The Search menu appears as shown below. The Data Se
button is selected, indicating this is the Data Search menu

3. Click TEMP Zone2 in the left selection box.

It appears in the window at the top of the selection box. Th
equal sign (=) already appears as the current comparison o
ator.
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4. Click the CONST button (Numeric Constant).

A keypad appears.

5. Type 4, 0, 0; then click Enter.

The Data Search menu appears with the TEMP Zone2 par
eter equal to 400.

Now you will add a small deviation factor to the numeric consta
Maybe the data field never had a value of exactly 400, but you 
want to know if it was within a certain range.

6. Click the gray button in the Deviation area.

A keypad appears.

7. Click 3; then click Enter.

A deviation of 3 is entered in the Deviation area. This mea
that the search will consider any value between 397 and 4
(inclusive) to be a match.

8. Click the Search button.

You return to the Chart Display while the searching starts.

When the first occurrence of TEMP Zone2=400 +/-3 is 
located, the record is displayed at the top of the list, and 
Search Successful appears in the Message Window.

To search for the next occurrence, follow these steps:

1. Click the S button.

The Search menu appears, and the search string of TEMP
Zone2=400 is displayed.

2. Click the Search button.

The search will begin at the current position in the data log
and stop at the next match.
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Application

In this part of the example, you will enter the development env
ronment and add a data field to the log form MONITOR1. The
you will go back to Run Mode and see the new data field plott
on the Trend Display.

Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. Press F10 to return to the Application Manager Main Menu.

2. Click Exit Interact ; then click Accept.

The Interact Application Manager window is displayed.

Loading the Log Form To load a log form, follow these steps:

1. Double-click the Historical Trending Module (HTM)  icon.

2. Double-click the Log Forms icon.

3. Double-click the MONITOR1  icon.

The Record Data Fields window is displayed as shown bel

Adding a Data Field

To add a data field, follow these steps:

1. Double-click on End-of-List .

2. On the Edit  menu, click Insert Field.
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The Field Definition dialog box appears as shown below:

3. Type Fan in the Name box.

4. Click on Discrete in the Data Type box.

5. Click the Output  box.

The Address Reference dialog box appears.

6. Type dvr\timer1&64 .

7. Click OK

8. Enter 60 in the Graph Bias box; then click OK .

The Record Data Fields window now reflects your addition
Data Field number 6.

Adding a Log Form Comment

To add a log comment, follow these steps:

1. On the File menu, click Log Form Properties.

The Log Form Properties property sheet appears.

2. Click the Comments page.
Interact Getting Started Guide 159



Testing the Example Application Chapter 9: Historical Trending Module

 

us 
at 
The Comments page appears.

3. Type Added data field FAN in the Comment Line 1 box.

4. Click OK .

The Record Data Fields window is active.

5. Close the Record Data Fields Close window.

6. Click Yes to save changes to the MONITOR1.HTM form.

Testing the
Example

Application

Now that you have modified the example application using the
Historical Trending Module (HTM), you are ready to test the 
application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser click the Application 
Manager icon. 

2. On the Run menu, click Run Interact.

3. Click Yes when you are asked to save changes.

The Trend Display appears.

4. Click on Logging Control.

The Logging Control Display appears. Notice that the stat
message (in red) for MONITOR1 reports that the log form
changed.
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Erasing Old Log Files Since you added a data field to the log form, the previously logg
records are incompatible with the new log form. All the old log
files must be deleted, and logging must begin in the new form

To erase old log files, follow these steps:

1. From the Logging Control display, select MONITOR1  by 
placing the selection box over it and clicking.

2. Click Erase Log.

A menu appears which allows you to continue with or canc
the erase.

3. Click Continue.

The data log is empty, meaning all the old log files have be
deleted.

4. Click Data Log Enable/Disable located in the upper left 
corner of the display.

This re-enables the data log MONITOR1, and logging beg
immediately.

5. Click Leave Log Ctrl.

The Trend Display appears.

Loading the Data Log To load the new data log, follow these steps:

1. Click Load Data Log.

The Load Data Log Display appears.

2. Select MONITOR1  by placing the selection box over it and
clicking.

Notice the log form comment that you added is displayed 
the bottom of the screen.

3. Click Accept.

The data log MONITOR1 is loaded and drawn on the Tren
Display.
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Adjusting the X-Scale
and the Pen
Assignment

Adjust the X-Scale so that the display is easier to read.

To adjust the X-scale and the pen assignment, follow these 
steps:

1. Click once on the Expand X-Scale button, this is the second
button from the bottom along the right edge of the screen.

The graph is redrawn at the new scale. The graph still appe
much as it did before you added the new data field. You w
not see a plot for the new data field until you assign it to o
of the pens.

2. Click the Pen/Scale button.

 The Pen Assignment and Y-Axis Scale menu appears.

3. Drag the pen slide selector down to point to the third pen,
TEMP Zone2.

4. Click FAN in the list of data fields to the right.

FAN, the data field we added in the development environ-
ment, is now assigned to the third pen.

5. Click the fifth pen, Speed, to toggle this pen off.

This will make it easier to view the plot of your new data fiel

6. Click Continue.

The Trend Display reappears. Four data field plots are sho
and the second one from the top is FAN.

7. Click Go To AM, located at the bottom right of the screen, 
return to the Application Manager Main Menu.

8. Click Exit Interact ; then click Accept to return to the devel-
opment environment. 
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Experiment! This chapter provides only a brief introduction to the features 
HTM. The best way to learn is to experiment.

• Load one of the example log forms in the development en
ronment. Add a data field, and change the configuration o
the Trend Display to allow more pens to be assigned. Loa
the edited log form in Run mode, and observe the results.

• Back up a data log from the Logging Control screen.

• Search for data and time values in a data log from the Tre
Display or the Chart Display.
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Recipe Control  Module

The Recipe Control Module (RCM) helps you create a library of 

recipes containing process values. You can load, modify, and store 

these recipes online as called for by your production process. 

RCM automatically produces a recipe activity log for each recipe. 

The logs are stored in ASCII comma delimited format for ease of 

review.

This chapter provides an overview of RCM. The included example 

will show you how to create a recipe, load it into memory, and 

send it to a controller.
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Overview of
RCM

RCM is an optional software program that runs under the con
of the Interact Application Manager (AM). RCM allows you to 
create and modify recipes, load recipes into memory, downloa
recipes to a controller, and save recipes to disk. You can also
configure recipes to be sent automatically using “triggers” such
an event or the time of day.

When you configure a recipe, you enter (preset) the values th
will be downloaded to the controller. During Run Mode, operato
with the proper user level can modify the preset values before
download to adjust to current manufacturing conditions. If 
maximum and minimum values were assigned during configu
tion, edited preset values are checked to ensure they remain 
between these limits. An example of a recipe appears below:

When the recipe Plastech is downloaded to the controller the 
following events occur:

• The analog value 220 is written to address DVR\4:102 
(RESIN 1)

• The analog value 320 is written to address DVR\4:104 
(RESIN 2)

• The discrete value 1 is written to address DVR\4:106 
(COLOR RED)

Important
Concepts

The following are important concepts you will need to know as
you use RCM.

Scaling the
Downloaded Values

RCM includes a feature which allows analog data values to be
“scaled” by a given percentage before downloading. This featu
known as “percent scaling” adjusts every analog value in the 
recipe for which scaling was configured.

Recipe Name: Plastech

Variable
Name

Variable 
Type

Controller
Address

Value

RESIN1 Analog DVR\4:102 220.00

RESIN2 Analog DVR\4:104 320.00

COLOR RED Discrete DVR\4:106 1
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Uploading Values
from the Controller

Another unique feature of RCM allows variables to be read fro
the controller and saved in a recipe for future downloading. 
Reading values from the controller is called “uploading.”

User Levels During configuration, most components on the Recipe Display
and the Edit Recipe Display can be assigned a user level to res
access to that function. Interact supports six user levels numbe
from 0 to 5. User level 0 is the highest user level, offering the m
privileges; user level 5 is the lowest user level, offering the lea
privileges.

You may decide to restrict operators from some or all of the fu
tions critical to the operation of RCM. To restrict operators fro
using a function, you must assign each operator a user name.
must then assign a user level to the user name that defines the
ations available to each operator.

For more security, you can assign each user level a unique al
numeric password in the Application Manager. Passwords mus
between 1 and 15 characters long.

Key Assignments The Recipe Display is used by the operator during Run Mode
Recipe Display components can be assigned keyboard keys t
the operator can press to move directly to the component and
perform the assigned operation. For example, pressing F2 mi
perform the same operation as clicking the Percent Scale butt
with the left mouse button. The default key assignments for th
Recipe Display components are listed below.

Note During configuration of the Recipe Display, you can 
change the key assignments to any key on the keyboar

Component Default Key Assignment

Send Recipe to Controller button F1

Percent Scale button F2

Recipe Message Window F3

Edit Recipe button F4

Recipe Activity button F5

Scroll Up button CTRL- PAGE UP

Scroll Down button CTRL-PAGE DOWN

Page Up button PAGE UP
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The function keys F1 through F10 can be used together with t
Shift, Ctrl and Alt keys to provide 40 function keys, listed belo

Run Mode You can perform the following operations using the RCM Run
Mode:

• Download recipes to a controller, either manually by an op
ator or automatically triggered by a controller event or the 
time of day

• Upload values to be used in a recipe from a controller

• Load and save recipes

• Edit recipes online

• Scale recipe data before downloading

• Log recipe activity to a file

Page Down button PAGE DOWN

Beginning of File button HOME

End of File button END

Load Recipe button F6

Save Recipe button F7

Backup Log button F7

Delete Recipe button F8

Print Log button F8

Go To Module button F9

Previous Module button Not Assigned

Next Module button Not Assigned

Component Default Key Assignment

Pressing these keys Assigns these functions

F1 through F10 F1 through F10

Shift+ F1 through F10 F11 through F20

Ctrl+ F1 through F10 F21 through F30

Alt+ F1 through F10 F31 through F40
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Overview of the
Example

Application

The following sections provide hands-on experience with actu
Recipe Module recipes. This example consists of an applicatio
Rcmexamp, which contains several recipes and a panel create
PTM. You will explore the example application in several way

• Load and view a recipe on the RCM Run Mode Recipe dis
play and send the recipe to the demo “controller”

• View a related PTM panel which displays current recipe 
information

• Edit the recipe

• Test the modified example

Note This example assumes you have the Panel Toolkit Mod
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Running the
Example

Application

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, click Open Application. 

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Rcmexamp; then, click OK .

The Application Browser appears with the Rcmexamp app
cation loaded.

5. On the Run menu, click Run Interact.

6. Click Yes when you are asked to save changes.
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You enter the Interact Run Mode. The PTM panel used wi
this example is displayed.

Note This application was configured to go into Run Mode whe
the Run Interact option is selected. Use the Startup Mo
parameters configured on the Application Settings prope
sheet to configure which mode, module, and startup use
will be active upon entering Run Mode. For this applicatio
the PTM panel used with this example is the first Run 
Mode screen displayed.

Loading a Recipe To load a recipe, follow these steps:

1. Click on the Go To Recipe Module button.

The Recipe Display appears.

2. Click on the Load Recipe button located in the lower left 
corner of the display.

A list of recipes is displayed.

3. Move the selection bar over recipe Durogoop, and click to
select the recipe.

Durogoop is now shown as the Selected Recipe in the Rec
Load Message Window.

4. Click on the Accept button located in the upper right corner o
the Recipe Display.

The Durogoop recipe is displayed on the RCM Recipe Disp
as shown below.
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The recipe items are listed on the screen along with their 
current values.

Sending the Recipe to
the Controller and
Viewing the Panel

In a real application, you will see the effect of downloading a 
recipe to the controller in your actual process. For this examp
you can see the effect of downloading a recipe to the demo dr
on a PTM panel.

To download the recipe and view the result, follow these steps

1. Click the Send Recipe To Controller button located in the 
upper left corner of the Recipe Display.

The recipe is downloaded to the demo driver. A message 
appears in the Recipe Message Window indicating the rec
has been sent.

2. Click the left arrow  button located in the lower-left corner o
the display.
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The PTM panel used with this example is displayed as sho
below:

The bottom half of the example panel contains PTM tools 
which display current recipe values in the controller and 
perform other PTM operations. The name of the current 
recipe, Durogoop, is displayed on the Indicator  tool in the 
lower left of the screen.

Note The top half of the example panel contains tools used to
demonstrate Remote Recipe features.

Editing the Recipe From the RCM Recipe Display, editing of recipe data values can
be performed. 

To edit data in the recipe, follow these steps:

1. From the PTM example panel, click Go To Recipe Module.

The RCM Recipe Display appears.

2. Click the Edit Recipe button found in the upper right corner
of the display.

3. Click the value 220.000 for the item Resin 1.

A Numeric Entry Keypad appears.
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4. Click 5, 0; then, click Enter.

Resin 1 now has a value of 50.

5. Click the Save Recipe button located at the bottom of the 
screen.

The Recipe Save Message Window displays Durogoop as
selected recipe.

6. Click the Accept button found in the upper right corner of th
display.

7. Click the next Accept button.

8. Click Leave Edit located in the upper right corner of the 
display.

The RCM Recipe Display appears, and the new value is 
reflected. Now download the recipe, and view the result of
your edits:

9. Click Send Recipe To Controller.

10. Click the left arrow  button in the lower-left corner of the 
display.

The example PTM panel appears. Notice that the new valu
50 for Resin 1 is displayed.

Exploring the RCM
Remote Recipe

Features

In this section you will explore the Rcmexamp application using 
Remote Recipe features. A recipe will be viewed on a PTM 
Remote Message display. The recipe will then be edited, and 
will observe the changes.

To load a recipe from the Remote Message Display, follow 
these steps:

1. Click the Load Recipe button located within the Remote 
Recipe Control.

A list of available recipes are displayed.

2. Click OK .
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The Durogoop recipe is displayed in the Remote Recipe 
Control  window as shown below:

Recipe items are listed on the screen, along with their curr
values.

Sending the Recipe to
the Controller and
Viewing the Panel

In a real application, you will see the effect of downloading a 
recipe to the controller in your actual process. For this examp
you can see the effect of downloading a recipe to the demo dr
on a PTM panel.

To download the RCM recipe and view the result, follow these 
steps:

1. Click the Send Recipe button located in the Remote Recipe
Control.

The recipe is downloaded to the demo driver. A message 
appears in the Remote Recipe Control indicating the recip
has been sent.

2. The name of the current recipe, Durogoop, is displayed on
Indicator  tool in the lower left corner of the panel.

Modifying the
Example

Application

In this exercise, you will learn to perform the following tasks:

• Create a simple recipe named Paste consisting of two ingr
ents, Flour and Water

• Download the recipe to the demo driver and view the resu
of downloading on the example panel
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Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. From the PTM panel, click Go To AM to return to the Appli-
cation Manager Main Menu.

2. Click Exit Interact ; then, click Accept.

The Interact Application Manager window is displayed.

Creating the Recipe To create the recipe, follow these steps:

1. Double-click on the Recipe Module (RCM) icon.

2. Double-click on the Recipes icon.

3. Double-click on the New Recipe icon.

The Recipe Item Definitions window appears as shown 
below:

4. Click the Insert Item icon on the toolbar, or double-click End 
of List .
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The Recipe Item Definition dialog box appears as shown 
below:

5. Type Resin1 - Flour in the Description box.

This is the description of our first recipe item.

6. Click the Send Value Input box.

The Address Reference dialog box appears.

7. Type DVR\4:101; then, click OK .

This is the address referencing the first recipe item. Notice t
the address you entered now appears in the Send Value I
box.

8. Click the Analog Value box, and enter 100.

9. Click OK .

The completed recipe is displayed in the Recipe Item Defi
tions window.

Now create the second recipe entry.

1. Click the Insert Item icon.

The Recipe Item Definition dialog box appears.

2. Click the Description box, and type Resin 2 - water.
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This is the description of the second recipe item.

3. Click the Send Value Input box.

The Address Reference dialog box appears.

4. Type DVR\4:102; then, click OK .

This is the address referencing the second recipe item. No
that the address you entered now appears in the Send Va
Input box.

5. Click the Analog Value box, and enter 15.

6. Click OK .

The completed entry is displayed in the Recipe Item Defin
tions window.

7. To change the order of the recipe items, press the Move Item 
Up or Move Item Down icons on the toolbar.

Creating a Recipe
Comment

Before saving the recipe, you will add a Recipe Comment tha
displayed on the Run Mode screen when the recipe is loaded.

To make a recipe comment, follow these steps:

1. On the File menu, click Recipe Properties.

The Recipe Properties property sheet appears as shown be
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2. Select the Comment page.

3. Type the following message:

This is a recipe for paste.
Resin 1 = FLOUR
Resin 2 = WATER

4. Click OK .

The Recipe Item Definitions window appears.

5. Close the Recipe Item Definitions window.

6. Select Yes.

The Save As dialog appears.

7. Type Paste in the File Name box; then, click OK .

Testing the
Example

Application

Now that you have used the Recipe Control Module (RCM) an
created a recipe, you are ready to test the application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, click Run Interact.

3. Click Yes when you are asked to save changes.

The PTM panel used in this example appears.

4. Select the Go To Recipe Module button.

The Recipe Display appears.
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Sending the Recipe to
the Controller and
Viewing the Panel

To load the new recipe and download to the controller, follow 
these steps:

1. Click the Load Recipe button located at the bottom left of the
display.

A list of recipes is displayed.

2. Click on Paste.

Paste is now shown as the Selected Recipe in the Recipe L
Message window.

3. Click Accept.

The Paste recipe is displayed on the RCM Recipe Display

4. Click Send Recipe to Controller.

5. Click on the left arrow  button located at the bottom-left of the
display.

The example PTM panel appears. The values you entered
Resin 1 (flour) and Resin 2 (water), 100 and 15 respective
are displayed. These are the only items our new recipe ha
common with the example panel.

Disregard the values of Resin 2X, Resin 3, and Secret X. Y
did not make entries for them in the Paste recipe.

The PTM button label No Recipe Loaded is displayed beca
you did not modify the PTM panel to operate with the Pas
recipe. Refer to your PTM help file for information about 
editing PTM panels.

6. Click on Go To AM to return to the Application Manager 
Main Menu .

7. Click Exit Interact  followed by Accept to return to the devel-
opment environment.
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Experiment! This chapter provides only a brief introduction to the features 
RCM. The best way to learn is to experiment.

• Try the percent scaling feature with the Durogoop recipe. 
Change the scale to 50%, send the recipe to the controlle
and view the scaled recipe values on the example panel.

• Load the other recipes in the example application, and vie
them on the example panel.

• Experiment with disabling/enabling a recipe item from the 
edit screen.

• Press Recipe Activity on the Run Mode screen to view the
recipe log file. Recipe logging must be enabled in the deve
opment environment for any recipe activity to be displayed

• Edit both Paste recipe entries so the Minimum and Maximu
values are 0 and 500, respectively, and Percent Scaling is
enabled. Enter Run Mode, and experiment with changing 
scale.
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Machine Conf igurat ion 
Module

The Machine Configuration Module (MCM) helps you create a 

library of groups and lists containing process values that perform 

manufacturing product “changeovers.” You can load, modify, and 

store these groups online as called for by your production process. 

MCM can produce an activity log for each group or list. The logs 

are stored in ASCII comma delimited format for ease of review.

This chapter provides an overview of MCM. It also provides you 

with an example to show you how to create a group or list, load it 

into memory, and send it to a controller.
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Overview of
MCM

MCM is an optional software program that runs under the cont
of the Interact Application Manager (AM). MCM allows you to 
create and modify groups and lists, load them into memory, do
load them to a controller, and save them to disk. You can also
configure groups and lists to download automatically using “tr
gers” including events and time of day.

When you configure a group or list, you enter (preset) the valu
that will download to the controller. During Run Mode, operato
with the proper user level can modify the preset values before
download to adjust to current manufacturing conditions. If 
maximum and minimum values were assigned during configu
tion, edited preset values are checked to ensure they remain 
between these limits. An example of a list appears below:

When you download the list TMBODIES to the controller, the 
following events occur:

• MCM writes the analog value 90 to address DVR\3:1 (Mel
Time).

• MCM writes the analog value 300 to address DVR\3:2 (Sh
Size).

• MCM writes the analog value 20 to address DVR\3:3 (Inje
tion Time).

• MCM writes the analog value 40 to address DVR\3:4 (Coo
Time).

• MCM writes the discrete value 1 to address DVR\3:10.1 (V
Open).

List Name: TMBODIES

Item Name Item Type Controller
Address

Value

Melt Time Analog DVR\3:1 90

Shot Size Analog DVR\3:2 300

Injection Time Analog DVR\3:3 20

Cool Time Analog DVR\3:4 40

Vat Open Discrete DVR\3:10.1 1 (on)

Door Closed Discrete DVR\3:10.2 0 (off)

Screw Heat On Discrete DVR\3:10.3 1 (on)

Screw Engaged Discrete DVR\3:10.4 1 (engaged)
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• MCM writes the discrete value 0 to address DVR\3:10.2 
(Door Closed).

• MCM writes the discrete value 1 to address DVR\3:10.3 
(Screw Heat On).

• MCM writes the discrete value 1 to address DVR\3:10.4 
(Screw Engaged).

Important Concepts The following are important concepts you will need to know as
you use MCM.

Groups and Active Lists

MCM’s structure allows you to cluster lists into groups, adding
level of hierarchy to the MCM structure. You can add, name, 
delete, change, and assign user levels to groups, the same wa
can with lists. They allow you to organize your lists into catego
ries. You can also block certain users from accessing certain 
groups. 

When you download a list, it becomes the active list from its 
particular group. MCM tracks which list is currently active in eac
group. You can have more than one list active at one time, but t
must be in separate groups. You can only have one active list
group.

You can view the groups and lists we have configured for the 
MCM example application. This will help you see how we hav
organized our lists. 

To view the groups, follow these steps:

1. Launch Interact from MachineShop toolbar.

2. On the File menu, click Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Mcmexamp; then, click OK .

The Application Browser appears with the Mcmexamp app
cation loaded.
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5. Double-click the Machine Configuration Module (MCM) 
icon in the Application Browser.

6. Double-click the Groups icon.

You can see the four groups we have configured for the 
example application. You will open two of these to see ho
we have set up the application.

Double-click the MACHCONF  group to show its lists.

As you can see, the MACHCONF group contains four lists
By opening the groups, you can see the basic structure of 
application. When you enter Run Time, you will open and 
manipulate these groups and lists.

Verifying Items after Downloads

When you enable this option for certain list items and include 
verify event list item, MCM will read back these items after it ha
downloaded the list items to the controller. If it finds any discre
ancies between the value in the list and the value in the contro
it will notify the operator. (You must enable verify for each 
specific item you want verified, and add a verify event for MCM 
to read those items back.)
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Monitoring Values in the Controller

Another unique feature of MCM allows it to read each list item
continuously after it downloads the list to the controller. You ca
configure Interact to display the value it reads next to the list’s
current value, or Interact can automatically update the list’s 
current value. A changed value will appear in a different color
the Remote List Display tool, allowing the operator to upload a
save the new value if they so desire.

Hot-Editing the Downloaded Values

With this option enabled, you can edit a list item in a group’s 
“active list.” MCM will immediately send the new value to the 
controller. You do not have to re-send the entire list to update 
value. 

Structuring Hierarchies within Lists

MCM is structured so that you can place each list into a categ
called a group. You saw this earlier in the chapter. You determ
the number of groups, their names, and their security levels. T
allows you to give only authorized personnel access to certain
lists. For example, you could restrict access so that only field 
service personnel would have access to “Machine Setup” lists

You can also configure lists to download other lists from differe
groups. In this way, you can nest lists within lists and use an ini
list to trigger the secondary one(s). An example of this “list of 
lists” is our startup list. 

To view the Startup List, follow these steps:

1. Double-click the Startup group icon.

2. Double-click Start01.
Interact Getting Started Guide 185



Overview of MCM Chapter 11: Machine Configuration Module

pe 
 

th 
n 
ss 

e 
ts 
 the 

, 
to 

.

y 
This opens the list named Startup. Notice that the Data Ty
column tells you that each item is a list. The Value column
gives you the names of each list this list downloads.

We configured MCM to automatically download this list to 
the controller when you enter Run Mode. 

Single-button Downloads

MCM also includes a new feature allowing a single button to bo
load a list and send it to the controller in a single click. You ca
assign this function to a push button using a new MCM addre
reference for this purpose.

Key Assignments The operator can use the Activity Log Display during Run Mod
to view MCM activity events. You can assign display componen
to keyboard keys that the operator can press to move directly to
component and perform the assigned operation. For example
pressing F10 performs the same operation as clicking the Go 
AM button with the left mouse button. The default key assign-
ments for the Activity Log Display components are listed below

Note When you configure the Activity Log Display, you can 
change the key assignments of certain commands to an
key on the keyboard.

Component Default Key Assignment

Scroll Up button CTRL- PAGE UP

Scroll Down button CTRL-PAGE DOWN

Page Up button PAGE UP

Page Down button PAGE DOWN

Start of Log button HOME

End of Log button END

Backup Log button F7
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You can use the function keys F1 through F10 together with th
Shift, Ctrl and Alt keys to provide 40 function keys, listed belo

Run Mode Using MCM in Run Mode you can:

• Download lists to a controller, either manually by an opera
or automatically triggered by a controller event or the time 
day.

• Monitor item values in the controller for changes and upda
their lists when changes occur.

• Verify list items after downloading them to the controller to
make sure the values are correct.

• Load and send a list with a single click on a push-button.

• Upload values to be used in a list from a controller.

• Load and save lists.

• Edit lists online.

• Log list activity to a file.

Print Log button F8

Previous Module button none

Next Module button none

Component Default Key Assignment

Pressing these keys Assigns these functions

F1 through F10 F1 through F10

Shift+ F1 through F10 F11 through F20

Ctrl+ F1 through F10 F21 through F30

Alt+ F1 through F10 F31 through F40
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Overview of the
Example

Application

The following sections provide hands-on experience with actu
Machine Configuration Module lists. This chapter will walk you
through our example application, Mcmexamp. This application
contains four groups, each containing pre-configured lists. We
have also created three panels in PTM/GMM to show you how
set up an interface with MCM. In the example application you 
will:

• Load and view a list from a PTM/GMM panel and send the
list to the virtual controller.

• Edit the list, watching how “hot edit,” “monitor,” and “moni-
tor with update” affect the editing process.

• Test the modified example.

• Upload the new values into your active list.

• Save and delete new lists.

• Test the single-button download feature.

Note This example assumes you have the Panel Toolkit Mod
(PTM) and the Graphics Monitoring Module (GMM) 
installed on your system and that you are familiar with it
operation. If you are unfamiliar with PTM, refer to Chapte
5 of this manual.

Running the
Example

Application

To run the example, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, click Run Interact.

3. Click Yes if you are asked to save changes.

You will enter the Interact Run Mode, briefly pausing in the
Application Manager while Interact loads the application.

Note We configured this application to go directly into Run 
Mode when you run Interact. The Start-up mode param
ters configured on the Application Settings property she
define which mode, module, and start-up user will be acti
upon entering Run Mode. We also configured the applic
tion to immediately download the “startup” list, which 
contains one list from each group. You will learn more 
about this in Modifying the Startup Settings on page 208.
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In the Remote List Display tool at the top of this first PTM pane
you will see the groups you looked at earlier in the Windows 
Application Manager. Clicking a group name will show the list
contained in that group. Clicking a list name will load it so you c
view its items in the Remote List Display tool. The buttons on t
right side of the tool allow you to move your highlight bar up an
down a list or group. The third button, “Back,” allows you to 
“back out” of lists. It will also cancel a delete, print, save as, o
overwrite action.

We have drawn a virtual controller at the bottom left of your 
screen. In a real application, you will write directly to a PLC, b
in this example, you write to the demo driver. The virtual 
controller helps you visualize how your lists would download to
real PLC. 

Three lists appear in the “Active Lists” box - one for each grou
(excluding the Startup Group). We assigned each group to a p
of columns in the virtual controller. These columns represent se
rate cards in the controller. The first pair of columns shows the
active list for the Machconf group. The second pair shows the 
active list for the Machset group. The third pair shows the active
list for the Prod_set group. You can see which list is active for 
each group by reading the name listed above the columns in t
Active Lists box. Lists can contain several different types of da
values, including both analog and discrete.

The virtual controller only shows analog and discrete values, 
though your lists can also contain ASCII, other lists, or events. T
left column in each pair shows analog values, while the right 
column shows discrete (I/O) values.
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The first pair of columns, or card, labeled “CONFIG” shows th
values for 3QTRMOLD, the active list of the Machconf group.

Navigating the
Example Application

The MCM Example Application contains three panels. To swit
to the next panel, click the right arrow button. To go back to a
previous panel, click the left arrow button.
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Before you start the following exercises, be sure that you can 
the first panel Interact opened when you entered Run Mode, a
shown below.

Exploring the MCM
Monitor Features

In this section you will observe the MCM example application as 
it uses the monitor feature. Monitor mode informs the operator
value changes in the controller. To see how it does this, you w
change the values from outside the list and observe the chang

To view the monitor feature of MCM, follow these steps:

1. Click Machconf on the Remote List Display tool.

You can see the lists contained in the group MACHCONF

2. Click 3QTRMOLD on the Remote List Display tool.

You can now see the list items in the 3QTRMOLD list.

3. Click and drag the slide on the slide tool.

4. Watch the mold close and open as you slide the tool. 

5. See the value change for that item in the virtual controller a
the Remote List Display tool.
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Other monitor cues include the List Status window which 
shows that a list has changed in the group MACHCONF. T
item “72in. forward motion” turns yellow in the Remote Lis
Display tool.

Loading and Sending
a List

To load and send a list, follow these steps:

1. Click the Back button twice to return to the list of groups.

2. Click Prod_set in the Remote List Display tool.

The lists contained in the Prod_set group appear.

3. Click TMBODIES to load this list.

MCM loads this list and displays its list items.

Note Notice that none of the values in the controller have 
changed yet. So far, you have only viewed this list; you 
have not downloaded any new values yet.

4. Click the Send List button and watch the screw assembly 
engage on the press diagram.

This downloads the list to the demo driver. You will see ne
values appear in the TMBODIES column on the virtual 
controller.

Note When you work with a real application, you can see the
physical effect of downloading a list to the controller. Fo
this example, we illustrate the effect of downloading a li
via a virtual controller and a diagram of a press.

5. Click Press to Start.
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If you look at the last pair of columns in the virtual controlle
(the SETUP columns), you will see that the “Oper” I/O item
is now lit.

If this was a real application, the mold would begin func-
tioning according to the values it had received in each acti
list.

Modifying Lists You can modify lists from Run Time in several ways. You can e
or hot edit them, you can upload new values from the controlle
you can delete lists, and you can enable and disable certain it
in lists. You will learn about each of these actions in the followin
section.

Editing Lists

To edit data in a list, follow these steps:

1. Click on Injection Time  in the Remote List Display tool.

You will see a Numeric Entry Keypad appear.

2. Click 3, 0; then, click Enter. (You can also use your externa
keypad to enter the numbers.)

The list item Injection Time now has a value of 30. Howeve
this value does not appear in the controller yet. Notice that 
item is now yellow and has an asterisk to the left of it. The
color alerts you to the fact that item’s value has changed; 
asterisk alerts you to the fact that you have not saved it. A
note that in the box labeled “List Status,” an item has 
appeared, reading that a list in the Prod_set group has 
changed.

3. Click Send List.
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The new value now appears in the controller under the 
TMBODIES column, and the item returns to its original colo
although the asterisk still appears.

4. Click Save List.

The Save List Message Window shows Tmbodies as the 
selected list.

5. Click Accept.

6. Click Accept again.

The list reappears. The asterisk is gone and the newly-sav
value appears in the list. The new value is now a permane
part of this list.

Hot Editing Lists

To hot edit a list, follow these steps:

1. Click the right arrow  button to switch to the second panel i
this example application.

2. Click Hot Edit Off .

The button should now read Hot Edit On .

3. Click the item Shot Size.

4. Click the keys on the screen or enter on your external keyp
2, 5, 0; then, click Enter.

5. Notice that the value reflected in the Remote List Display to
and in the virtual controller’s TMBODIES column are iden-
tical and match the value you entered. 

The virtual controller automatically receives the new value
unlike in the previous example. With the hot edit feature o
you do not need to send a list after changing an item in it. H
edit sends the new value immediately. (You will see an 
asterisk by the item in the Remote List Display tool becau
you have not saved the new value to the list.)

6. Click Hot Edit On  to turn off the Hot Edit feature.
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Uploading Values

1. Click on the mold, the control panel, the screw assembly, a
the vat supply pipe.

2. Click the Line Down button in the Remote List Display tool
to view the monitored value for each of these list items. Not
the “door ajar” warning and the changed values in the virtu
controller and Remote List Display tool.

Each item affected changed to yellow text, alerting you tha
their values have changed.

3. Click Upload List.

Notice how the Remote List Display changed the appeara
of each item, and that the list value is now the same as th
monitored value. Each item is now white, but has an aster
by it to show that its value has changed. Also note the sta
alert in the List Status box.

Note Each of these items are configured with the “monitor” 
option enabled. If you configure a list with “monitor with
update” enabled, MCM will not only alert the operator 
when a value has changed, but it will also automatically
upload the new values into the list.

4. Click Save List.
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5. Click Save List As: TMBODIES.

You will see an external keyboard entry bar appear at the 
bottom of your screen.

6. Delete the name TMBODIES with your backspace key. Then
enter the name SMBODIES.

Note You will not see a cursor in this entry bar.

7. Press Enter.

Notice that the Remote List Display tool now reads “Save L
As: SMBODIES.”

8. Click Accept.

Notice that the asterisk is now gone. The list’s name is no
SMBODIES, a new list that you derived from TMBODIES.

Enabling and Disabling Lists

Another way to modify a list is to disable one or more list item
This prevents MCM from writing that list item’s value to the 
controller when you download the list. A disabled item appear
dark gray in the list display tool. You can also disable an entire l
You can still view a disabled list, but all the items are grayed o

To disable a list item, follow these steps:

1. Click the Back button to return to the Prod_set list.

2. Click SM_PARTS.
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3. Click the Line Down button until you have highlighted Shot 
Size.

4. Click Disable.

5. Click the Line Up button so you can see that the item is no
dark gray.

6. Click Send List.

Notice that second value in the controller, the one that sho
receive the new Shot Size, did not update to the SM_PAR
list value of 50.

To enable a list item, follow these steps:

1. Click the Line Down button until you have highlighted the 
disabled item, Shot Size.

2. Click Enable.

3. Click the Line Up button to see that the list item is now the
active color, white.

4. Click Send List.

Notice that Interact sent the Shot Size item this time and wr
the new value to the virtual controller.

To disable an entire list, follow these steps:

1. Click the Back button to return to the Prod_set list.

2. Click the Line Down button until you have highlighted 
SMBODIES.

3. Click Disable.

4. Click SMBODIES.

Notice that every item in the list is dark gray.

5. Click Send List.

You will receive a message in the Remote Message Displ
stating that it could not send the list because of insufficien
permission.

6. Click the Back button to return to the Prod_set list.

Notice that the list name itself is dark gray.
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To enable a list, follow these steps:

1. Click the Line Down button until you have highlighted 
SMBODIES.

2. Click Enable.

3. Click SMBODIES.

Notice that every item is now the active color, white.

4. Click Send List.

Interact sent the list and wrote all the values to the virtual 
controller.

Deleting Lists

We have configured this application to allow users to delete o
derived lists in Run Time. SMBODIES is a derived list becaus
you created it from the master list TMBODIES. Therefore, the
only list you can delete in Run Time is SMBODIES.

To delete a list, follow these steps:

1. Click the Back button to return to the Prod_set list.

2. Click the Line Down button until you have highlighted the list
TMBODIES .

3. Click Send List.

You must make another list active before you can delete 
SMBODIES because you cannot delete an active list.

4. Click the Line Down button until you have highlighted the list
SMBODIES.

5. Click Delete List.

6. Click Accept.

You have now deleted SMBODIES.

As we stated earlier, you cannot delete master lists. Try deleti
one to see what happens.

1. Click the Back button so that you can see the names of all t
groups in the Remote List Display tool.

2. Click MACHCONF .
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3. Click the Line Down button until you have highlighted the list
3QTRMOLD .

4. Click Delete List.

Notice that the Remote List Display tool will not let you sele
Accept to actually delete the list. 

The dotted box appears around any object that you canno
select. If you try to click this box, nothing will happen.

5. Click Cancel.

Using the Remote
Message Display Tool

You may have noticed during the last series of exercises that 
second panel has a message display tool under the Remote L
Display tool. This tool shows descriptions of the lists and grou
configured in MCM. This helps you choose the correct group a
list.

Viewing Alternate
Methods of Using

MCM

MCM is a very flexible module. You do not have to use the 
Remote List Display Tool to view, load, and send lists. The thi
panel of this application shows you an example of another way
use the module.
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Linking PTM Tools to List Items

After advancing to the third panel in this application (by using t
right arrow button), take a moment to examine the new layout. T
first thing you may notice about this third screen is the Produc
Setup Panel.

The various push-buttons and numeric entry tools are linked t
specific list items in the Prod_set group. The values you see h
are for the current active list in Prod_set, TMBODIES.

To use the Product Setup Panel, follow these steps:

1. Click the Close button under “Press Door”.

The button should now read Open and the List Changed 
Press To Save push-button appears to the far right.

2. Click the Cool Time numeric input tool. 

An internal keypad entry tool appears.

3. Click 2, 5; then, click Enter.

Notice that the values have not changed in the virtual 
controller yet. As in the former panel, you must enable hot e
to have your changes download immediately to the controll

4. Click List Changed Press To Save.

5. Click Send List.
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Single-button Downloads

Another way to send lists is to use single-button downloads. Y
will notice a set of buttons in the middle of the screen.

These buttons will load and send a list as soon as you click on
them.

To use the single-button downloads, follow these steps:

1. Click QTR_MOLD , SUPERVAT, and SM_PARTS.

2. Notice the values shown in the virtual controller. 

The lists you just downloaded appear in the I/O along with
their values. 

Changing User Level

When Interact starts running the MCM example application, it
automatically starts at user level 0, the factory level. You can 
which user level you are at by reading the user level display on 
third panel.

We have defined three of the 6 levels available. User level 0 
allows the most access, providing those with factory clearance
access to all lists and all functions except for deleting master li
User level 3 allows maintenance to view and access the startu
setup, and prod_set groups. User level 5 can only view and ac
the Prod_set group, and cannot access the cleaning list in tha
group.
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These levels prevent unauthorized personnel from changing a
downloading lists they should not touch.

To change your user level, follow these steps:

1. Click Change User.

An internal keypad popup appears.

2. Enter the password for user level 3: 3, 3, 3, 3; then, press 
Enter.

3. Click the right arrow  key to advance to the first panel.

4. Click the Back button to return to the list of groups.

Notice that you can no longer see the Startup group listed
the Remote List Display tool.

5. Click Machconf.

Notice that you cannot see any lists in this group. This gro
is visible to your user level, but you have no access to any
the lists within it.

6. Click the Back button.

7. Click the left arrow  key to get to the third panel.

8. Click Change User.

9. Enter the password for user level 5: 5, 5, 5, 5; then, press 
Enter.

10. Click the right arrow  key to advance to the first panel.

Notice that you can only see the Prod_set group.

11. Click Prod_set.

Notice that the list named CLEANING  no longer appears.

Note The user levels apply to single-button downloads as we
A level 5 cannot send a list assigned to level 0, even if th
can access a screen with a single-button download assig
to the level 0 list.
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Modifying the
Example

Application

In this exercise, you will learn how to:

• Create a simple list named Night consisting of two settings
Screw Heat On and Machine Operation, and a Verify even

• Download the list to the demo driver and view the results.

• Modify the configuration setup from starting the specified 
Group to returning to last states.

Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. Click the Exit Interact  button.

This will bring you to a custom-designed verification scree
which asks if you are sure you wish to exit. 

2. Click Yes.

You will automatically return to the Windows Application 
Manager. 

Creating a List To create the list, follow these steps:

1. Double-click the Machine Configuration Module icon.

2. Double-click the Groups icon.

3. Double-click the Prod_set icon.

4. Double-click on New List.

The List Item Definitions dialog box appears.

5. Click the Insert Item  icon on the toolbar.
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The List Item dialog box appears.

6. Type Screw Heat On in the Description box.

This is the description of our first list item.

7. Click the Data Type drop-down combo box.

Several options appear.

8. Select Discrete.

9. Click the ‘Send Value Input’ box.

The Address Reference dialog box appears

10. Type DVR\3:10.1; then, click OK .

This address references the first list item, and is a discrete
reference. For more information on address references, se
Address References on page 28. Notice that the address you 
entered now appears in the Send Value Input box.

11. Click the Upload Value Output box.

The Address Reference dialog box appears.
204 Interact Getting Started Guide



Chapter 11: Machine Configuration Module Modifying the Example Application

load 

s 
12. Click the drop-down combo box, select DVR\3:10.1; then, 
click OK .

Notice that the address you entered now appears in the Up
Value Output box.

13. In the Discrete section, select the Off  radio button.

14. Click OK .

The completed list item appears in the List Item Definition
window.

Now create the second list entry.

1. Click the Insert Item  icon on the toolbar.

The List Item Definition dialog box appears.

2. Click the Description box, and type Machine Operation.

This is the description of the second list item.

3. Click the Data Type drop-down combo box.

Several options appear.

4. Select Discrete.

5. Click the Send Value Input box.

6. Type DVR\3:10.2; then, click OK .

7. Click the ‘Upload Value Output’ box.

8. Click the drop-down combo box, select DVR\3:10.2; then, 
click OK .

9. In the Discrete section, select the Off  radio button.

10. Click OK .
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The completed list item appears in the List Item Definition
window.

Now create the third list entry.

1. Click the Insert Item icon on the toolbar.

The List Item Definition dialog box appears.

2. Click the Description box, and type Verify .

This is the description of the third list item.

3. Click the Data Type drop-down combo box.

Several options appear.

4. Scroll down, and select Event.

5. In the Event section, select the Verify  radio button.

6. Click OK .

The completed list item appears in the List Item Definition
window.

Now save the list. 

1. Click the Save icon on the toolbar.
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The Save As dialog box appears.

2. In the List Name box, type Night, and click OK .

Creating a List
Comment

If you create a list comment, that information will appear in the
Remote Message Display tool we configured on the second pa

To create list comment, follow these steps:

1. With the new list still open, on the File menu, and select Prop-
erties, List Properties.

The Properties window appears.

2. Click in the Description box, and type the following message

Prepares press for inactivity.

3. Click the Controls tab.
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You can now see the default user level settings for this list.
this is a maintenance task (readying a press for overnight in
tivity), we will assign most tasks a user level of 3, as show
below.

4. Using the arrow buttons beside each setting, change the u
level to 3 for the following settings: Visible, Edit List, Hot 
Edit List, Save List, Download List, Upload List.

5. Using the arrow buttons beside its setting, change the use
level of Delete List to -1. This completely disables the dele
function.

6. Click the Derived tab and set all the user levels to 3 on tha
tab.

7. Click OK .

8. Close the List Item Definitions dialog box; click Yes to save 
your changes.

Modifying the Startup
Settings

Before going back into Run Time, you can change the startup
settings to “Restore Last State at Startup.” This will cause Inter
to return to the last state your application was in before you ex
Interact the last time. 
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To modify your startup settings, follow these steps:

1. Make sure that the Machine Configuration Module item in t
Application Browser is open. If not, double-click the 
Machine Configuration Module (MCM)  icon.

2. Double-click the Machine Configuration Setup icon.

The Machine Configuration Setup dialog box appears. Yo
only need to change the first two items in this window.

3. Click the check box next to Restore Last State at Startup.

4. Click the drop-down combo box under Startup List and sel
None.

5. Click OK .

Testing the
Example

Application

Now that you have used the Machine Configuration Module 
(MCM) and configured groups and lists, you are ready to test 
application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, click Run Interact.
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3. Click Yes when you are asked to save changes.

Viewing the New
Startup Configuration

Notice that the active lists now in the controller are not the thr
startup lists from the first time you entered Run Mode. Instead
3QTRMOLD, CNVYR_SM, and ACCSRIES, you now see 
QTR_MOLD, SUPERVAT, and SM_PARTS.

Sending the New List
to the Controller

To load the new list and send to the controller, follow these 
steps:

1. Click Prod_set in the Remote List Display tool.

2. Click the right arrow  button to advance to the second pane

3. Click the Line Down button to highlight Night.

The comment you entered in the description box appears 
the Remote Message Display tool.

4. Click on Night.

Night now appears as the selected list.

5. Click Send List.

Notice that your new list’s values appear in the virtual 
controller.

6. Click Exit Interact ; then, click Yes to return to the develop-
ment environment.

Experiment! This chapter provides only a brief introduction to the features 
MCM. The best way to learn is to experiment.

• Try configuring a different list to run when you start up 
MCM.

• Load the other lists in the example application, and view 
them on the example panel.

• Practice more with disabling/enabling lists and list items.

• Try using the wait event as a list item

• Change the user level settings on your groups and lists, b
master and derived.

• Press View Activity on the Run Mode screen to view the lis
log file.
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Report  Module

The Report Module (RPM) allows you to create custom reports for 

any Interact application. With RPM, the operator can preview 

real-time data reports on the display screen during online opera-

tion. RPM can send reports to floppy drives, networks, printers, or 

ASCII text files. With these functions, RPM allows you to create 

and store reports easily and efficiently.

This chapter provides an overview of RPM. An example is 

provided that shows you how to incorporate a sample report within 

an application. The example application goes through potential 

uses for RPM and leads you through creating a sample report.

Chapter Contents

Overview of RPM 212

Important Concepts 212

Overview of the Example Application 218

Running the Example Application 219

Modifying the Example Application 228

Testing the Example Application 231

Experiment! 232



Overview of RPM Chapter 12: Report Module

rol 

se 

 a 

-

.

r-

ut 
e 

ati-

 

 a 
nt 
tly 

on-
Overview of
RPM

RPM is an optional software program that runs under the cont
of the Interact Application Manager (AM). RPM has several 
unique features that assist you in generating your reports. The
features are listed below:

• Report Form Editor - Use the Report Form Editor to create
report template for your data.

• Scroll horizontally - Use the horizontal scroll buttons to 
scroll report data on the display that is greater than 80 col
umns wide.

• View real-time data - Use the View Report display to view 
report text and real-time data as it is updated in Run Mode

• Group variables - Create groups of variables to sum or ave
age columns and rows of data.

• Input data - Configure the report to allow an operator to inp
ASCII or numeric data online. This data does not go into th
controller.

• Track data - Monitor data over time to count or time the 
occurrence of an event and track high and low values.

• Generate reports automatically - Configure RPM to autom
cally send the report to a printer or disk file at a particular 
time or when the data changes.

Important
Concepts

The following are important concepts you will need to know as
you use RPM.

Forms Report forms define the text and variable data that are sent to
printer or disk when the report is generated. In the developme
environment, you enter text and variable data references direc
on the form. During Run Mode, real-time data is read into the 
report at the positions you configure in the development envir
ment.
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Variables Variables are data fields that you enter in the report form. Eac
variable type is configured by positioning the text cursor in the
Report Form Editor screen and selecting the Insert Variable 
command from the Edit menu. They can be one of the followin

• Numeric Value - displays data read from the controller

• Group Value - displays the Current Low Value, Current Hig
Value, Historical Low Value, Historical High Value, Sum, 
Average, or Time Sum amount of several numeric or opera
variables. Numeric or operator group variables may be 
assigned to one or more groups.

• Stored Message - references a message you create and i
taken from the RPM.MSG file

• ASCII Text - displays data read from the controller

• Operator Input - ASCII or numeric data that is entered by t
operator

• User Name - enters the user’s name in the report

• Page Number - enters the page number in the report

• Start Time - enters the start time in the report using the 
HH:MM:SS format

• End Time - enters the end time in the report using the 
HH:MM:SS format

• Start Date - enters the start date in the report using either 
MM/DD/YY or DD/MM/YY format

• End Date - enters the end date in the report using either th
MM/DD/YY or DD/MM/YY format

• Color Control - changes the report text to a specific color

• Printer Control - text attributes recognizable by your printe
such as italics, bold, underline, etc.
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Groups A group is a collection of variables whose values are combined
analysis. This allows operations to be performed on a collection
variables at the same time. You can take the Current Low Val
Current High Value, Sum, Average, Historical Low Value, Histo
ical High Value, or the Time Sum of a set of data.

Groups are assigned a specific function that is performed on a
members assigned to this group. For example, you could nam
group “COLUMN1.” If the function assigned to this group was th
Sum, then this group variable would sum all numeric and opera
variable data assigned to the COLUMN1 group of your report.

Once you create a group (add it to the Group List) you can ass
Numeric Value, Group Value, and Operator Input variables to
You can also assign groups to other groups, creating sub-totals
grand totals.

Stored Messages When you create a report form, you can store message variabl
the form. The message variable references the messages you
created using the Stored Message command on the Settings m
When you create a new message, you assign a number to it tha
message variable references during Run Mode.

Text for stored messages resides in a file named RPM.MSG. 
reports in an application reference the same message file. This
can either be loaded into your computer’s system memory or r
from a disk upon entering Run Mode. This depends on the 
Message Storage parameter on the General page of the RPM S
property sheet.

You can configure the stored message variable to reference e
the message number (reference type set to Constant) or an ad
(reference type set to Variable) which RPM will monitor to obta
the message number. Placing the message number at the mo
tored address will display the associated message.
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Report Triggers A report trigger is the method used to generate a report that ca
sent to a disk file or printer. There are eight methods available
trigger a report. The trigger methods are listed below:

• Manual Only

• Minute Interval

• Hour Interval

• Day Interval

• Day Span

• Week Span

• Data Change

• Positive Edge

Several trigger methods only allow you to specify the interval 
when a report is generated and sent to a printer or disk. This 
moment is specified at the trigger interval. Other trigger metho
also allow you to specify when data collection should begin an
end for the report. Data collection refers to the length of time a
event or value is monitored.

Trigger Intervals Trigger intervals control when a report is triggered. Trigger int
vals include a start time or day of the week and the interval sp
fied in minutes, hours, or days. Use the Trigger page of the Re
Preferences property sheet to configure the trigger interval. Th
Trigger Method you select determines the available options fo
configuring the trigger interval.

• Manual Only - no trigger interval

• Minute Interval - specifies the Start Time and Interval in mi
utes

• Hour Interval - specifies the Start Time and Interval in hou

• Day Interval - specifies the Start Day-of-Week, Start Time,
and Interval in days

• Day Span - specifies the Start Time and End Time in hour

• Week Span - specifies the Start Day and Time and an End
Day and Time

• Data Change - specifies the address you want to monitor 
will trigger the report when the data changes
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• Positive Edge - specifies the address you want to monitor t
will trigger the report when the data makes a False to True
transition

File Numbers Report files are created by RPM during Run Mode. Report file
consist of the text and variables that were configured for the rep
in the development environment. As report files are created, t
receive a sequential file extension number beginning with R01 
incrementing to a maximum of R99. You specify the maximum
number using the Maximum Files parameter on the General p
of the Report Properties property sheet.

Once the report file reaches the maximum file number, the ne
saved report will overwrite file number R01. For example, if yo
set the maximum file number to 20 and you name the report fo
EXAMPLE, RPM creates files EXAMPLE.R01 through 
EXAMPLE.R20. The next report RPM saved after 
EXAMPLE.R20 will be EXAMPLE.R01.

User Levels During configuration, you can assign user levels to restrict ope
tors from using some or all of the functions critical to the operati
of RPM. Interact supports six user levels numbered from 0 to 
User level 0 is the highest user level, offering the most privileg
user level 5 is the lowest user level, offering the least privilege

To restrict operators from using a function, each operator is 
assigned a user name. The user name is then assigned a use
that defines the operations available to each operator. For mo
security, you can assign each user level a unique alphanumer
password in the Application Manager. Passwords must be 
between 1 and 15 characters long.

Run Mode In Run Mode, the device driver and all Interact modules for th
application load and begin running. All report features are acti
and you can begin generating reports.

Report View Display

This screen allows you to view your report files. This is the firs
screen that appears when you enter the Run Mode. Initially, th
Report View Display is blank, since no reports have been load
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After loading a report, the data monitored is displayed on the 
screen. The top portion of the display provides information on 
loaded report.

Features available from this display let you:

• Scroll horizontally and vertically through a report file. This 
allows you to view reports that are greater than 80 column
wide.

• Go to the Report Load or Report Control Displays

• Go to the Next Module, Previous Module, use the selected
module, or return to AM

• Print the currently displayed report file

• Save the currently displayed report file

Report Load Display

The Report Load Display enables you to load your report files
This screen appears only after selecting Load Report from the
Report Display. 

A selection box follows the cursor as you move it over the rep
files. The top portion of the display provides information on ea
report. The report name, number of files within the report, and 
start and end time is listed on this heading.

Features available from this display let you select individual fil
of a report and return to the Report View Display.

Report Control Display

The Report Control Display enables you to control various rep
features during Run Mode. This screen appears only after 
selecting Report Control from the Report View Display.

A selection box follows the cursor as you move it over the rep
files. The top portion of the display provides information on ea
report file.

The following features are found on each report display:

• Total number of files in the report

• The start and end time of these files

• Current file number

• Whether the report is active/inactive and enabled/disabled
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• Total size of all files in the report

• Current report log path

• Printer status

The features available on this display allow you to do the 
following:

• Enable or disable reports. A disabled report can’t be printe
loaded, or saved, but still collects data.

• Reset a report. Resetting reports affects all Numeric varia
data collected to date and resets these values back to zer

• View messages associated with a report

• Return to the Report View Display

• Go to the Next Module, Previous Module, user selected m
ule, or return to the AM

• Toggle printer status

• Change to a new disk. This is used in backing up your rep
files.

• Erase all report files associated with a specific report

• Back up report files

Overview of the
Example

Application

The following sections provide hands-on experience using the
Report Module (RPM). The example application, Rpmexamp,
consists of a preconfigured report form. In a real application, a
report form would be configured to generate a report of data fr
addresses in your controller. The report form in this example i
configured to generate a report from the data written by tools 
the Panel Toolkit Module to the Interact Demo driver.

You will explore the example application in several ways:

• Load the example application

• Load a Report Form

• Observe the report in Run Mode

• Enter an operator message into the report

• Save the report file

• Go to the PTM module

• Go to the Report Control Display
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• Edit the report in the development environment

• Test the modified example

Note This example assumes you have the Panel Toolkit Mod
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Running the
Example

Application

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, select Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Rpmexamp; then, click OK .

The Application Browser appears with the Rpmexamp app
cation loaded.

5. On the Run menu, select Run Interact .

6. Click Yes when you are asked to save changes.

You enter the Interact Run Mode. The PTM panel used wi
this example appears.

Note This application was configured to go into Run Mode whe
the Run Interact option is selected. Use the Startup Mo
parameters configured on the Application Settings prope
sheet to configure which mode, module, and startup use
will be active upon entering Run Mode. For this applicatio
the PTM panel used with this example is the first Run 
Mode screen displayed.

Loading the Report
Form

First you will explore the features of the Report Module by 
loading and displaying a report form.

To load a report form, follow these steps:

1. Select the Go To Report Module button.

The Report View Display appears.
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2. Click on Load Report located in the lower left of the screen

The Report Load Display appears.

3. Place the selection box over Example, and click.

The report file is highlighted.

4. Click on Accept.

The report file Example is loaded and shown on the Repo
View Display as shown below:

The word “Current” appears after the file name indicating th
is the most recent file.

Observing the Report Look closely at this report. Various color codes are assigned to
report to help distinguish between each section of the report.

The report was configured by creating columns of text using th
Report Form editor. Variables are inserted in the report at spec
locations. Each parameter and column located on the report is
described in the following paragraphs.

Start and End Time

The Start and End Times are predefined variables. Start Time
refers to the time at which data collection began for this report f
End Time refers to the time the report was actually generated
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Operator

The Operator variable is predefined and inserts the user name
the report.

Good Parts

The eight variables listed under the Good Parts column are 
numeric values assigned to an address. Three of these nume
variables are assigned to the demo driver timers. These are th
values that are changing.

Numeric Entry tools located on the PTM panel created for this
example write data to the assigned addresses. The addresses
then monitored and written to the report.

These eight variables are assigned to the Goodparts group. Th
done so you could easily take the sum of this column.

Bad Parts

The eight variables listed under the Bad Parts column are num
values assigned to an address.

Numeric Entry tools located on the PTM panel created for this
example write data to the assigned addresses. The addresses
then monitored and written to the report.

These eight variables are assigned to the Badparts group. Th
done so you could easily take the sum of this column.

% Yield

This column takes the number of good parts, divides it by the to
number of parts, and multiplies this value by 100%. The resul
the percent yield each line is producing.

The variables are Numeric Values assigned to the Yield group
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Downtime and Stops Columns

The numeric variables located under the Stops column are 
assigned to eight Maintained Push Buttons located on the PT
panel created for this example. Each production line has a Pu
Button assigned that, when pressed, will stop the line. Each tim
line is stopped, the Numeric Value variable located under the 
Stops column applies the Count function to this address. This 
keep track of the number of times the line was stopped.

The numeric variables located under the Downtime column ap
the Timed function to the same address assigned for each co
sponding Stop column variable. The Timed function starts a 
counter that indicates the duration in minutes and seconds tha
line is down.

All variables located under the Downtime column are assigned
the Downtime group. All variables located under the Stops colu
are assigned to the Stops group.

Total Parts

This row consists of group variables that have a specific funct
applied. Total good parts are derived from taking the sum of a
variables belonging to the Goodparts group. Total bad parts a
derived from taking the sum of all variables belonging to the 
Badparts group. Total number of stops is derived from taking 
sum of all variables belonging to the Stops group.

Notice also the total downtime accumulated for each line. The
group variable located under the Downtime column takes the s
of all the times belonging to the Downtime group.

You can also see the average percent yield this process is 
producing. The group variable located under the %Yield colum
takes the average of all variables belonging to the Yield group

Entering an Operator
Message

Reports can have operator messages attached to them. An O
ator Input variable has been inserted next to the Operator Mes
parameter. This allows you to enter ASCII text. 

To enter a message, follow these steps:

1. Move the cursor over the word None next to the Operator 
Message parameter located at the bottom of the display.

This area of the report is highlighted.
222 Interact Getting Started Guide



Chapter 12: Report Module Running the Example Application

 the 

own 
ve 

 
file 
er 

 the 

r 
2. Click the word None.

3. Enter a message.

4. When finished, click the right mouse button, or press Enter.

The message entered is now part of the current report.

Saving Reports To save a report, follow these steps:

1. Click on Save Report located at the bottom center of the 
display. 

A message, similar to the one shown below, is displayed in
Message Window indicating the report is being saved.

SAVING EXAMPLE.R01

Once the report is saved, a message similar to the one sh
below is displayed in the Message Window indicating the sa
operation is complete.

EXAMPLE.R01 SAVED

Reports can also be configured to be saved automatically
based on time or events. Each time a report is saved, the 
number is incremented by 1. Once the Maximum File Numb
is reached, the next saved file will overwrite the first file 
number.

2. Clear the message in the Message Window by clicking 
anywhere inside the window.

Going to PTM Now go to the PTM module, change some values, and observe
results.

To go to PTM, follow these steps:

1. Click on the left arrow  button, located in the lower left corne
of the display. 
Interact Getting Started Guide 223



Running the Example Application Chapter 12: Report Module

e 
 
of 
The PTM panel is displayed as shown below:

The eight Numeric Entry tools on the far left side adjust th
number of good parts the respective line is producing. The
eight Numeric Entry tools in the center adjust the number 
bad parts the respective line is producing.

2. Click on line number 1’s Good Parts Numeric Entry tool.

A Numeric Keypad is displayed.

3. Click 9, 0, 0; then, click Enter.

This value is displayed on the tool.

4. Click on line number 1’s Bad Parts Numeric Entry tool.

A Numeric Keypad is displayed.

5. Click 4, 5, 0; then, click Enter.

This value is displayed on the tool.

6. Now click on line numbers 2, 4, 6, and 8’s Downtime Main-
tained Push Buttons located on the far right side of the 
display.

Button lens labels will change to On.

7. Return to RPM by clicking on Go To Report Module.
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Notice the new values you entered for line number one ar
now displayed. Because the %Yield column is calculating t
ratio of good parts to bad parts, the percent yield has chan
for line number one. This also affects total percent yield.

The number of times lines 2, 4, 6, and 8 were stopped is sho
under the Stops column. The total number of times all line
were stopped is shown at the bottom of the column.

Since these lines are down, the Downtime column indicate
the number of minutes and seconds these lines are down.
total downtime for all lines is shown at the bottom of the 
column.

Viewing the Report
Control Display

Use the Report Control Display to do the following:

• Enable/disable reports

• Reset reports

• Backup reports

• Erase reports

• Change to a new disk for report logging

• Control the printer

This section leads you through enabling/disabling reports, res
ting reports, and controlling the printer.

Enablin g/Disablin g the Report

To enable or disable the report, follow these steps:

1. From the Report View Display, click Report Control 
located in the upper right corner of the display.
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The Report Control Display appears as shown below:

2. Move the selection bar over report Example.

3. Click on the report. 

The report is highlighted.

4. Click the Report Enable/Disable button located in the upper
left corner.

This toggles the report between Enabled and Disabled. A 
disabled report can not be saved or printed. The report tex
indicates the state of the example either Enabled or Disab

5. Click on Report Enable/Disable until the report is Enabled.

Resettin g the Report

Use the Reset Report feature to reset any numeric or operator i
variables that use the Count function to 0.

To reset the report, follow these steps:

1. Move the selection bar over report Example.

2. Click on the report.

The report is highlighted.
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3. Click the Reset Report button located next to the Message 
Window.

4. Click on the Leave Control button located in the upper right
corner of the screen to leave the Report Control Display.

The Report View display appears. Look at the Stops colum
Since the variables under this column are Numeric Variab
with the Count function applied, they are now reset to 0.

Your downtime values will continue to grow if you activate
the Downtime buttons on the PTM screen. Resetting the rep
merely starts the timer back at zero again.

5. Click on the Report Control button to return to the Report 
Control Display.

Controllin g the Printer

To control the printer, follow these steps:

1. Move the selection bar over the Example report.

2. Click on the Example report.

The report is highlighted.

3. Click on the Printer Ctrl  button located in the lower right 
corner of the display. 

The report printer status (LPT1) toggles between On and O
The Message Window indicates printer status along with t
text associated with the highlighted example.

4. Click on the Leave Control button to return to the Report 
View Display.
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Modifying the
Example

Application

In this part of the example, you will enter the development env
ronment and add variables to the existing report. You will then
enter Run Mode and load the modified report.

Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. From the Report View Display, click Go To AM to return to 
the Application Manager Main Menu.

2. Click Exit Interact ; then, click Accept.

The Interact Application Manager window is displayed.

Loading the Report
Form

To load the report form, follow these steps:

1. Double-click on the Report Module (RPM) icon.

2. Double-click on the Reports icon.

All reports created for this application are listed.

3. Double-click on the Example icon to open up the example 
report form.

Adding Variables to
the Report Form

The Example report configuration is shown with all variables 
inserted in the form. In the next steps, we will add variables to t
form.

To add variables to the report form, follow these steps:

1. On the View menu, click Color/Printer Codes.

This will show all color and printer codes that have been 
added to the report. Any text inserted in the form after (to t
right of and below) a color code will appear in the specifie
color or until another color code variable is encountered.

In this exercise you are interested in the lowest and highe
yields this process has generated. Thus, you will add variab
that check for these values.
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Once this exercise is completed, the report form will appea
shown below. Use this figure as a guide while following th
steps below.

To accomplish this you will do the following:

a. Insert text identifying the lowest and highest yield for o
process.

b. Add group value variables assigned to the new group.
c. Assign the Low and High functions to the new group va

ables. This will display the lowest and highest yields o
our process.

2. Place the cursor between the Total Parts row and Operator 
Message row.

3. Press Enter to create an additional row.

4. Move the cursor (press the space bar) until it is under the 
left digit of the Good Parts column.

5. Type Lowest Yield:

The text will appear red because the color code inserted ab
the Total Parts line is set to red.

6. Move the cursor (press the space bar) to the right until it is
under the far left digit of the %Yield column.

7. On the Edit  menu, click Insert Variable .

8. Click Group Value.
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The Group Variable dialog box is displayed as shown belo

9. Click on YIELDHL  in the Group to Display box.

10. Click on Historical Low Value in the Function Type box.

11. Type 6 in the Field Width box.

12. Type 2 in the Decimal Places box.

13. Click OK .

You return to the Report Form Editor with the group variab
added.

14. Move the cursor (press the space bar) under the far left dig
the Downtime column.

15. Type Highest Yield:

16. Click on the group variable you just added, next to Lowest 
Yield.

You will copy and paste this variable next to the Highest Yie
parameter.

17. On the Edit  menu, click Copy.

18. Move the cursor (press the space bar) under the far left d
under the Stops column.

19. On the Edit  menu, click Paste.

A copy of the group value variable you added is inserted n
to the Highest Yield parameter.
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20. Click on the variable you just copied under the Stops colu

21. On the Edit  menu, click Edit Variable .

The Group Variable dialog box appears.

22. Click on Historical High Value in the Function Type box.

Since this is a copy of the Lowest Yield parameter, you do n
have to change the Field Width or Decimal Places parame

23. Click OK .

The Report Form Editor is displayed. You are now finished
editing the report form. Now save your changes, following t
next set of steps, and add this report to the Report List so y
application is able to load the report.

Saving the Report
Form Changes

To save the changes, follow these steps:

1. On the File menu, click Save Report As.

The Save As dialog appears.

2. Type Example1.rpm in the Report Name box.

3. Make sure the Add to Report List box is selected. 

This allows the Example1 report to be used in Run Mode.

4. Click OK .

5. On the File menu, click Close Module.

This closes the Report Form Editor, and the Application 
Manager appears.

Testing the
Example

Application

Now that you have used the Report Module (RPM) and create
report, you are ready to test the application.

Returning to Run
Mode

To return to Run Mode, follow these steps:

1. From the Application Browser, click the   Application 
Manager icon.

2. On the Run menu, click Run Interact.
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3. Click Yes when you are asked to save changes.

The PTM panel used in this application appears.

Loading the Report
Form

To load the Report Form, follow these steps:

1. Select the Go To Report Module button.

The Report View Display appears.

2. Click the Load Report button located in the lower left of the
screen.

The Report Load Display appears.

3. Move the selection bar over EXAMPLE1 , and click. The 
report form is highlighted.

4. Click on the Accept button.

The Report View Display is shown with variable data insert
in the form. Notice the group value variables you added.

Experiment! This chapter provides only a brief introduction to the features 
RPM. The best way to learn is to experiment.

• Go back into the development environment, and add vari-
ables to the report form. You can also change the function
assigned to the numeric variables.
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User Program Module

The User Program Module (UPM) is designed to allow a user-

written terminate-and-stay-resident (TSR) program, called the 

User Program, to share data with Interact. Interact allows user-

written TSR’s to be easily added into Interact’s standard architec-

ture and provides the user-written TSR program with its own inter-

rupt for efficient operation in the real-time environment.

This chapter provides an overview of UPM. An example is 

provided that shows you how to use a TSR developed with UPM 

within an application.
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Overview of
UPM

UPM communicates with the User Program via a software inte
rupt. The User Program communicates with other Interact 
modules and drivers through a shared memory area. The follow
graphic illustrates how UPM and the User Program fit into the
Interact architecture.

Important
Concepts

The following are important concepts you will need to know as
you use UPM.

User Program The term User Program refers to the user-written TSR progra
that must be loaded into memory before running the Interact 
Application Manager.

User Interrupt UPM interrupts the User Program to give it processing time and
send or receive data. During configuration you define the user
interrupt number (60 through 67 hex), which must match the 
number expected by the User Program.
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Trigger The trigger defines when a specific stimulus will cause UPM t
interrupt the User Program. You are allowed to configure thre
trigger conditions, any one of which will cause UPM to interrup
the User Program. The conditions include the following:

• Data change on any of the output address references bein
monitored by the User Program

• Data change for a specific address reference

• Time interval

Output List The Output List is a list of output address references that you w
the User Program to monitor. UPM moves changing data valu
for these references into a shared memory area, called the Ou
Array, that the User Program may access. The diagram below
illustrates the Output List’s relationship to UPM and the User 
Program.

Input List The Input List is a list of input address references to which the
User Program may send new data values. The User Program
writes data into a second shared memory area called the Inpu
Array, which UPM then moves to the corresponding input refe
ences in the Input List. The diagram above illustrates the Inpu
List’s relationship to UPM and the User Program.

Monitor Screen This is the runtime screen displayed by UPM. It shows the curr
data values and error status for the references in the Input an
Output Lists. The Monitor Screen is provided as a diagnostic t
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User Screen This is an optional runtime screen displayed by the User Progr
to provide its own information to the operator. If the User Scre
is supported, the operator can view it by selecting a button on
Monitor Screen. If desired, the User Screen can be configured
be the only screen the operator can access when UPM is in th
foreground, therefore bypassing the Monitor Screen complete

Run Mode To go to Run mode, the TSR User Program must already hav
been installed in memory before running the Application 
Manager. Once a TSR program has been installed, it remains
memory until the system is rebooted. However, most TSR 
programs provide a command-line option that allows their 
removal from memory without having to reboot.

Once the TSR is in memory, you can repeatedly run Interact a
switch between development and runtime without having to re
install the TSR.

In Run Mode, when you press the Go To Module button and se
UPM, either the Monitor Screen or the User Screen will be 
displayed. The Monitor Screen provides a button which the op
ator may press to view the User Screen, if supported. This bu
is enabled on the Display page of the UPM Setup property she
the development environment.

The User Screen is totally under the control of the User Progr
and may consist of text, graphics, or a combination of the two. T
operator may even be prompted for input when viewing the U
Screen. Consult your User Program supplier for information ab
the User Screen operation.

Overview of the
Example

Application

The following sections provide hands-on experience using the
User Program Module (UPM). This example consists of an ap
cation, Upmexamp, which has been configured to operate wit
“TSR.EXE,” an example TSR program.

You will explore the example application in several ways:

• Place a reference to TSR.EXE in your Autoexec.bat file

• Load the UPM application

• View the Monitor and User Screens

• Change inputs and observe the results

• View the related PTM panel
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• Edit the Output List

• Test the modified example

Note This example assumes you have the Panel Toolkit Mod
(PTM) installed on your system and that you are familia
with its operation. If you are unfamiliar with PTM, refer to
Chapter 5 of this manual.

Exploring the
UPM Example

Application

Now that you have had an overview of the User Program Mod
(UPM), you are ready to take a look at the example applicatio

Modifying Your
Autoexec.bat File

Before running Interact, you must load the User Program. You
must modify your Autoexec.bat file for this example to work pro
erly.

To modify your Autoexec.bat file, follow these steps:

1. Make a copy of your current Autoexec.bat file.

2. Using a text editor, modify your Autoexec.bat file to load th
example TSR upon rebooting the computer. Add a line to yo
Autoexec.bat file which is the path were the TSR resides. T
line below assumes the TSR is located at the default path

C:\INTERACT\APPFILES\UPMEXAMP\TSR.EXE

3. Save the change and restart your computer.

When the TSR has finished loading, the message below w
appear.

TSR Test Program for Interact User Program Module 

Version EX-XXXXX-XXX

TSR has been installed at interrupt 61 hex.
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Running the Example
Application

To run the example, follow these steps:

1. Launch Interact from the MachineShop toolbar.

2. On the File menu, click Open Application.

A list of available projects appears.

3. Double-click the APPFILES folder.

The APPFILES folder opens.

4. Click Upmexamp; then, click OK .

The Application Browser appears with the Upmexamp app
cation loaded.

5. On the Run menu, click Run Interact.

6. Click Yes when you are asked to save changes.

You enter the Interact Run Mode. The PTM panel used wi
this application is displayed.

7. Select the Go To UPM button.

The UPM Monitor Screen is displayed as shown on the 
following page.
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Note This application was configured to go into Run Mode whe
the Run Interact option is selected. Use the Startup Mo
parameters configured on the Application Settings prope
sheet to configure which mode, module, and startup use
will be active upon entering Run Mode. For this applicatio
the PTM panel used with this application is the first Run
Mode screen displayed.

Viewing the Monitor
Screen

Output offsets are listed on the left side of the Monitor Screen
These are the references that the User Program monitors from
Interact. Input offsets are listed on the right side of the screen
These are the references that the User Program writes to Inte

Notice the Data Error associated with output item #4. You will
address this when you are editing the Output List later in this 
example.
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Viewing the User
Screen

Now you will go to the screen that was created by the User 
Program designer.

To view the User Screen, complete this step:

• Click on the User Screen button, located in the lower left 
corner of the screen. The User Screen appears as shown
below:

This screen was designed to display the same information as 
Monitor Screen. It also allows you to change Input offsets, as y
will do in the next step. 

Note The Data Error associated with output item #4 is the sam
one that you saw in the Monitor Screen on page 239. Y
will address this error later in this example.

Changing the Input
Offsets

To change the input offsets, follow these steps:

1. Press F1.

The message “Offset to change?” appears.

2. Type 1; then, press Enter.

You are prompted to enter an unsigned integer value.

3. Type 25; then, press Enter.
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Notice the new value immediately appears under the Inpu
Array Offset, next to Offset 1 Unsigned. Now you will chang
the string reference.

4. Press F1; then, type 4.

5. Press Enter.

6. At the prompt, type Message from the User Program.

7. Press Enter.

Notice the string immediately appears under the Input Arra
Offset, next to Offset 4 String.

Viewing the New
Values on the Monitor

Screen

To view the new values, complete this step:

• Type 1 to return to the Monitor Screen, and observe the 
effects of your input changes.

Notice that the changes you made on the User Screen are refle
on the Monitor Screen. Under the Input Array Offset, input offs
#1 has a value of 25, and input offset #4 displays the first 15 c
acters of the string.

The first line of the Message Window also displays the ASCII te
string of input offset #4. This was configured by setting the 
address reference of input offset #4 to the link variable 
LINK\UPM_WINDOW:A.

Viewing the PTM
Panel

The designer of this example also created a related PTM pan
demonstrate how easily other Interact modules can be incorpo
rated. 

To view the PTM panel, follow these steps:

1. On the Monitor Screen, click on the User Screen button 
located in the lower left corner of the screen.

The User Screen is displayed.

2. Type 5 to go to the Panel Toolkit Module (PTM).
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The example PTM panel appears as shown below:

Output offsets and input offsets are listed along with their 
address references and current values.

Note The Data Error associated with output item #4 is the sam
one that you saw in the Monitor Screen on page 239 and
User Screen on page 240. You will address this error la
in this example.

Modifying the
Example

Application

In this part of the example, you will do the following:

• Go to UPM in the development environment

• Edit the Output List

• Save the new configuration

• View the results in Run Mode
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Returning to the
Development
Environment

To return to the development environment, follow these steps:

1. From the PTM panel, press F10 to return to the Application 
Manager Main Menu.

2. Click Exit  Interact ; then, click Accept.

The Interact Application Manager window is displayed.

Editing the Output
List

In this step, you will edit the configurations of two Output List 
items.

To edit the Output List, follow these steps:

1. Double-click the User Program Module (UPM) icon.

2. Double-click the Output  List  icon.

The Output List window appears as shown below:

Each output item is listed by number and name, along with
Output Reference, Data Type, Offset, and Block Length. Fi
you will edit item #1 (Offset 0).

Important Notice that item#1 is offset 0. The item number is a loca
tion in the list of address references you enter in the dev
opment environment. The offset number is the item’s 
actual offset in the User Program’s Output (or Input) Arra
In Run Mode, the address references are identified sole
by offset number.

3. Click anywhere on the row of item #1.

The entire row is highlighted.

4. On the Edit  menu, click Edit Entry .
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The Output Item dialog box appears as shown below:

5. Type Timer1 in the Name box.

6. Click OK .

You are returned to the Output List window. Notice that th
new name is reflected in the list.

Item #5 (Offset #4) is the reference that caused the errors
the Monitor Screen, User Screen, and PTM Panel. This is
because its address reference is LINK\ALARMS:A. This lin
variable is made available through the Alarm Managemen
Module (AMM) which is not included in Upmexamp.

In the Experiment! section on page 246, you are encouraged
add the Alarm Management Module (AMM) to Upmexamp 
make this link variable operational. For now, you will chang
the address reference to make the error disappear.

7. Click anywhere on the row of item #5.

The entire row is highlighted.

8. On the Edit  menu, click Edit Entry .

The Output Item dialog box appears.

9. Type Timer2 in the Name box.

10. Click on Unsigned Integer in the Data Type box.

11. Click in the Output  box to enter an address reference.

The Address Reference dialog box appears.

12. Delete the current reference, and type DVR\TIMER2  in the 
address reference box.
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13. Click OK .

14. Click OK  again to accept all of your changes to this Outpu
Item. The Output List window appears where all of your 
changes are reflected in the list.

15. On the File menu, click Close Module.

16. Click Yes.

The Application Manager window appears.

Testing the
Example

Application

Now that you have explored the User Program Module (UPM)
you are ready to test the application.

Returning to Run
Mode

Now, return to Run Mode, and observe the effects of the chan

To return to Run Mode, follow these steps:

1. From the Application Browser, click the Application 
Manager icon.

2. On the Run menu, click Run Interact. 

3. Click Yes when you are asked to save changes.

The UPM Monitor screen appears.

Viewing the
Modifications

To view the modifications, follow these steps:

1. Click on the User Screen button located in the lower left 
corner of the display. 

The User Screen appears. Notice that the changes are refle
and the data error at offset #4 is gone.

2. Type 5.

The PTM panel appears. Even though the address referen
was changed it is still an error on this panel because the 
change was not made in PTM. This panel is still looking fo
data from an alarm module.

See Experiment! on page 246 for steps to incorporate an alar
module into Upmexamp.
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3. Press F10 to return to the Application Manager Main Menu.

4. Click Exit Interact ; then, click Accept.

Removing the User
Program from

Memory

This concludes the UPM example. The TSR User Program wi
remain in memory until you delete the TSR.EXE entry from yo
Autoexec.bat file and restart your system.

To remove the TSR from memory, follow these steps:

1. Using a text editor, delete the following line from your 
Autoexec.bat file:

C:\INTERACT\APPFILES\UPMEXAMP\TSR.EXE

2. Save the change, and restart your computer.

A message appears informing you that the TSR has been
removed.

Experiment! This chapter provides only a brief introduction to the features 
UPM. The best way to learn is to experiment. Try adding the 
Alarm Management Module (AMM) to Upmexamp by following
the steps below:

1. While in the development environment, add AMM to the 
Modules Used list of Upmexamp.

2. Change the configuration of output #5 to its original setting
(Data Type = String, Output = LINK\ALARMS:A ).

3. Refer to the AMM help file for information on configuring 
alarms. For this example, assign a reference of: 
DVR\TIMER1 > 200 to trigger an alarm.

4. Add output and input items to the lists in the development
environment, and view the results in Run Mode. Note, the
example User Screen will display only the first five input and 
output items.

5. Configure the Master Control setting (found under UPM 
Setup, Triggers) with the output reference: DVR\1:10.

6. Add a Maintained Push Button to the PTM panel that spec
ifies this address for its input reference. Notice in Run Mod
that the User Program will only receive data when the butt
is depressed.
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 and 
You can also read through the TSR.C and TSR.H source code
experiment making changes to the code and compiling.
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Interact  Network Concepts

Interact includes many features that support Local Area Networks 

(LANs). These features, when coupled with Interact’s existing 

capabilities, allow you to connect operator interface and supervi-

sory control stations to existing network operating systems, 

including Novell Netware, Artisoft Lantastic, and Microsoft LAN 

Manager.

This chapter is intended to describe the possibilities of networking 

Interact in an existing network environment. Descriptions of how 

the various Interact modules and drivers can be configured for use 

in a network environment are presented.
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Overview of
Interact

Networking

You can use Interact networking to organize, manage, and up
your applications more easily. Interact networking products al
allow you to turn your plant floor workstation into an informatio
hub, drawing data from the plant floor and sending it to MIS a
SCADA environments. You can even use the Interact DDE Ser
on a PC to collect the factory floor data then use SQL to send
data to a larger system such as an AS400.

Interact networking is designed to work with all NetBIOS comp
ible networking topologies including Ethernet, Arcnet, and Tok
Ring. The NetBIOS implementation ensures Interact works wi
new or existing networks, so Interact networking can be integra
into any manufacturing facility.

Using Interact’s network-aware file system, the NetBIOS Drive
the Interact Modem Driver (IMD), and the Interact DDE Serve
you can do the following:

• Connect to and share data between Interact workstations

• Transfer data files to remote workstations

• Restart applications at a remote location

• Send new applications to a remote location

• Log data files to a central location

• Run Interact and your Interact applications from a centraliz
location

• Manage recipes over a network or load recipes from a dat
base

• Send plant floor data to DDE applications in the MIS depa
ment

• Use the Interact DDE Server along with SQL to send data
non-PC based systems (i.e. AS400)

• Remotely connect to Interact workstations via a modem

All this capability means Interact not only meets needs rangin
from control panel replacement to high supervisory application
but also can link all these levels together throughout your facil
250 Interact Getting Started Guide
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Sharing Data
Between
Interact

Workstations

Interact allows plant floor workstations to share data on a LAN
This is done via the Remote Driver Access feature of the NetBI
driver. Remote Driver Access allows an Interact workstation 
connected to a network to access information residing in an 
Interact application running on another station on that network
real-time. Numeric or ASCII data can be written to or acquired
from a programmable logic controller (PLC). It can also be rea
from Interact link variables, for example, to monitor the PLC 
driver status of a remote station.

All this is done through a simple addressing format. The figure
below illustrates a typical address which might be assigned to
PTM tool or alarm used on an application residing on Node_A
Nbios\Node_B\Dvr\1:1.

In the above example Nbios is used to reference the NetBIOS
driver, indicating the data is to be acquired over the network. 
Node_B is the station on the network from which the data is to
read. The Dvr\1:1 is an address using the Interact demo drive
Replace this with the driver format used in your specific applic
tion.

Transferring Data
Files and Sending

Applications

During Run Mode, Interact Networking allows you to transfer 
Interact files and applications to and from remote Interact wor
stations. Typical files might include alarm log files, data logs, 
recipe logs, and reports. The NetBIOS driver transfer features
make it easy to copy files over the network. These transfers m
also be security protected.

Interact application files may also be transferred across a netw
This makes it possible to create an application at your desk, do
load it to a remote station on the network, and restart that app
tion.
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Logging to and
Running Interact from

a Central Location

Interact uses many “disk based” files to perform its tasks. Sinc
Interact supports these features and can read and write to its 
from any valid location across a network, its file system is said
be “network-aware.” Interact recognizes two DOS runtime env
ronment variables. They are listed below:

• Interact  - specifies the drive and directory where Interact 
program files exist.

• Interact_files - specifies the drive and directory where app
cation files exist.

These runtime environment variables can be very useful in a 
networked system for centralizing all applications and/or progra
files on a network server.

The network-aware file system also means any path for loggin
Interact data files may be set to any logical drive on the netwo
In the following example, a typical alarm log path for Node_A 
might be F:\node_a\alarms. Node_B might store its alarms to the
path F:\node_b\alarms.

Note The logging and centralized program files are inherent t
the Interact software and do not require the NetBIOS 
driver.

Managing Recipes
Over a Network

Interact’s Recipe Module (RCM) allows you to use different 
directories to load, save, and delete recipe files in your applicat
Interact’s network-aware file system expands that capability o
a network. This means separate workstations on the network 
load, save, and delete files from the same locations. This grea
enhances the usability of your recipes by diminishing confusio
over which stations hold the most current recipe files.
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Using Interact
DDE Server

The Interact DDE Server allows you to take plant floor informa
tion from an Interact workstation connected to the NetBIOS 
network and bring that data into any Windows DDE-compatibl
application.

Interact Gateway Via
SQL Environments

Through the Interact DDE Server, data from workstations on t
plant floor is brought into Windows DDE-compatible applica-
tions. This information can then be manipulated and imported
non-PC based systems (i.e. AS400) or a machine that suppor
SQL. Thus, Interact allows you to send data to all areas of you
organization, from plant floor workstations to higher level data
base systems.

Connecting to SCADA
or MIS/MES

Environments

During Run Mode, Interact uses the high-speed and efficiency
DOS for plant floor workstations. However, it is important to b
able to get that plant floor data to all areas of your organizatio
like the MIS department.

Many MIS/MES applications require Windows, forcing slower 
SCADA packages to the factory floor in order to support the nee
of the MIS department. This is not where these packages are 
suited, since process control requires immediate updates that
higher level SCADA packages cannot supply.

The Interact DDE Server allows you to have the best of both 
worlds. The DDE Server supplies data from an Interact works
tion to the Windows environment. In the Windows environmen
the DDE Server then supplies that live data to DDE-compatibl
client applications. DDE client applications may read from or 
write to Interact workstation applications. 
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This relationship is shown below:

Application
Capabilities

Using Modems

The Interact Modem Driver (IMD) is used to connect an Intera
station to a controller interface (PLC Link) or to connect an 
Interact station to another Interact station (Network Link). This
shown in the figure below:

Using IMD in a direct controller connection (PLC Link) allows a
Interact serial driver to connect with a controller via a modem.
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This modem connection is transparent to the Interact applicat
It will appear that the application is connected directly to the 
controller instead of via a modem.

This configuration requires only the use of an Interact serial dri
to communicate with the controller. The NetBIOS and LANtast
Z software are not needed in this configuration.

Using IMD in a station-to-station configuration (Network Link) 
allows one Interact station to connect with another one via 
modems. This allows the Interact station to have access to da
located in the other station by using the Interact NetBIOS Driv
Either node can read or write data locations in controllers 
connected to the other node.

In this configuration, you must use the following drivers:

• NetBIOS driver

• IMD driver

• LANtastic Z network software

LANtastic Z is a two-node network used to connect two comput
via the serial ports. LANtastic Z is a zero-slot network that nee
no network adapters.

IMD also includes an automated dialing feature that connects 
remote station based on events, time, or operator inputs. For 
example, you could have a remote station call a supervisory 
station when an alarm is triggered, and the supervisory station
could then evoke an action to correct the problem.
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Appendix A
Frequently Asked Questions

General Interact Questions
1.  Is my CTC hardware Y2K compliant?

 All information on Y2K compliance and necessary upgrades is available 
our website.

2.  Does Interact come in any other language?

 At the moment, Interact is in English and French. We are working on our
German version of Interact. Please stay in touch with your local distributor
more information.

Configuration Questions
3.  How do I get my application to run on boot-up on my PowerStation?

 You  need to adjust settings in Interact development and on the PowerSta
To do this, follow these steps:

a. In Interact Settings, select your application as the Startup Application
b. Under Application Settings, select the Inhibit AM Menu check box an

make sure the startup module is PTM. 
c. On the PowerStation from the PowerStation Shell main menu, select 

tings", go to "General", select "Power on Operation" and set it to RUN
TERACT.

4.  What internal variable can I use to read and write ASCII?

 The Link Variables are the only internal variables that will accept ASCII da
You must use the suffix ":A" on the link variable to allow the link variable 
store ASCII data. For example: 

LINK\STATE:A = "ON"

5.  How do I get my application from my development computer to my Powe
tion?

 Use MachineShop, which simplifies the process of transferring projects. 
the MachineShop Getting Started Guide for more information.
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6.  How do I display alarms in a Remote Message Display tool within Panel
Toolkit Module (PTM)?

 When you configure the Remote Message Display tool, put the following L
variable in the Message Text Output field:

LINK\ALARMS:A

Run Time Questions
7.  Where can I get all of the latest drivers for Interact?

 You can download the latest drivers from our FTP site.

8.  I am getting question marks on my Interact tools in run mode after using
Tag Editor. Why?

 You probably did not sort your tag list. Tags in the Tag Editor must be in
alphabetical order for Interact to read them properly. Please open up you
Editor, go to "Settings" and check the Auto Sort option. With Auto Sort 
selected, every time you edit your tag list, the list will be automatically sor

9.  I need more fonts for my Interact applicaiton. Are any more
 available?

 Yes, we have a utility called Fontpack. You can have this utility when you j
our Product Support Program (PSP). Please contact your local distributo
more information about the PSP program.

Printing Questions
10.  If I want to print graphics from Interact run mode, what do I need?

 You need the correct printer driver in Interact to match your printer. A Prin
Drivers Utility program is available. This utility is available to Product 
Support Program (PSP) members. Please contact your local distributor f
more information about the PSP program.

11.  Will my Printer Drivers Utility for Interact version 4.X through Interact 
version 5.1 work with Interact version 6?

 No, it will not. Interact 6 has its own Printer Drivers Utility. This utility is 
available to Product Support Program (PSP) members. Please contact y
local distributor for more information about the PSP program.
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Index
A
acknowledging alarms 114
acknowledgment user level 114
action tools 70, 74, 80
active list 183, 189
Activity Log Display 186
adding

data field 158
drivers 41, 132
graphics 103
log comments 159
modules 40, 132
recipe comment 177
tools 81, 103
variables to report form 228

address
references 28, 29, 30, 33, 58, 95, 99, 

126, 139, 159, 204, 244
references, decoding 30

alarm
acknowledging 114
groups 115, 121
history 121
priorities 113
runtime displays 116, 258

Alarm Control Display 122
Alarm Definitions 124
Alarm Management Module (AMM) 16, 

111, 112, 147
creating new alarms 124
send alarm information 115

Alarm Summary Display 112, 114, 117, 
118, 120, 123

Alarm Value 112
analog input tools 59, 63, 68, 72
analog output tools 61, 64, 69, 73
analog tools 58
appearance connections 97, 100, 107
application 27
Application Browser 35, 38, 41

Application Manager (AM) 11, 15, 25, 
27, 112, 130, 182, 212

user interface 36
application settings,configuring 47
Arcnet 250
ASCII data 257
ASCII message entry 16
AutoCAD 16

B
bar graph 16, 34, 52, 61, 64, 80

C
Chart Display 144, 147, 148, 154
configuring

application settings 47
Interact settings 42
transfer of data 139

controlling the printer (RPM) 227
counter 80
creating

derived list 196
list comment 207
lists 203
new alarm 124
new panel 79, 103
recipe 175

Cross Reference Report 33
Cross Reference Utility (CRU) 33
Current Value 112
Customer Support Services 7

D
data field, adding 158
data log 145, 147, 148, 150, 154, 155, 1
Data Transfer Module (DTM) 16, 34, 130

configuring transfer of data 139
DDE Server 17, 250, 253
decoding address references 30
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decrement buttons 61, 68, 80
deleting log files 161
demo device driver 53
derived list 196, 198
development environment 10, 26, 27, 37, 

52, 112, 146
development system 12
device driver 28, 29
DLL 10
downloading recipe 171, 174

E
Edit Recipe Display 167, 172
enable/disable report 226
environments

development 12, 26, 27, 37, 52, 112, 
146

operating 10
runtime 11, 26, 27, 52, 252

Ethernet 250

F
file conversion utility (HTM) 146
file numbers 216
forms (RPM) 212

G
graph, bar 16
Graphics Monitoring Module (GMM) 16, 

52, 87
adding graphics 103
adding tools 103
appearance connections 97, 100, 107
creating a new panel 103
motion connections 95, 96, 105

groups
alarm (AMM) 115
data transfers (DTM) 130
list (MCM) 184

variable (RPM) 212, 214

H
Historical Trending Module (HTM) 17, 

143
adding comments to log 159
adding data fields 158
convert log files 146
deleting log files 161
examining data log 155
loading a data log 150, 154, 161
log files 144
log forms 145, 158
logging data record 146
searching data log 156

hot edit 185, 194

I
increment buttons 60, 68, 80
indicator 69, 80
Indicator tool 69
input

array 235
list 235

input area 80
input list 80
Input references 28
Interact

adding drivers 41, 132
adding modules 40, 132
architecture 14
configuring settings 42
demo device driver 53
fonts 258
introduction 10
online help 14, 37
operating environments 10
starting 20
system requirements 12, 13
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Interact Modem Driver (IMD) 254, 255

K
key assignments 115, 167, 186

L
LANtastic Z 255
last states (MCM) 208
latched push button 58
lighted push button 16
line trend 16, 72, 73, 80
link variables 30, 31, 251, 257
list comment 207
lists 185, 188, 189

create 203
delete 198
disable 196, 197
editing 193
enable 197
hot edit 194
loading and sending 192
monitor values 185
verify items 184

Load Data Log Display 148
load panel 74
loading recipe 170, 179
local message display 65, 80
log

comments 159
deleting files 161
file conversion 146
files 144
forms 145, 158
write interval 146

Log Form List 145
Logging Control Display 145, 148

M
Machine Configuration Module (MCM) 

16, 181
derived list 196, 198
groups 184
hot edit 185, 194
last states 208
list comment 207
lists 185, 188, 189

active 183, 189
create 203
delete 198
disable 196, 197
editing 193
enable 197
loading and sending 192

monitor list values 185
single-button download 186, 201
verify list items 184

MachineShop 3
Maintained Push Button 57
Maximum File Number 144
message entry display 80
meter 52, 64, 80
Meter and Message Display Tools 63
modules

adding 40
Alarm Management Module (AMM) 

16, 111
Application Manager (AM) 15, 25, 

27, 112, 130, 182, 212
Data Transfer Module (DTM) 16, 34,

130
Graphics Monitoring Module (GMM) 

16, 52, 87
Historical Trending Module (HTM) 

17, 143
Machine Configuration Module 

(MCM) 16, 181
Panel Toolkit Module (PTM) 16, 51, 

88, 134
Recipe Module (RCM) 16, 165, 252
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Report Module (RPM) 17, 211
User Program Module (UPM) 17, 233

momentary push button 57
monitor (MCM) 188, 191, 195
monitor list values 185
Monitor Screen 235, 236, 238, 239, 241
monitor with update (MCM) 188
motion connections 95, 96, 105
multi-state indicator 16

N
NetBIOS 17, 250, 251, 253
Network Link 254
networking 10, 17, 250

central location 252
centralizing 22

numeric display 16, 52, 60, 62, 69, 80
numeric entry 66, 80

O
online help 14, 29, 37
operating environments 10
operator messages (RPM) 222
output

array 235
list 235, 243

Output references 28

P
panel label 81
panel meter 16
Panel Toolkit Module (PTM) 16, 51, 88, 

134
creating a new panel 79
Toolbar 80
tools 56

action 70, 74, 80
adding tools 81
analog input tools 59, 63, 68, 72

analog output tools 61, 64, 69, 73
analog tools 58
bar graph 52, 61, 64, 80
counter 80
decrement button 61, 68, 80
increment button 60, 68, 80
indicator 69, 80
input area 80
input list 80
line trend 72, 73, 80
load panel 74
local message display 65, 80
message entry display 80
meter 52, 64, 80
meter and message display 63
numeric display 62, 80
numeric displays 52, 69
numeric entry 66, 80
panel label 81
PID faceplate 80
push buttons 52, 56, 80

latched 58
maintained 57
momentary 57

range indicator 62, 80
remote list display 80
remote message display 80
selection entry 80
set button 67, 80
slide potentiometer 16, 59, 63, 72

80
time and date 56, 81
XY plot 80

password 28, 31
percent scaling 166
PID faceplate 16, 80
PLC Link 254
position connections

Graphics Monitoring Module (GMM)
position connections 98
262 Interact Getting Started Guide



Index

Interac

 

, 
Printer Drivers Utility 258
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Product Support Program 258
push button 52, 56, 80

R
range indicator 62, 80
read/write ASCII 257
Recipe Display 167, 170
Recipe Module (RCM) 16, 165, 252

creating recipe 175
downloading recipe 171, 174
editing recipe 172
loading recipe 170, 179
percent scaling 166
recipe comment 177
uploading values 167

remote list display 80, 189, 191, 194, 195
Remote List Display tool 199
remote message display 80, 173, 207
Report Control Display 217, 225
report files 216
Report Form Editor 212, 213
Report Load Display 217
Report Module (RPM) 17, 211

adding variables 228
controlling the printer 227
enable/disable report 226
forms 212
groups 214
operator messages 222
report files 216
report triggers 215
resetting the report 226
stored messages 214
trigger intervals 215
variables 213

report triggers 215
Report View Display 216, 220
resetting the report 226

runtime environment 11, 13, 22, 26, 27,
28, 52, 252

runtime system 13

S
Save List As 196
searching data log 156
selection entry 80
send alarm information 115
serial drivers 23
set button 67, 80
single-button download 186, 201
slide potentiometer 16, 59, 63, 72, 80
Software Development Kit 15
starting

Interact runtime 21
Startup application 257
startup module 257
stored messages (RPM) 214
system requirements 12, 13

T
Tag Editor 32, 258
tag names 32
terminate-and-stay-resident (TSR) 17, 

233, 236
time and date display 56, 81
Token Ring 250
Trend Display 144, 146, 148, 150, 151
trigger 235
trigger intervals 215

U
uploading values 167
user

interrupt 234
level 28, 76, 114, 167, 182, 201, 208

216
User Program 233, 234, 235, 237
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V
variable

groups (RPM) 212, 214
link 30, 31, 251
report 213

verify list items 184

W
Windows Dynamic Link Libraries 

(DLLs) 10
write interval 146

X
XY Plot 16
XY plot 80

Y
Y2K compliance 257
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